
AvL Proprietary and Confidential  
Content is Subject to Change without Notice  

 
 

AAQ Antenna Controller 
 
 

Users Manual 
 

Revision R11.8.0 
 

AvL Confidential and Proprietary Information 

Do Not Copy 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 2 of 200 
 

Revision History 

Rev. 
1.0.0.3 

25 July 
2012 

Software Release 6   5775 1.1.2.182 N/A 

Rev. 
1.0.0.4 

19 Sept 
2012 

Software Release 7   6112 1.1.3.22 N/A 

Rev. 
1.0.0.5 

12 Dec 
2012 

Software Release 8   6348 1.1.3.74 1.0.0.3 

Rev. 
1.0.0.6 

08 April 
2013 

Software Release 9   6869 1.1.3.160 1.0.0.3 

Rev. 
1.0.0.7 

11 Oct 
2013 

Software Release 10   7069 1.1.3.187 N/A 

Rev. 
1.0.0.8 

02 May 
2014 

Rewrite   8564 1.1.3.224 N/A 

Rev. 
1.0.0.9 

31 Aug 
2015 

Rewrite for Release 
11.4 

  10542 1.1.4.324 N/A 

Rev. 
11.5.0 

5 Jan 2016 
Update for Release 

11.5.  Change in 
Revision Sequence 

  10649 11.5.342 N/A 

Rev. 
11.5.1 

14 Jan 
2016 

Update message 
section chapter 8 

  10649 11.5.342 N/A 

Rev. 
11.6.0 

21 June 
2016 

Updates for release 
11.6 

  10738 11.6.364 N/A 

R11.8.0 
12 

December 
2016 

Updates for R11.8, 
added revision and 

approved by in 
revision history 

JF MF 10784 11.8.382 N/A 

 

 

 

 

 

 

 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 3 of 200 
 

Contents 
Chapter 1 - Introduction .......................................................................................................................................... 10 

1.1 Controller System Overview ............................................................................................... 10 

1.2 Standard Hardware Components ....................................................................................... 10 

1.3 Software Architecture ........................................................................................................ 11 

1.3.1 Operating System .................................................................................................. 11 

1.3.2 ROM ....................................................................................................................... 11 

1.3.3 PIC .......................................................................................................................... 11 

1.3.4 CONFIG .................................................................................................................. 11 

1.3.5 Remote – GUI (Graphical User Interface) .............................................................. 11 

1.3.6 Module – Device .................................................................................................... 12 

1.3.7 Module – Function ................................................................................................. 12 

1.4 Controller Hardware Specification ..................................................................................... 12 

1.5 Definitions and Common Terms: ........................................................................................ 13 

Chapter 2 - AAQ System Architecture & Hardware Overview ................................................................................ 15 

2.1 Controller System Block Diagram ....................................................................................... 15 

2.1.1 The AAQ enclosure contains:................................................................................. 16 

2.2 AAQ Antenna System ......................................................................................................... 18 

2.2.1 AvL Cable Drive System ......................................................................................... 18 

2.2.2 Motor Drives .......................................................................................................... 18 

2.3 AAQ Components ............................................................................................................... 19 

2.3.1 Navigation Remote Input Output Module (RIOM) ................................................ 19 

Chapter 3 - GUI Installation, Set-up & Network Configuration ............................................................................... 20 

3.1    Requirements ....................................................................................................................... 20 

3.2 Installation .......................................................................................................................... 23 

3.2.1 Windows installation file ....................................................................................... 23 

3.2.2 Installation Folder .................................................................................................. 23 

3.2.3 AAQ Remote Access Settings ................................................................................. 24 

3.2.4 AAQ Remote Settings (Access Level 0) .................................................................. 24 

3.2.5 Editing Controller Alias .......................................................................................... 25 

3.2.6    AAQ Remote Settings (Level 1-9) ............................................................................ 25 

3.3  Network Settings ............................................................................................................... 26 

3.3.1 Factory IP Addresses .............................................................................................. 26 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 4 of 200 
 

3.4 AAQ Remote Network Settings Tool .................................................................................. 27 

3.5 IP addressing and Networking Examples ............................................................................ 28 

3.5.1 Factory Default Network Configuration ................................................................ 29 

3.5.2 Single Device Configuration ................................................................................... 30 

3.5.3 Dual Network Device Configuration ...................................................................... 31 

3.5.4 Cross Device Network Configuration ..................................................................... 32 

Chapter 4 - AAQ Remote .NET GUI .......................................................................................................................... 34 

4.1 Introduction ........................................................................................................................ 34 

4.2 Interpreting the Display ...................................................................................................... 35 

4.2.1 Main Window ........................................................................................................ 35 

4.2.2 Connection Indicator ............................................................................................. 36 

4.2.3 RIOM (Remote Input Output Module) Indicators ................................................. 36 

4.2.4 Scrolling Alarms ..................................................................................................... 36 

4.2.5 Command Pane ..................................................................................................... 37 

4.2.6 Manual Control Pane ............................................................................................. 38 

4.2.7 Heading Source ...................................................................................................... 38 

4.2.8 Target Selection Pane ............................................................................................ 39 

4.2.9 Status Pane ............................................................................................................ 40 

4.3 File Menu ............................................................................................................................ 41 

4.3.1 Settings .................................................................................................................. 41 

4.3.3 AAQ Support Files, Upload / Download… .............................................................. 46 

4.3.4 Calibration ............................................................................................................. 47 

4.3.5 RIOM Software Update ......................................................................................... 50 

4.3.6 Show Movement ................................................................................................... 51 

4.3.7 Edit GUI Layout ...................................................................................................... 52 

4.3.8  Change Status Variables Displayed ....................................................................... 53 

4.3.9 User Manager ........................................................................................................ 54 

4.3.10  Lock ....................................................................................................................... 57 

4.3.11  Exit ........................................................................................................................ 58 

4.4 View Menu .......................................................................................................................... 58 

4.4.1 Sensor Output ........................................................................................................ 58 

4.4.2 Controller Configuration ........................................................................................ 59 

4.4.3 Profile System ........................................................................................................ 60 

4.4.4 DvB-S2 Control ....................................................................................................... 66 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 5 of 200 
 

4.4.5 LNB Control ............................................................................................................ 67 

4.4.6 Satellite List ............................................................................................................ 67 

4.4.7 System Log ............................................................................................................. 69 

4.4.8 Data Log ................................................................................................................. 70 

4.4.9 Alarm List ............................................................................................................... 71 

4.4.10    Device Window ................................................................................................... 72 

4.4.11   Graphic Controller Window ................................................................................. 73 

4.5 Login Menu ......................................................................................................................... 77 

4.6 Help Menu .......................................................................................................................... 78 

4.6.1 About ..................................................................................................................... 78 

4.6.2 Version ................................................................................................................... 79 

4.6.3 Troubleshoot ......................................................................................................... 80 

Chapter 5 – Initial Setup, Basic Operation & Profile Examples ............................................................................... 81 

5.1 Unpacking ........................................................................................................................... 81 

5.2 Basic Connections ............................................................................................................... 82 

5.3 AAQ Remote Application (GUI) Installation ....................................................................... 83 

5.3.1 Remove previous versions ..................................................................................... 83 

5.4 Install the AAQ Remote ...................................................................................................... 83 

5.5 Power on and Boot ............................................................................................................. 84 

5.6 Initial Login and IP settings ................................................................................................. 84 

5.7 Command Functions ........................................................................................................... 85 

5.7.1 Command Descriptions ......................................................................................... 86 

5.8 Profile System ..................................................................................................................... 87 

5.8.1 Discussion on Profiles ............................................................................................ 87 

5.8.2 Configuration Parameter Types ............................................................................. 88 

5.9 Profile Examples ................................................................................................................. 89 

5.9.1 Target Satellite selection ....................................................................................... 89 

5.9.2 Simple Profile Example .......................................................................................... 90 

5.9.3  Add Profile ............................................................................................................. 91 

5.9.4 Select Target .......................................................................................................... 92 

5.9.5 Common Profile Adjustments ............................................................................... 93 

5.9.6 Adjusting Motion Limits......................................................................................... 94 

5.9.7 Modem Acquisition, Low Power Carrier ................................................................ 95 

5.9.8 Adjusting RSL Threshold ........................................................................................ 97 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 6 of 200 
 

5.10 Adding a Reference Satellite ................................................................................. 99 

Chapter 6 – AAQ System Configuration Variables (Parameters) .......................................................................... 102 

6.1 Introduction ...................................................................................................................... 103 

6.1.1 Core Parameters .................................................................................................. 103 

6.1.2 Target Parameters ............................................................................................... 106 

6.1.3 Signal Parameters ................................................................................................ 107 

6.1.4 Feed Parameters .................................................................................................. 108 

6.1.5 Optional ............................................................................................................... 109 

6.2 Hardware Safety & Mechanical Limits - Core ................................................................... 109 

6.2.1 Pedestal Limits ..................................................................................................... 110 

6.2.2 Stow Position ....................................................................................................... 111 

6.2.3 Reflector/Feed On/Off ......................................................................................... 112 

6.2.4 Interlocks ............................................................................................................. 112 

6.3 General System Set-Up - Core .......................................................................................... 113 

6.3.1 RSL Meter ............................................................................................................ 114 

6.3.2 Navigation ............................................................................................................ 115 

6.3.3 SATTANT .............................................................................................................. 117 

6.3.4 Manual Moves ..................................................................................................... 117 

6.3.5 Acquisition ........................................................................................................... 118 

6.3.6 Time ..................................................................................................................... 120 

6.3.7 Other Core Parameters........................................................................................ 120 

6.4 Automatic Operation - Target .......................................................................................... 122 

6.4.1  Target Satellite .................................................................................................... 123 

6.4.2 Target Sources ..................................................................................................... 124 

6.4.3 Target Acquisition ................................................................................................ 125 

6.4.4 Other Target Based Parameters .......................................................................... 126 

6.5 Signal Source Based Parameters ...................................................................................... 127 

6.5.1  Acquisition .......................................................................................................... 128 

6.5.2 Coarse Peaking .................................................................................................... 129 

6.5.3 Fine Peaking ......................................................................................................... 130 

6.5.4 Cross Pattern - Coarse Peaking ............................................................................ 130 

6.5.5 Cross Pattern - Fine Peaking ................................................................................ 131 

6.5.6 Step Pattern Mode .............................................................................................. 132 

6.5.7 Step Pattern - Coarse Peaking ............................................................................. 132 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 7 of 200 
 

6.5.8 Step Pattern - Fine Peaking ................................................................................. 133 

6.5.9 Plateau Peaking ................................................................................................... 133 

6.5.10  Polarization Peaking ........................................................................................... 134 

6.5.11  Other Signal Based Parameters .......................................................................... 134 

6.6 Feed Based Parameters .................................................................................................... 135 

6.7 Sensor Override ................................................................................................................ 137 

6.7.1 Compass ............................................................................................................... 137 

6.7.2 GPS ....................................................................................................................... 137 

6.7.3 Tilt ........................................................................................................................ 137 

6.8 System Options ................................................................................................................. 138 

6.8.1 NMEA Server ........................................................................................................ 138 

6.8.2 Slide Motor Feed System ..................................................................................... 138 

6.8.3 Vector Compass ................................................................................................... 139 

6.8.4 Wing System ........................................................................................................ 139 

Chapter 7 - Theory of Operation ........................................................................................................................... 140 

7.1  Introduction ...................................................................................................................... 140 

7.1.1  Auto-Point Antenna Basics .................................................................................. 141 

7.2 Antenna Drive System ...................................................................................................... 141 

7.2.1 Azimuth Cable Drive ............................................................................................ 141 

7.2.2 Elevation Positioning ........................................................................................... 146 

7.2.3 Feed and Polarization Positioning ....................................................................... 151 

7.3 AAQ Controller System Detailed Description ................................................................... 154 

7.3.1 Modular / Parametric Software ........................................................................... 155 

7.3.2 Operator Access Levels ........................................................................................ 155 

7.3.3  AAQ Configuration Items ..................................................................................... 157 

7.3.4  Antenna System Calibration ................................................................................ 158 

7.3.5  Factory Test ......................................................................................................... 158 

7.3.6  Power-On Calibration .......................................................................................... 158 

7.3.7  Product Lifetime .................................................................................................. 159 

7.4 AAQ Controller Functional Description ............................................................................ 160 

7.4.1  Pedestal Base Heading ........................................................................................ 160 

7.4.2  SATTANT .............................................................................................................. 161 

7.4.3 Reference satellite function ................................................................................ 162 

7.4.4  Pedestal Tilt Compensation ................................................................................. 163 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 8 of 200 
 

7.4.5  Satellite Pointing Solution ................................................................................... 163 

7.4.6  Acquiring the Satellite Signal ............................................................................... 164 

7.4.7  Signal Source = RSL .............................................................................................. 166 

7.4.8  Signal Source, Modem or Beacon Receiver ......................................................... 168 

7.4.9  Peaking on the Signal ........................................................................................... 169 

7.4.10  Coarse Peaking .................................................................................................... 169 

7.4.11  Fine Peaking ......................................................................................................... 171 

7.4.12  Linear Polarization Optimization ......................................................................... 172 

7.4.13  Tracking on the Signal (Optional) ........................................................................ 172 

7.4.14  Step Track ........................................................................................................... 173 

7.4.15  Two-Line Element (TLE) Track ............................................................................. 173 

7.4.16  Position Hold........................................................................................................ 174 

7.4.17  Satellite Signal Properties .................................................................................... 174 

7.4.18  Scintillation Effect ................................................................................................ 174 

7.4.20  Signal Sources ..................................................................................................... 175 

7.4.21  Profile System ..................................................................................................... 176 

7.5  The Acquisition process ................................................................................................... 177 

7.5.1 Power on and Boot .............................................................................................. 177 

7.5.2 Home Sequence ................................................................................................... 177 

7.5.3 Acquisition Sequence .......................................................................................... 180 

7.5.4 Peaking Sequence ................................................................................................ 181 

Chapter 8 - Troubleshooting ................................................................................................................................. 183 

8.1 Alarms & Messages .......................................................................................................... 183 

8.1.1 Alarms .................................................................................................................. 183 

8.1.2 Error Messages .................................................................................................... 185 

8.1.3 Prompts ............................................................................................................... 186 

8.1.4 Running Messages with Associated Hex Code .................................................... 186 

8.2 Communicating with the GUI ........................................................................................... 189 

8.2.1 Comms. LED Indicator.......................................................................................... 189 

8.2.2 Remote IP Address .............................................................................................. 189 

8.2.3 Verifying Connections .......................................................................................... 190 

8.2.4 ACU communication to RIOMs ............................................................................ 190 

8.3 Modem Signal Source not found on scan ......................................................................... 191 

8.3.1 Verify Communication ......................................................................................... 191 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 9 of 200 
 

8.3.2 IP Addressing ....................................................................................................... 191 

8.4 Elevation and Azimuth alignment .................................................................................... 192 

8.4.1 Elevation Offset ................................................................................................... 192 

8.4.2 Azimuth Offset ..................................................................................................... 193 

8.4.3 Recognizing a Failed Compass ............................................................................. 194 

8.4.4 Changing the Compass Heading Sources ............................................................. 195 

8.5 Recognizing a Failed GPS .................................................................................................. 196 

8.5.1 Changing to Manual GPS ..................................................................................... 197 

8.6 Maintenance ..................................................................................................................... 198 

8.6.1 Annual Inspection ................................................................................................ 198 

8.7 Contacting Customer Service ........................................................................................... 199 

8.7.1 Email Support ...................................................................................................... 199 

8.7.2 Priority Telephone & Fax Support ....................................................................... 200 

 

 
 

 

 

 

 

 

 

 

 

 

 

 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 10 of 200 
 

Chapter 1 - Introduction 
 

1.1 Controller System Overview 
 

The AAQ controller is a unique highly flexible, cost effective, purpose built embedded antenna 

controller.  The primary application for this controller is for transportable satellite antennas exposed 

to harsh environments with demanding performance requirements.  The small form factor 

packaging of the controller enables its use in a wide range of antenna types – large and small.  By 

embedding the controller into the antenna pedestal, system cabling and connections are greatly 

simplified.   

The controller is an IP based network compatible controller that has a single core base code that can 

be applied over multiple hardware platforms.  Using parametric software that is configurable by 

user defined operational profiles, the controller can adapt to virtually any antenna size, positioner or 

sensor suite due to its modular approach in software and hardware.  Consequently, many different 

combinations of sensors, modems, beacon receivers, motors, third party applications and other 

devices can be readily integrated and used with the basic system. 

1.2 Standard Hardware Components 
 

The hardware architecture employs multiple micro-processors to distribute processing tasks 

efficiently and to share processing burdens optimally. The standard hardware consists of two 

embedded components, the ACU (Antenna Control Unit) and the NAV RIOM (Navigation Remote 

Input Output Module).  

 

The ACU contains a total of five (5) microprocessors – each dedicated to specific tasks.  The main 

processor is an ARM9.  With its extensive memory suite, it is capable of performing all 

administrative functions, networking, high level motion control commands, coordinate 

transformations, tilt compensation and communication with external devices via Ethernet or serial 

connections.  A 44-pin dsPIC33 microprocessor is used to communicate with the on board pitch and 

roll sensor and to provide additional analog and digital Input / Output capability.  Three 28-pin 

dsPIC33 microprocessors provide encoder quadrature, servo motion control and PWM (Pulse Width 

Modulation) output to each of three standard motors. 

 

The ACU includes an internal 4-port Ethernet switch, an RSL (Receive Signal Level) power meter, bias 

tee to supply LNB (Low Noise Block-Downconverter) voltage, tone generator and three motor servo 

drives.  The ACU is composed of a single PCB (Printed Circuit Board) enclosed in an aluminum 

housing with four (4) external connectors. 
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The NAV RIOM contains a GPS receiver and patch antenna, a 2-axis inclinometer and a magnetic 

compass.  It also has a dsPIC33 microprocessor which communicates with these internal devices as 

well as with the ACU over Ethernet. 

 

Both of these standard components are designed to survive in harsh environments and to be 

embedded in the antenna pedestal to simplify cabling. 

 

More information on Controller Hardware can be found in Chapter 7, Theory of operation. 

1.3 Software Architecture 
 

AAQ software consists of a family of code which provides a scalable, extensible, modular capability 

using parametric driven antenna behavior enabling users to tailor system performance as they wish. 

1.3.1 Operating System 
 

The operating system for the controller is LINUX. 

1.3.2 ROM 
 

The ROM code comprises the core software and performs administrative functions, coordinates 

transforms, tilt compensation and communication between RIOMs and other external devices. 

1.3.3 PIC 
 

PIC (Programmable Integrated Circuit) code is written to utilize the MicroChip PIC microprocessors 

in the system.  These are used for motion control, encoder quadrature, PWM motor input, various 

I/O connections.  Two pieces of PIC code are used to communicate with the two versions of PICs in 

the controller. 

1.3.4 CONFIG 
 

CONFIG files contain parameters and variables set to configure a specific antenna to perform all 

necessary functions. There are several types of CONFIG files – see Chapter 6 for a detailed description of 

these files. 

 

1.3.5 Remote – GUI (Graphical User Interface) 
 

The Remote files are provided to enable a graphical user interface to the controller.  There are two types 

of GUI; an XML Windows based .NET GUI (AAQ Remote) and a browser based HTML GUI. 
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1.3.6 Module – Device 
 

A Device Module file enables inter-operability and communication between the controller and a specific 

device.  An example of this type of vendor device module would be one created specifically for the 

iDirect Evolution 8000 Modem. 

1.3.7 Module – Function 

 
A Function Module enables specific unique functions in the controller.  An example of a function module 

is the Step Track Module. 

More details on the software architecture can be found in Chapters 4, 6 and 7. 

1.4 Controller Hardware Specification 
 

The two basic AAQ Controller components are the ACU and the NAV RIOM. 

ACU  

 Size:  approximately 8.3” H x 7.4” W x 1.4” D 

 Weight:  3 lb. 

 Communication Ports:  2 RS-232 ports, 1 Ethernet port 

 LNB Voltage Output:  0, 13 VDC, 18 VDC 

 Input Power:  24 to 32 VDC, 14A maximum 

 Operating Temperature:  -40°C to +60°C 

 Humidity:  0 to 95% RH Condensing 

 Environmental Protection:  IP65 

 Circuit Protection:  internal resettable 15A fuse  

NAV RIOM (Remote Input Output Module) 

 Size:  approximately 4” H x 1 7/8” W x 1 ½” D 

 Weight:  0.5 lb 

 GPS Receiver and Patch Antenna 

 Magnetic Compass, with error correction 

 Digital Inclinometer – 2 axes 

 Environmental Protection:  IP66 

 Operating Temperature:  -40°C to +60°C 

 Humidity:  0 to 100% RH Condensing 

 

 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 13 of 200 
 

1.5 Definitions and Common Terms: 
 

Antenna Bore Sight – line of sight passing through antenna vertex, feed phase center and satellite 

Azimuth – angular orientation of antenna bore sight about vertical axis; typical range ± 200°; 

 positive direction clockwise looking down on pedestal 

World Azimuth – angular orientation of antenna bore sight about gravity vector in local level 

 coordinate system 

Pedestal Azimuth – angular orientation of antenna bore sight about tilted and yawed pedestal 

 vertical axis 

Elevation – angular orientation of antenna bore sight about horizontal axis; typical range 0 to 90°; 

 positive direction up 

World Elevation – angular orientation of antenna bore sight about horizontal axis in local level 

 coordinate system with horizontal axis aligned with East-West plane 

Pedestal Elevation – angular orientation of antenna bore sight about tilted and yawed pedestal 

 horizontal axis 

Polarization – angular orientation of the plane of the electric field perpendicular to the plane of 

 propagation in the receive RF signal; can be linear or circular 

World Polarization – skew angle of the feed relative to antenna bore sight plane and the equatorial 

 plane 

Pedestal Polarization – skew angle of the feed relative to the tilted and yawed antenna bore sight 

 plane and the equatorial plane 

Pitch – angular displacement of pedestal about local level horizontal axis that is fixed in the local 

 tangent plane 

Roll – angular displacement of pedestal about local level transverse axis that is fixed in the local 

 tangent plane 

Latitude – local latitude measured from Earth’s Equator; latitude is typically determined from the 

 embedded GPS 

Longitude – local longitude measured from Greenwich Meridian where East longitude is positive, 

 West longitude is negative; longitude is typically determined from the embedded GPS  
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Compass Heading -   0° = North, 90° = East, 180° = South, 270° = West; typically measured by 

 embedded magnetic compass with declination adjustment or True North heading without 

 declination adjustment 

Tilt – non-level condition where pedestal horizontal and vertical axes are pitched and rolled so 

 pedestal azimuth axis is no longer aligned with local gravity vector 
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Chapter 2 - AAQ System Architecture & Hardware Overview 
 
 

2.1 Controller System Block Diagram 
 

The basic AAQ Controller block diagram is shown in Figure 1.1. The AAQ communicates with the motors 

and NAV RIOM on an internal LAN. The ACU requires 28 VDC and communicates externally over a LAN or 

WAN. The User Interface can be any combination of personal computer (custom GUI application or web 

browser), 1 RU Control Interface or Hand Held Control Interface. 

 

 

Figure 2.1 - AAQ Controller Hardware Components. 
 

 

 

EL 

MOTOR 

AZ 

MOTOR 
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The AAQ consists of a single PCB (Printed Circuit Board) enclosed in an aluminum housing with four (4) 

external connectors.  The 8-pin power connector (J3) receives 28 VDC power and distributes the PWM 

voltage to each of the three standard motors.  The TNC coax connector (IF IN) receives RF signal from 

the LNB.  Two D-sub miniature connectors, one 28-pin (J2) and one 44-pin (J1) provide connection to 

various sensors and other external devices, including the NAV RIOM, over serial and Ethernet.  The AAQ 

Enclosure is shown in Figure 2. 

 

 

 

Figure 2.2 - AAQ Enclosure and Connectors 
 

2.1.1 The AAQ enclosure contains: 

 
1. CPU:  ARM9 running the LINUX OS 

2. Memory:  4 GB micro SD, 2 GB RAM, 4 GB NAND Flash w/battery backup 

3. Servo Control:  3-axis Brushed DC Motors (EL 12A, AZ 8A, POL 5A) 

4. Encoder Feedback:  3-axis quadrature encoder circuits 

5. RSL:  RF Signal Detector with Variable Attenuator 

6. Tilt Sensor:  2-axis 

 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 17 of 200 
 

 

7. Communication Ports:  2 RS232 and 2 Ethernet  

8. Ethernet Switch:  4-port 

9. Positioner Sensor Inputs:  Digital and Analog  

10. LNB Bias Tee and Tone Generator 

11. Sensor Analog and Digital I/O Interfaces 

 

The AAQ enclosure shown in figure 2.1.1 is generally mounted underneath the positioner AZ/EL 

cover. Each connector on the enclosure has a wire harness to connect to positioner components. 

 

 

Figure 2.1.1 - AAQ Controller - Typical mounting in a positioner 
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2.2 AAQ Antenna System  
 

The controller combined with the proven AvL pedestal provides a pure and simple solution for 

communications in any environment. The controller offers many intuitive features allowing the user to 

successfully maintain and operate the antenna both locally and remotely from anywhere in the world.  

 

2.2.1 AvL Cable Drive System 

 

The AvL cable drive system that is used with the AAQ Controller, utilizes highly reliable aircraft 

control cables in a redundant configuration to achieve a zero backlash, light-weight, very stiff drive 

system. It achieves this high-tech performance by wrapping the cable around the drive capstan 

several times before wrapping the larger drive drum. The method used to wrap the capstan results 

in a minimum free length of cable. The load in the cable on the main drum is exponentially reduced 

as it is wrapped around the drum. Therefore, the total elongation of the cable when under load is 

minimized. The AvL cable drive system results in stiffness of up to 10 times that of comparable gear 

or harmonic drive systems. The cables are pre-tensioned and spring loaded at the main drum 

attachment point which eliminates backlash at installation and backlash from any cable stretch in 

the future. 

 

2.2.2 Motor Drives 

 

Lightweight, reliable, DC motors with integral gearboxes are used for the Az, El and Pol drives. These 

motors were selected because they provide the best torque-to-weight ratio as well as allowing dual 

speed operation for slewing and peaking. These motors produce constant torque over a wide speed 

range, which ensures smooth operation when peaking the antenna.  

 

Additional information on the AAQ controller, Cable drive & antenna systems can be found in the 

Theory of operation section Chapter 7. 
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2.3 AAQ Components  
 

2.3.1 Navigation Remote Input Output Module (RIOM)  

 
The NAV RIOM contains a GPS receiver and a 3 axis magnetic Compass. Depending on the model a 2-
axis inclinometer may reside within the NAV RIOM.  The NAV RIOM (see Figure 2.3.1) is plugged into 
the AAQ’s J2 harness and it is typically mounted on the back of the reflector at the topmost point 
when deployed.  At this location, the GPS antenna is afforded a good view of the sky, in order to 
provide accurate location and pointing information. 

 

 

 

Figure 2.3.1 - NAV RIOM on Reflector 

 

 

 

 

 

 

 

 

NAV RIOM 

Top of Reflector 
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Chapter 3 - GUI Installation, Set-up & Network Configuration 
 

This chapter describes the GUI “Graphical User Interface” installation and set-up as well as, how 

to configure the AAQ controller to communicate and function within a network of Ethernet 

devices.  The available networking options on the AAQ controller are to ensure that the antenna 

controller is able to properly communicate with both clients (computers, mobile devices, CIP 

interfaces, etc.) and required devices (modem, beacon receiver, GPS device, etc.).   

 

3.1    Requirements 
 

Operating System: 

 Microsoft Windows 10 

 Microsoft Windows 8.1 

 Microsoft Windows 8 

 Microsoft Windows 7 

 Microsoft Windows Vista 

 Microsoft Windows XP (with appropriate service packs, updates, framework 
and settings) 

.Net Framework: 

 .Net Framework 3.5 or greater 
 

Important Note - Uninstall any previous version 

 

If a previous version of the AAQ Remote is installed on your system, always remove it before installing a 
newer version of the application. 
 
Using Windows 8 or greater, select; 
 

Path 

Main Window → Start → Settings Button 

Search “programs and features” in the search dialogue box 

 
Using Windows 7, Vista, or XP, select; 

 

Path 

Main Window → Start → Control  Panel 

Programs ->Programs and Features 
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This will prompt the programs and Features screen. Uninstall the file by left clicking the “AAQ Remote” 
file, initiating the uninstall wizard.  
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Figure 3.1 - Programs and Features 
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3.2    Installation 

3.2.1 Windows installation file 

 
Begin by installing the AAQ Remote on your operating system through the AAQRemoteSetup_X-X-X-X.msi 

(Windows installation file), provided in your Customer Documentation Flash Drive.  

 

 
 

Figure 3.2.1 - Installation File 
 

3.2.2 Installation Folder 

 
By default the wizard will save the GUI under the PC’s ‘All Programs’ menu located under: 
 START > ALL PROGRAMS > AAQREMOTE. 

 
Figure 3.2.2 - Installation Wizard 

 

 Important - Use the Default location. 
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Once the installation is complete, a shortcut to the program will be located on the desktop. 

 

 
 

Figure 3.2.2b - Remote Icon 
 

3.2.3 AAQ Remote Access Settings 

 
The AAQ Controller allows for different user interactions based on the access level of the user.  This 
allows for the end user to engage in a simple to use experience (level 0), while keeping the 
customization available for knowledgeable users with higher level login privileges.  The AAQ Remote 
application incorporates these login level rules.  Depending upon the login level of the user various 
tools and interactions will become available.   

 

  Note - Integrators are typically set to access level 4 from the factory. 

 

3.2.4 AAQ Remote Settings (Access Level 0) 

The Remote Settings window displays the IP address, directing the Graphical User Interface 

(GUI) to the AAQ antenna controller unit (ACU).   The default service address is shown. 

 
 

Path 

Main Window → File → Settings 

AAQRemote Settings 

 

 

Figure 3.2.4 - AAQ Remote Settings (Level 0) 
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3.2.5 Editing Controller Alias 

 
The “Controller Alias” pull down feature allows the user to associate an alphanumeric name with an 
IP address. This feature is accessed by clicking the “Edit” button in the AAQ Remote Settings 
window. This allows users to identify specific systems within a network. 

 

 
 

Figure 3.2.5 - Edit Controller (Alias) Profile 
 

3.2.6    AAQ Remote Settings (Level 1-9) 

 

 
 

Figure 3.2.6 - AAQ Remote Settings (Level 1-9) 
 

 

Note - See Chapter 4 for description of non-network GUI description & settings 
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3.3  Network Settings 
 

3.3.1 Factory IP Addresses 

 
The AAQ controller provides three interfaces to the customer’s network: 
 

 
 

Figure 3.3.1 – AAQ Controller IP Interfaces 
 

 

For direct communication to the controller from a PC or Laptop, the computer attached must be 
on the same network and subnet.  This can be done by changing the Local Area Connection Status 
(TCP/IPv4) of the Ethernet port on the user’s PC.   
 
 

 
 

Figure 3.3.1b - Valid TCP/IPv4 Settings example 
 
 

The controller address can be changed through the AAQ Remote application by left-clicking the 

File button on the File Bar and selecting “Settings”.  The Settings window is capable of setting 

the current IP address of the controller and setting a new IP address to the controller to use on 

the next power cycle.  The controller will accept any valid IPv4 address in the following ranges: 

 

 
 

Figure 3.3.1c - Valid IP Address Range 
 

Note – The Control Interface Panel display uses the 192.168.129.59 address and is 

Non-Configurable. 

Eth 1:0 – Interface #1, Configurable  (Factory Default IP: 192.168.129.50)      

Eth 1:1 – Interface #2, Configurable  (Factory Default IP: 192.168.129.52)     

Eth 1:2 – Service Interface, Non-Configurable (Factory  IP: 192.168.129.51) 

  

Subnet mask:    255.255.255.0 

IP address:   192.168.129.22 (1 to 254) 

Subnet mask:    255.255.255.0 

Octet Range:  1 to 255 . 0 to 255 . 1 to 255 . 1 to 255 
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3.4 AAQ Remote Network Settings Tool 
 

The AAQ Remote Settings tool is utilized to customize the AAQ Network IP settings using login 

level 4 or above.  

 

Path 

Main Window → File → Settings 

AAQ Network Interface Options 

 
 
Modems, beacon receivers, etc. will sometimes require the AAQ controller to be configured on 

the device network, enabling communications between the two devices.  

 

 
 

Figure 3.4 - Advanced Network Settings Tool 
 
 

Window item Description 

DHCP 

When the ACU is set to use DHCP, make sure that the server is also 
a DNS server. Using a DHCP server without a DNS server will cause 
the ACU to receive a valid IP address that is unknown to the user. 

Customer Network 1 & 2 

Customer IPs may be changed in accordance with customer device 
requirements. Once a new address is entered, click “Apply” to 
make the change.  

Service Network 

The service IP is permanent and available for recovery if 
necessary. If a fault has occurred in setting the new IP Address, the 
ACU defaults to the original 192.168.129.51 address.   
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Refresh 
To query the current running network configuration, left-click the 
Refresh button on the left side of the window.  *Note button will 
display as “Populate” if no IP addresses are visible in the window. 

 
 

3.5 IP addressing and Networking Examples 
 

 

The following examples describe how to set up the AAQ controller to communicate and function 

within a network of Ethernet devices.  The available networking options on the AAQ controller 

are to ensure that the antenna controller is able to properly communicate with both clients 

(computers, mobile devices, CIP interfaces, etc.) and required devices (modem, beacon receiver, 

GPS device, etc.).   

 

 

The AAQ controller provides two configurable interfaces to the customer’s network; 

Eth1:0 (Settable interface #1) and Eth1:1 (Settable interface #2). These network interfaces can be 

configured using the provided AAQ Remote application.  Each interface can be configured to use 

a specific IP Address, Subnet Mask, and Gateway.  The use of two interfaces allows the user to 

configure the controller to be active on multiple networks communicating with multiple external 

devices, but keep the devices independent within the network. 

 

 

The permanent non-settable “Service Network” interface is intended to remain available in the 

event the settable interfaces are unknown or an AvL Service Technician requires access to the 

system. 

 

 

Note - Newer CIP units (Gray face) may be configured with router functionality 

either from the factory, or via the AvL Updater Tool. For the scope of this 

chapter, all examples are shown with CIPs configured as a simple 

network switch. See Appendix B of this manual for further information. 
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3.5.1 Factory Default Network Configuration  

 
Equipment described:   

 AAQ Controller 

 Client Computer 

 

Connection Eth1:0  Customer Network Eth1:1  Customer Network Eth1:2  Service Network 

IP Address 192.168.129.50 192.168.129.52 192.168.129.51 

Subnet Mask 255.255.255.0 255.255.255.0 255.255.255.0 

Gateway None None None 
 

Fig. 3.5.1a - Factory Network Example 
 

The default network configuration contains basic networking needed to set up the controller on the 

customer’s network.  The IP addresses are set on the 192.168.129.x network.   

To communicate to the AAQ controller connect a computer to the controller as shown below: 

 

 
 

Figure 3.5.1b - Simple Network Configuration Example 
 

 
In the above example, the computer may be set to any address within the subnet, 
192.168.129.1 through 192.168.129.254 with the exception of the controller address. 

  

Static IP Address:  192.168.129.2 

Subnet Mask:       255.255.255.0 

 

Computer 

IP Address:  192.168.129.50 
Subnet Mask: 255.255.255.0 

 

AAQ Controller 
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3.5.2 Single Device Configuration 

 

Equipment described: 

 AAQ Controller  

 Client Computer 

 Standard IP Modem (external) 

 Network Switch (or CIP) 

 

Connection Eth1:0  Customer Network Eth1:1  Customer Network Eth1:2  Service Network 

IP Address 192.168.1.50 192.168.129.52 192.168.129.51 

Subnet Mask 255.255.255.0 255.255.255.0 255.255.255.0 

Gateway None None None 
 

Figure 3.5.2a - Single Device Example 

 
In this example, the controller is tasked with communicating with a modem that is used as 

feedback for acquisition of the satellite.  The modem communicates on a standard IPv4 scheme.  

One of the controller’s settable interfaces (Eth1:0 Customer Network) will be changed to 

communicate to the modem on the modem’s preset or existing network.  When connecting 

Ethernet devices to the controller it is necessary to use the network switch contained in the CIP 

so the controller can communicate with both the modem and client computer.   

 

 
 

Figure 3.5.2b - Single Device Network 

IPv4 Address:  192.168.1.2 
Subnet Mask: 255.255.255.0 
  

Computer 

IPv4 Address:  192.168.1.10 
Subnet Mask: 255.255.255.0 
  

Modem 

IPv4 Address:  192.168.1.50 
Subnet Mask: 255.255.255.0 
  

AAQ Controller 

Network Switch (Internal to CIP) 
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3.5.3 Dual Network Device Configuration 

 
Equipment described: 

 AAQ Controller  

 Client Computer 

 Standard IPv4 Modem  

 Beacon Receiver 

 Network Switch (or CIP internal) 

 

Connection Eth1:0  Customer Network Eth1:1  Customer Network Eth1:2  Service Network 

IP Address 192.168.1.50 192.168.2.50 192.168.129.51 

Subnet Mask 255.255.255.0 255.255.255.0 255.255.255.0 

Gateway None None None 
 

Figure 3.5.3a - Dual Network Device Example 
 

In this example, the controller is tasked with communicating to two different acquisition devices, 

a modem and beacon receiver.  Both devices communicate using an IPv4 scheme.  Both settable 

controller interfaces must be used at this point, one for each device.  The Eth1:0 Customer 

Network interface will be set to communicate to the modem and the Eth1:1 Customer Network 

interface will be set to communicate to the beacon receiver.  Though each device is on a different 

IP network by setting both interfaces the controller will be able to communicate to both devices 

simultaneously.   

 
 

          Figure 3.5.3b - Dual Network Device Configuration Example 

IPv4 Address:  192.168.1.2 
Subnet Mask: 255.255.255.0 
  

Computer 

Modem 

Network Switch (Internal to CIP) 

IPv4 Address:  192.168.2.20 
Subnet Mask: 255.255.255.0 
  

Beacon Receiver 

IPv4 Address:  192.168.1.10 
Subnet Mask: 255.255.255.0 
  

IPv4 Address:  192.168.1.50 192.168.2.50 
Subnet Mask: 255.255.255.0 255.255.255.0 
  

AAQ Controller 
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3.5.4 Cross Device Network Configuration 

 
Equipment 

- AAQ Controller  

- Client Computer 

- Standard IPv4 Modem 

- Network Switch (Internal to CIP) 

- Network Router 

 

 

Connection Eth1:0  Customer Network Eth1:1  Customer Network Eth1:2  Service Network 

IP Address 192.168.1.50 192.168.3.50 192.168.129.51 

Subnet Mask 255.255.255.0 255.255.255.0 255.255.255.0 

Gateway None 192.168.1.1 None 
 

Figure 3.5.4a - Cross Device Network Example 

 

 

In this scenario the controller needs to communicate with an acquisition device that is not on the 

same physical network as the controller.  Cases like this would include the device being at a different 

location, or that the device handles sensitive data and cannot be on the controller network, or that 

networking on the controller’s network interferes with the device’s ability to function.  In these and 

other examples, a network router must be added as a gateway to handle traffic to the external 

network.  The controller is configured to use the router as a gateway to communicate to the modem 

that is located on the external network.  This allows a physical separation of the controller 

networking from the modem’s network. 
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Figure 3.5.4b - Cross Device Network Configuration Example 

 

 
 

 

 

 

 

IPv4 Address:  192.168.1.2 
Subnet Mask: 255.255.255.0 
  

Computer 

Modem 

Network Switch  

IPv4 Address:  192.168.1.1 
Subnet Mask: 255.255.255.0 
  

Network Router 

IPv4 Address:  192.168.3.30 
Subnet Mask: 255.255.255.0 
  

IPv4 Address:  192.168.1.50 192.168.3.50 
Subnet Mask: 255.255.255.0 255.255.255.0 
Gateway:   192.168.1.1 

AAQ Controller 

External Network 
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Chapter 4 - AAQ Remote .NET GUI 
 
This chapter is intended to familiarize the user with the various graphical views and associate functions of the 

AAQ Remote.NET interface. 

 

4.1 Introduction 
 
 

The AvL Technologies’ Graphical User Interface (GUI) is designed for use with the AAQ controller system and 
uses the Microsoft .NET 3.5 framework.  This framework allows the use of the AAQ Remote GUI across most 
Microsoft operating systems: Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Vista, and 
Windows XP (provided XP users have proper service packs, updates, framework, and settings).  
 
 
 The AAQ system relies on an Ethernet (RJ45/Wireless/etc.) connection from the PC to the controller’s ACU 
module.  Once properly connected, the AAQ Remote GUI will provide communication with the AAQ 
controller and allow the user to monitor, configure & control the positioner. 
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4.2 Interpreting the Display 
 

4.2.1 Main Window 

 

 
 

Figure 4.2.1 - AAQ Remote Front Panel 
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4.2.2 Connection Indicator 

 
Upon opening the AAQ Remote application the program will attempt to establish communication 
with the connected AAQ Controller.  Once connection is established the Connection Indicator LED 
located in the bottom left corner of the application will turn from inactive (grey) to active (green), 
shown in Figure 4.2.2. 
 

 
 

 
 

 
 
 

Figure 4.2.2 - Connection LED 
 

If the connection light does not change to active (green), communication has not occurred between the 
controller and PC.  Check to make sure the IP address of the application is correct (File → Settings), the 
computer’s IP and subnet mask are valid, and the physical Ethernet connection is present.  See Chapter 
3 for network settings. 

 

4.2.3 RIOM (Remote Input Output Module) Indicators 

 

 
 

Figure 4.2.3 - RIOM Connection Indicators 
 

The RIOM Connection Indicator LEDs will change from inactive (grey) to active (green) when the 
controller has negotiated a connection to each RIOM, these indicators give the user the ability to 
check system wide communication at a glance.  If any of the RIOM Connection LEDs remain inactive 
there is a connection issue to that RIOM module and troubleshooting needs to be performed before 
system operation can begin. 

 

4.2.4 Scrolling Alarms 
 

Scrolling Alarms may be seen on the front panel to notify the user of a problem to be addressed.  See 
Alarms and messages in Chapter 8 for more information. 

 

 
 

Figure 4.2.4 - Scrolling Alarm Indicator example 
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4.2.5 Command Pane 

 

 
 

Figure 4.2.5a - Command Pane 
 

The Command Pane contains the main controls for antenna movement.  Each control is an LED 
indicator button with a descriptive label.  When clicked the action associated with the control is 
performed.  When the controller is performing an action the associated control LED will become 
active (green) indicating that it is the current command.   

 

Command Action Taken 

Stop Stops the controller 

Manual Control Activates the manual control functions 

Home Moves antenna to the “Home” position 

Stow Stows the antenna 

Acquire Acquires the selected satellite  (Home must be completed first) 

Move to… Moves the antenna to a specific position (Home must be completed first) 

Repeak Finds the signal peak in accordance with fine pointing device 

Peak Peaks on the signal in accordance with coarse pointing device 

Track Tracks the signal in accordance with option specified 

X Pol Flips the pol 90 degrees to simplify “Cross Pol” testing 

 

Figure 4.2.5b - Command List 
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4.2.6 Manual Control Pane 

 

 
 

Figure 4.2.6 -Manual Control Pane 
 
The Manual Control Pane contains the controls for manually jogging the antenna in any direction and 
axis.  This pane is inactive until the controller is in manual control mode.  To activate manual control 
mode select ‘Manual Control’ control from the Command Pane.   
 

If the Step Mode Checkbox is unchecked the system will operate in a “jog until released” mode.  While 
the button is pressed the antenna will move in that direction until the button is released. 
 

If the Step Mode Checkbox is checked the system will operate in a “jog by step” mode.  When the 

button is pressed the system moves the antenna in the direction of the button pressed by the 

amount listed in the Step Amount Display text box.  While the antenna is moving to the position, 

button presses are ignored, steps are not accumulated by pressing the button multiple times. 

 

Note – For Jog by step mode, home command must be run first to initialize encoders 

before operation. 

 

4.2.7 Heading Source 

 

 

 

 

 

 

 

 

 

Figure 4.2.7a – Heading Source Pulldown 
 
The heading source pane allows the user to select the device that will be used to determine heading coordinates 
for the controller. Available choices are described below. 
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 Device Description 

No Compass 
This is typically selected for locations where magnetic interference is expected. In this 
case, the antenna will make a wide scan in accordance with the “NoCompass Scan 
Width” parameter 

GPS or AvLGPS For future release. 

Compass This is the most common setting which uses the NAV RIOM built-in compass. 

Manual 
For manual compass, the pedestal is set physically due south (northern hemisphere). 
The heading is assumed to be at 180 degrees from this point. 

SatTant 
When selected, the antenna will base its heading on stored data from a previous 
SatTant acquisition. If no data exists, the antenna will attempt a SatTant acquisition. 
During this acquisition, initial heading info will be obtained from the Compass. 

VectorCompass To be used only when the Vector Compass option is installed for high accuracy systems. 

 
Figure 4.2.7b – Heading Source Device Descriptions 

 

4.2.8 Target Selection Pane 

 

 
 

Figure 4.2.8 - Target Selection Pane 
 

The Target Selection Pane contains the satellite profile currently active from the ACU’s onboard satellite 

profile list.  Opening the Target Profile Selection Dropdown Menu displays all of the available profiles 

which may be selected for acquisition.  Once a new profile is selected it becomes the running 

configuration and its target satellite will be shown in the “Current Satellite Display”. 

 

Once the controller has entered acquisition mode the Actual Target Position Display will update to 

display the selected satellite’s position relative to the antenna.  

  

Profile Selection Dropdown Menu 

  

Actual Target Position Display Current Satellite Display 

  



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 40 of 200 
 

4.2.9 Status Pane 

 
Figure 4.2.9a - Status Pane 

 

The Status Pane displays commonly used sensor outputs from the controller.  These are variables that 

the controller reports back to the application to be displayed for quick reference.  Other variables can be 

accessed through the Sensor Output Window.  The variables being displayed can be selected through 

‘File -> Edit Layout’. 
 

 
 

Figure 4.2.9b - Motor Status Indicators 

 

  

Status Variable Display 

  

Motor Status Indicators 
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The Motor Status indicators inform the user of the direction of motor movement, limit conditions 

reached, and safe move conditions reached.  Each indicator represents a direction of movement 

possible by a certain axis and is styled to be in that movement’s direction.  When moving in that 

direction the indicator will change to active (green)   to indicate that the motor is moving in that 

direction.  The indicators also function as an indicator to the operator that a condition has been 

reached.   

 

Condition Motor Status LEDs Displayed 

Azimuth Clockwise Limit Reached 
           

Azimuth Counter Clockwise Limit Reached 
           

Pol. Clockwise Limit Reached 
           

Pol. Counter Clockwise Limit Reached 
           

Elevation Up Limit Reached 
            

Elevation is Below the Down Limit 
           

Elevation is in the Stow Position / 
Elevation Limit Reached & Wings Open            

Error Condition: Check Alarms 
           

 

Table 4.2.9c - Motor Status Indicator Conditions 

 

 
 

4.3 File Menu 

4.3.1 Settings 

 

Path 

Main Window → File → Settings 

Simple View: Level 0 / Advanced View: Level 1 
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Figure 4.3.1a - Simple (Level 0) Settings Window 
 

There are two versions of the Settings Tool.  Users at level 1 or above are able to access the advanced 

Settings Tool while level 0 (or not logged in users) will only be able to access a simple Settings Tool.  The 

simple version of the Settings Tool allows the user to change the I.P.v4 address pointing the application 

to the AAQ Controller’s present address.  This is the address that the controller is using for network 

communication.  This setting is available in both versions of the Settings Tool. 

 

 
 

Figure 4.3.1b - Advanced (level 1) Settings Window 

 

By default the AAQ Controller indicates the static TCP/IPv4 service address 192.168.129.51.  The 
service address is permanent and cannot be changed. The configurable Ethernet interfaces can be 
changed through the AAQ Remote application by clicking the “AAQ Network Interface Options” 
button on the Settings window.  The controller will accept any valid IPv4 address in the following 
ranges: 
 

 

 

1-255.0-255.1-255.1-255 
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The controller’s Subnet Mask and Default Gateway can also be set through this method.   
 

If a failure has occurred in setting the new IP Address, the ACU defaults back to the original 
192.168.129.51 service address.   

  

IP Address 192.168.129.51 

Subnet Mask 255.255.255.0 

Default Gateway 192.168.129.1 
 

Figure 4.3.1c - Recovery Network Settings 
 

Command Delay (sec) represents the amount of delay that the application will wait before sending 

the command requested in the Command box, located in the main window, to the controller.  

Setting this text box to ‘0’ eliminates any delay in sending the command from the application. 

Various application options are available to customize the user experience.  These options are 

turned on and off by checking and unchecking the checkboxes located near the bottom of the 

window. 
 

Checkbox Action 

“Show Graphical Window on 
Open” 

When the application is opened the main window will be minimized and 
the graphical window will be displayed. 

“Show Limit Error Messages” 
Once the system has encountered any type of limit a message box will 
appear visually alerting the operator that they have reached a limit and 
must take action. 

“Show Manual Control Speed” 
When in manual mode, speed of antenna is displayed in control pane. 
(Slow or Fast) 

“Show Long System Message” Displays optional system messages which are longer and more descriptive. 

“Show System Message Codes” Displays system message reference codes along with messages. 
 

Figure 4.3.1d – AAQ Remote Setting Options 
 
 
 

4.3.1.1 – Advanced Network Settings 

 

Path 

Main Window → File → Settings, AAQ Network Interface Options Button 

Advanced View: Level 1 
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Figure 4.3.1.1 - AAQ Advanced Network Settings 
 
 

Under the advanced network settings, the two customer networks are accessible to allow connection to 
system devices that reside on different networks. See chapter 3 on network settings for more details. 

 
If your network setup allows for network devices to use a DHCP & DNS server you may set the ACU 
to obtain its network settings through the DHCP & DNS server via the DHCP checkbox.  

 
Using a DHCP server without a DNS server will cause the controller to receive a valid IP address that is 
unknown to the user. Whenever the ACU is set to use DHCP make sure that the server is also a DNS 
server. 
 

To check the current running network configuration click the refresh button on the left side of the 
window.  The application will then query the current network settings on the controller and display 
them to the user. 
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4.3.1.2 – Remote Power Network Settings 
 

 
 

Figure 4.3.1.2 – Remote Power Network Settings 
 
 

The AAQ provides remote power control which is network accessible. The power control device has 
its own IP settings and defaults to those shown in figure 4.3.1.2. When the controller network is 
changed to a different subnet however, the Remote Power settings must be changed to this new 
subnet in order to maintain remote power control. Remote Power functions are described below. 
See chapter 3 for further details on setting system IP addresses. 
 
 
 

Heading Description 

Alias 
Addresses for multiple terminals may be added to a stored listing. Assigning an Alias 
to the IP address simplifies selection when the function is used. 

Current Settings Shows the IP of the remote power device currently connected. 

New Settings This allows the device address to be updated. Press “Update Local Settings” to save. 

Add 
When pressed, a window pops up allowing a new Alias as well as IP address 
information to be entered for a new terminal remote power device. 
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4.3.3 AAQ Support Files, Upload / Download… 

 

Path 

Main Window → File → Upload / Download … 

Level 4 

 
 
Software, configuration, and firmware files for the AAQ Control system can be uploaded through the 
AAQ Remote application.  To upload or download a file from the AAQ controller left-click the File 
button on the File Bar and select “Upload / Download …”.  This will open the Maintenance Window. 
 

 
 

Figure 4.3.3a – System Maintenance Window 
 

From the Maintenance Window there are various options of uploading, downloading, and resetting 
the software on the AAQ Controller.  Files used by the controller include ROM files, Configuration 
files, and Module files.  To Upload a new file or Download the currently loaded file left-click the 
appropriate button, the user will then be asked for a file location to upload from or download to.   
 
Pressing Previous ROM will load the last used version which is stored in memory. Pressing Remove 
Module permanently deletes it from memory. 
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System Maintenance allows a “Master Restore” backup file to be created and uploaded if needed by 
pressing  Download Backup. This file contains all types of files listed below which are necessary to 
run the controller. 

  
 

 AAQ File Types             

ROM The AAQ software running on the controller. 

Module 
A file that contains information used by the AAQ software to interface with 
external and internal devices or software (Modem, Beacon Receiver, 
Tracking Libraries, etc). 

Config 
The complete configuration file used by the AAQ software that holds system 
parameters. 

Firmware A file that modifies the controller to add new features to the Linux kernel 

 
Figure 4.3.3b – AAQ File Types 

4.3.3.1 Uploading an Encrypted Service Configuration File 
 

The AAQ Remote application has the capability to accept an encrypted service configuration file.  
This encrypted configuration file can be provided by AvL Technologies and is uploaded the same as a 
regular configuration file.  When detected during a configuration upload, this will change 
configuration items as an administrator level user without the need to log in. 
 

4.3.3.2 Uploading, Downloading, and Removing Module Files 
 

Module files are specific files that allow the AAQ software to communicate with various interfaces.  
These interfaces include, but are not limited to, modems, beacon receivers, tracking libraries, and 
translators.  This allows the system to implement end user specific hardware or software without 
the need for AAQ software change.   
 
To upload or download a Module file left-click the Upload or Download Module button in the 
Maintenance window.  This will bring up a Windows location dialog box.  
 
When performing a module upload the controller software will be stopped and once the routine has 

completed uploading the module the power to the controller must be cycled to complete the 

process. 

4.3.4 Calibration 

 

4.3.4.1 Compass Calibration 

 

 

Path 

Main Window → File → Calibration → Compass Calibration 

Level  4 
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Figure 4.3.4.1 – Compass Calibration 

 

Calibration of the module is generally used by AvL technical personnel only but may be suggested 

when an antenna system is being installed onto a permanent mount or vehicle for the first time. 

Calibration may also be required when an antenna system is moved into an area of high magnetic 

disturbance.  

Caution - This function calibrates the compass device itself and cannot be removed. For setting 

compass read offsets to the controller, use the Compass Test Tool. 

Pressing the Automated Calibration button starts the calibration process without any user 

assistance. The antenna will swing throughout its entire azimuth range and the process may take up 

to 10 minutes or longer. Once it is complete, the user will be informed and directed to run the 

Compass Test Tool to determine the correct heading offset. 

 

4.3.4.2 Compass Test Tool 

 

Path 

Main Window → File → Calibration → Compass Test Tool 

Level  4 

 

The Compass Test Tool also calibrates the Compass however, user intervention is required and a 

tool window is provided which displays progress and allows some settings to be changed. 
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Figure 4.3.4.2a – Compass Test Tool Window 

 

Once the window is open, check that “Honeywell” is selected at the top and press “begin Testing. By 

default the tool will scan from the CCW Limit to the CW Limit.  If the system allows greater than 360 

degrees of motion, it will only scan 360 degrees.  Additionally, scanning will pause every 10 degrees 

to calculate the heading.  This is configurable by the vendor, but it is recommended that it is left at 

the default setting. 

 

Once testing has begun, you will be prompted to supply the Heading at the home position.   This 

value does not have to be exact, but needs to be close. For example, if the unit is roughly facing 

south then a value of 180 will suffice: 
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Figure 4.3.4.2b – Enter Heading 

 

Once OK is selected the program will determine if the compass is within tolerance (+/- 10 degrees or 

20 Peak-to-Peak).  If the compass is within tolerance it will inform the user of the recommended 

Heading offset and ask them if they wish to apply it to the configuration item. Apply the offset to 

complete. 
 

 
 

Figure 4.3.4.2c – Test Results 

 

Note - If the program indicates that the compass is out of tolerance, repeat the 

calibration process. 

 

4.3.5 RIOM Software Update 
 

Path 

Main Window → File → RIOM Software Update 

Level  4 
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Figure 4.3.5 – RIOM Software Upload 

 

From the RIOM Software Maintenance window, the user can update specific RIOM based devices on the 

system. When the “Upload RIOM Payload” button is pressed, the user is prompted to pick the location 

of the new file via a Windows location dialog box. Once the upload(s) are completed, the files will be 

shown in the “payload” box.  

 

To program individual RIOMs, first make sure that the correct files have been uploaded. Then check the 

appropriate box in the right-hand pane for the device(s) to be updated. For each RIOM device, use the 

pulldown to select the appropriate file and press “Program RIOM(s) when ready 

 

 

 

4.3.6 Show Movement 

   

Path 

Main Window → File → Show Movement 

Level 4 
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Figure 4.3.6 - Show Movement Tool 
 

The Show Movement Window allows the demonstration of physical movements and actions.  To setup a 

“Show Moves” routine simply fill in the text boxes for Azimuth, Elevation, and Polarization.  These text boxes 

are the pedestal location where the antenna will move to during the routine.  An optional third position is 

available for more dynamic movements.  If a limited number of moves are required, type the desired cycle 

number in the Desired Cycles text box.  If continuous motion is desired, check the “Continuous” checkbox.  

The routine has the capability of performing single or multi axis movements depending on the axis button 

pressed, located In the upper portion of the window.  Movement will begin when the desired axis button is 

pressed. 
 

 

4.3.7 Edit GUI Layout 

 

Path 

Main Window → File → Edit layout 

Level 4 
 

The Command box and Status box that appear on the main page of the application can be modified to 

show a variety of commands and status outputs at a glance.  All outputs can be viewed through the 

application, but the layout of the main page can be changed for user convenience in the field. To change 

the layout presented on the main page open the Layout Editor.   
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Figure 4.3.7 – Layout Editor 

The Layout Editor lists the current commands and status outputs being displayed in the main window.  

The “Change Commands Displayed” function is reserved for Engineering Login only and does not 

function under user or integrator levels.   

To change the status variables displayed in the Status box on the main window, left-click the 

‘Change Status Variables’ button.  The Status Variable Select Window will then allow the user to 

choose the status variables to display in the Status box on the main window.  Once all changes have 

been made, left-click the ‘Save’ button to accept the changes.  The application will now apply the 

changes the next time the application launches. 

 
 

4.3.8  Change Status Variables Displayed 

 

 

Path 

Main Window → File → Edit layout, Change Status Variables 

Level 4 
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Figure 4.3.8 – Status Variable Select 
 

The Status Variable Select Window allows the user to choose and order the status variables to 

display on the main window.  The sub-window Selectable Status Variables, located on the left side of 

the screen, contains all status variables reported by the controller.  To include a variable in the main 

window, check the ‘Use Variable’ checkbox beside the desired status variable.  Once checked the 

variable will be included in the sub-window Change Order of Variables, located on the right side of 

the screen.  From the Change Order of Variables sub-window the order of all selected variables may 

be changed.  To move a variable up left-click the ‘↑’ button beside the variable.  To move a variable 

down left-click the ‘↓’ button beside the variable.  To remove the variable from the main window 

left-click the ‘X’ button beside the variable, this will remove it from the list and uncheck the variable 

in the Selectable Status Variables sub-window. 

 

4.3.9 User Manager  

 

Path 

Main Window → File → User Manager  

Level 1 

 

Users have the ability to add, edit, and delete users depending upon their login level.  Any user of a 

specific level may modify other users up to their login level.  For instance a level 4 user may create a 
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level 3 user, but may not delete a level 9 user.  Before performing any modification, log into the 

controller with your usage rights. 
 

Note - Customer user profiles are typically set to access level “4” 

 

4.3.9.1 Adding Users 

 

Path 

Main Window → File → User Manager → Add User 

Level 1 

 

 

 
 

Figure 4.3.9.1 - Add New User 
 

To add a new user, enter the desired credentials for the new user and click the ‘Add’ button.  Upon 

successful completion, the new user ID may be used immediately.  

 

 
 

 

4.3.9.2 Deleting Users 

 

Path 

Main Window → File → User Manager → Delete User 

Level 1 
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Figure 4.3.9.2 - Delete User 
 

To delete a user, enter the User ID of a user already known to the controller.  The user will be removed 

from the system upon clicking the ‘Delete’ button. 

 

A “User List” is also available which provides all user IDs and the level of access for each one. 
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4.3.10  Lock 

 

Path 

Main Window → File → Lock 

Level 0
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Figure 4.3.10 - Lock Window 
 

The Lock tool opens a window that keeps all other windows from being used.  This is meant as a 

preventative measure to keep stray keystrokes or mouse presses from unintentional actions, such as 

moving the antenna during communication.  Once the window is closed the application returns to 

normal use.   

 

4.3.11  Exit 

 
The Exit command closes the application and all of its windows. 

 

 
 

4.4 View Menu 
 

4.4.1 Sensor Output 

 

Path 

Main Window → View → Sensor Output 

Level 0 
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Figure 4.4.1 - Sensor Output Window 

 

To view the list of sensor output variables left-click the View button on the File Bar and select “Sensor 

Output”.  This brings up the Sensor Output Window which contains all of the output variables.  To view 

an output variable simply check the variable and request updates on that variable.  Variables that are 

available will depend on the user level. The search window allows quick location of a desired item. 

 

 
 

4.4.2 Controller Configuration 

 

Path 

Main Window → View → Controller Configuration 

Level 4 
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Figure 4.4.2 - Configuration Window, Core Tab 
 

The configuration window allows the user to change all of the available configuration items 

(parameters) on the controller.  There are two types of parameters, choice and non-choice.  Items 

with choices have only a specific set of options to choose from, items such as signal sources contain 

choices (RSL/Modem/Beacon).  Non-choice items allow the user to input a value, such as changing 

the interval that tracking is recorded, can be any value within range. Configuration parameter details 

are covered in Chapter 6. 
 

The Core tab primarily displays “model related” items. 
 

Configuration items changed will remain in the current working configuration only until power is 

cycled on the ACU unless saved.  To keep any changes made, click the ‘Save’ button to write the 

configuration parameters to the controller.  Configuration variables that are available will depend on 

the user level. 

 
 

4.4.3 Profile System 
 

Path 

Main Window → View → Configuration, Target 

Level 4 
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Figure 4.4.3a - Profile System or Configuration Window, Target Tab 

 
 

The Target / Profile Tab is available via the Configuration window.  This page allows the user to view & 

make various changes which relate to each of the available system profiles. 

 
Acquisition of a target satellite begins with constructing, or more commonly, editing an existing profile 

that is specific for the method and target the user wishes to acquire. Profiles contain all the necessary 

parameters for acquisition.   

 

The Profile System tool allows the creation or editing and removal of profiles.  Profile creation is only 

available for users of level 1 or above.  Profile selection is available to all users through the main 

window. Target and Profile functions are explained below. 
 
 
 
 

 

    

        

Profile Selection Drop Down Add (Edit) & Remove Profile 

Buttons 

Acquisition Processes  Target Specific Parameters Target Sat. Drop Down Menu 

Up / Download Profile 
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Profile Function Explanation 

Profile Name 
Can be any name. Combination of Satellite longitude, Signal 

device, Carrier & Pol  is recommended 

Upload / Download Config. 
Allows the Uploading and Downloading of .conf files which 

contain all parameters for a specific profile 

Add / Remove Profile Allows Adding to (also editing) and Removal of existing Profiles 

Acquisition Sources 
Allows selection of acquisition source device for Primary and 

optional Secondary or Tertiary acquisition processes 

Target Specific Parameters 
Shows all Target related parameters and corresponding values. 

Parameter values are modified and saved here  

Target Selection 
Allows association of a Satellite to the new Profile. Target can be 

any Satellite included from the Satellite list.  
See: Main>View>Satellite List 

 

Figure 4.4.3b – Profile functions 

 

Selecting a profile to use or edit is done through the Profile Selection Drop-Down Menu.  The drop-down 

menu contains all of the profiles on the system. 

 

 
 

Figure 4.4.3c - Profile Selection 
 

The AAQ Controller acquisition process contains up to three major processes: Scan, Coarse Peak, and 

Fine Peak.  Each process may be configured to use a specific device as the source for acquisition.  

Devices available to be selected are based on a modules type system and are optional with the 

exception of the RSL detector. The device options include; various modems, Beacon receivers and a DvB 

receiver. 

The controller has the capability to perform redundant acquisitions in the event the primary acquisition 

process fails.  This enables a three tier safety net that keeps the system operator from guesswork in the 

field.  If the secondary and tertiary tiers are not configured, they may be removed from the list on the 

next application startup. Selecting “None” for all devices in a source group results in the skipping of that 

section. The Green         button allows second and third tier sources to be added. 
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Figure 4.4.3d - Selecting Profile Acquisition Source 
 

4.4.3.1 Creating a Profile  

 

 

 

 

 

 

 

 
 

Figure 4.4.3.1 - Add Profile Window 
 

To create a new profile left-click the “Add” button located in the top right corner of the Configuration 

Window/ Target tab.  Once clicked the Add Profile Window will be shown, prompting the user to enter 

the name of the new profile.  It is advised that the new profile be named based on the Target satellite, 

Signal device, Polarization or combination of these, but can be any name the user wishes. In addition, 

the newly created profile is initially populated with all of the same configuration items and values as in 

the currently selected profile. If multiple profiles exist on the system, start from a profile with a 

configuration closest to that which is desired for the one to be added. 
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4.4.3.2 Removing a Profile 

 

 

 

 

 

 

 

 
 

Figure 4.4.3.2 - Delete Profile Window 
 

To remove a profile select the profile you wish to remove through the Profile Selection Drop Down 

Menu.  Once selected, left-click on the “Remove” button located in the top right corner of the 

Configuration Window, Target tab. You will then be prompted to confirm that the selected profile is the 

one you wish to remove from the working set.  Click “Yes” to save the change. 
 

4.4.3.3 Editing Profile - Signal Source 
 

 
 

Figure 4.4.3.3 - Configuration Window, Signal Tab 
 

 

Signal Sources  
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The signal tab contains all of the signal specific parameters that directly control how the controller 

uses a device.  A selection menu is available at the left side of the window to select between the 

various devices on the system.   

 

Important – As different devices will have unique parameters, it is necessary to first 

select the Signal Device before modifying its parameters. 

 

4.4.3.4 Editing Profile – Feed Parameters 

 

 
 

Figure 4.4.3.4 - Configuration Window, Feed Tab 
 

The feed tab is located in the configuration window. This contains all of the feed specific parameters 

that directly affect how the controller interacts with the feed subsystem.  A selection menu is available 

at the left side of the window to select between the various feed types on the system.   
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4.4.4 DvB-S2 Control 
 

Path 

Main Window → View → DvB-S2 Control 

Level 4 

 

 

Figure 4.4.4 - DvB-S2 Control Window 

The DvB-S2 control window allows full monitoring and captured carrier control of the AvL DvB 
receiver. The DvB receiver option functional modes and GUI details are covered in Appendix H of 
this Users Manual. 
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4.4.5 LNB Control 
 

Path 

Main Window → View → LNB Control 

Level 4 

 

 

Figure 4.4.5 – LNB Control 

As many different types of LNBs are supplied with AvL antenna systems, the LNB Control window 

allows the user to control either the supply voltage or control tone used by the device. Supply 

voltage may be changed to match that required by a single band LNB or adjusted to change band as 

required by some multiband systems.  

4.4.6 Satellite List 

 

Path 

Main Window → View → Satellite List 

Level 0 

 

The Satellite List Window is populated by a list which is maintained on board the ACU controller.  To add 

a satellite to the Profile “target selection” pane, select the checkbox of the satellite to be added, then 

click the ‘Save Satellite List’ button.  Satellites should be added for target selection before creating an 

associated profile for simplicity. Unchecking the checkbox will remove the satellite from the target 

selection list.  Remember to save all changes. 
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Figure 4.4.6a - Satellite List Window 
 

When selecting from the list, the receive polarization must be determined. Click the Pol setting arrow to 

activate the dropdown box and change the Polarization setting for the satellite to be acquired. 

 

Note that in the above figure, certain satellites have information populated in the TLE 1 & TLE 2 

columns. In order to use TLE tracking, the associated profiles must use a target satellite of this 

type. 

To import a satellite list or TLE data, upload files or data strings in .txt format only. Note that 

importing a satellite list will clear all existing data. Importing TLE data will give the user the option 

to overwrite (Delete) the existing list or to append to the existing list.  

TLE Data can also be typed or copied directly into the TLE1 and TLE2 spaces in the Satellite List for 

any satellite. If any changes are made to information on a satellite that is already selected for use 

in a target profile, the user will have to re-select that satellite within the profile configuration.  

To add a new satellite, press the Add Custom Satellite button. The window below will appear: 
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Figure 4.4.6b – Add New Satellite 

Fill in all line items including the TLE Line 1 & 2 items. Line items should be copied and pasted from 

existing NORAD or equivalent ephemeris lists to assure accuracy. Should the TLE data be entered 

incorrectly, the data will populate the satellite list upon saving but operation for this satellite will 

not function for TLE tracking. 
 

Once changes have been made, save the satellite list. This will make the new information available to 

the controller and preserve it in non-volatile memory, allowing the updated list to be retrieved even 

after a power cycle. 
 

4.4.7 System Log 
 

 

Path 

Main Window → View → System Log 

Level 4 
 

 
 

Figure 4.4.7 – System Log 
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The System log tool allows the user to monitor the function commands and indications as reported by 
the AAQ controller. This is typically used by AvL technical staff and is sometimes used for remote 
troubleshooting. 
 

4.4.8 Data Log 
 

 

Path 

Main Window → View → Data Log 

Level 4 

 

 

 
 

Figure 4.4.8 – Data Logger Example 

 

 

The Data Logger window allows the user to plot up to six status variables over time. This can be used for 

testing, troubleshooting and plotting operational data over time. The sampling interval as well as the 

duration of the individual graph may be set to suit individual test requirements. These test samples may 

be saved as a graph (shown) or as a list of values if needed. 

 

 The results of the test can also be saved under the filename of choice by clicking on the folder icon next 

to “filename” and selecting both the name and location of the data file. The name will then show in the 

textbox. 
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4.4.9 Alarm List 

 

 

Path 

Main Window → View → Alarm list 

Level 0 

 

 

 
 

Figure 4.4.9 - Alarm Window 
 

The Alarm Window displays the current alarms reported by the controller.  If the window has no red 

“X” in the Status column, the system is not in an alarm state.   
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4.4.10    Device Window 
 

Path 

Main Window → View → Device window 

Level 0 

 

 

 
 

Figure 4.4.10 - Device Window, Modem Example 
 

The Device Window displays the data and status of the connected “Signal Device” used for acquisition. 

The module that handles communication from the AAQ to the device reports up to 8 predetermined 

status labels and values.  This information is placed in the “Device Data table” and can also be seen in 

the  

 

Sensor Output Window.  When multiple devices are used for acquisition, the window will 

automatically switch to the active device. 
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4.4.11   Graphic Controller Window 

 

Path 

Main Window → View → Graphic Controller Window 

Level 0 

 

 
Figure 4.4.11 - Graphic Controller Window 

 

 

The Graphic Controller Window is a simplified user friendly display of the main window.  This window 

shows graphically all the necessary inputs and outputs for a normal user to select a Profile & acquire a 

satellite. Each graphical area represents a corresponding command or monitor point from the main .NET 

GUI window. 
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4.4.11.1   Movement Commands  

 

 

 
 

 
Figure 4.4.11.1 - Graphic Controller Window Movement Commands 

 
 
 
The movement commands displayed on the Graphic Controller Window allow the same functions 
available in the Command Pane and the Manual Control Pane.  This includes all of the basic commands 
with indicator LEDs showing which command is active and a group of jog buttons.  In contrast to the 
main window there is no “Manual Control” button to activate the jog buttons.  Jog buttons are always 
active on the graphic window and one left-click will jog the antenna.  
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4.4.11.2   Target Display 

 

 

 
 

Figure 4.4.11.2 - Graphic Controller Window, Target Display 
 

 

 

The target display shows a simulation of the visible sky from the controller’s Latitude and Longitude 

position on the earth.  The point on the earth currently occupied by the antenna is represented as a 

circle (red or green) on the earth’s surface.  An arc is displayed above the earth; this arc is populated 

with satellites that are currently in use by the controller.  Use the satellite list (View > Satellite List) 

to add or remove satellites from the controller’s list of selectable targets.  The current heading of 

the antenna is shown at the top of the display.  Any messages received from the controller are 

shown below the display.  A green line indicates the current approximate pointing solution of the 

antenna.  
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4.4.11.3   Coordinate Dials 

 

 

 
 

Figure 4.4.11.3 - Graphic Controller Window Coordinate Dials 
 

Each axis of the positioner is represented by a graphic dial showing the current position of that axis in 

world coordinates.  The current value of that axis is also displayed in the center of each dial.   

 

4.4.11.4   Signal Strength Meter 

 

 
 

Figure 4.4.11.4 - Graphic Controller Window Signal Strength Meter 
 

The signal strength of each signal source is represented as a bar chart in the signal strength meter.  

Depending on the strength of the source the associated color bar will increase and decrease.  The 

sources included are shown below. 
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4.4.11.5    World Location 

 

 
 

Figure 4.4.11.5 - Graphic Controller Window World Location 
 

The current location of the controller can be seen as a red dot on a globe in the lower left corner of the 

window.  This globe rotates to show the approximate position of the controller on the earth as well as 

showing the Latitude and Longitude coordinates in text. 

 

 

4.5 Login Menu 
 

The Login Menu is located on the toolbar in the upper left hand corner of the Main AAQRemote 

window. 

 

Path 

Main Window → Login 

Level 0 

 

 
 

Figure 4.5a - File Login Menu Select 
 

The AAQ Controller system provides the ability to have the user login to access various levels of 

interaction with the controller.  This allows users of higher levels to access configuration parameters 

and sensor output variables that can change the functionality of the controller while users of lower 

levels can run the system but are limited in their ability to modify behavior.  To login to the 

controller left-click the Login button on the File Bar (Login).  This will bring up the Login window 

where the user can enter their credentials and send them to the controller.   
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Figure 4.5b - Login Window 
 

Upon logging in, the controller will accept the user and allow that user access up to their level. 

 

 

4.6 Help Menu 
 

The Help Menu is located on the toolbar in the upper left hand corner of the Main AAQRemote window. 

 
 

Figure 4.7 - File Bar Help Menu Select 

4.6.1 About 

 

Path 

Main Window → Help → About 

Level 0 
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Figure 4.7.1 - About Window 
 

The About Window shows the versions of the AAQ software and legal information.  Additional 

information may be listed in the About Window pertaining to the build of the AAQRemote Software. 

 

 

 

4.6.2 Version 

 

Path 

Main Window → Help → Version Info. 

Level 0 
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Figure 4.6.2 - About Window, Version example 
 

The Version tab allows for the user to quickly locate all of the versions of code running on the system.  

This includes the application, ROM (main running code), RIOM, and module version. 

 

 

4.6.3 Troubleshoot 

 

Path 

Main Window → Help → Troubleshoot 

Level 4 

 
 

 
 

Figure 4.6.3 – Troubleshooting Variables 
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The Troubleshoot window displays specific variables for each axis that are commonly used in 
troubleshooting by AvL technical staff. 
 

 

Chapter 5 – Initial Setup, Basic Operation & Profile Examples 
 

This chapter describes the setup & basic operations of the AAQ controller & typical Antenna configurations, 

from unpacking to acquisition of the target.  See Chapter 3 for additional Network configuration as well as 

Chapter 6 for system configuration details. 

 

 

5.1 Unpacking 
  
When unpacking your system, you will find taped to the CIP, an envelope containing the Customer Flash Card. 

This card contains generic and customer specific configuration documents needed to operate your AvL system. 

Your flashcard contains the following: 

 

 Antenna manual 

 Specifications sheet 

 Interface control document 

 Outline drawing of antenna system 

 Overall Wiring Diagram 

 Controller User Manual 

 Controller Quick Start Guide 

 Controller Module Documents (Modem, Beacon Receiver, Wings, etc.) 

 AAQ Remote GUI Installation file 

 Configuration Files (Created by Service) 

 (Certificate of Compliance) 
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5.2 Basic Connections 
 

Connecting Your Equipment  
 
 
 
 
 
 
 
 

A  
 

B  
  
C  

  
D  

  
E  

  
F  

  
G  

 
H  

 

   I  

 

 

Figure 5.2 – CIP Connections 

 

A.   HandHeld Controller 
B.   Control Interface Panel (Front & Rear connections shown) 
C.   Remote Controller (HandHeld) Cable  
D.   Ethernet to PC , LAN, Modem or Beacon receiver * 
E.   AAQ Power Connector 
F.   Pedestal DC Power Connector 
G.   AAQ Data Connector 
H.   Serial for Aux Equipment such as Modem or Beacon receiver depending on system type 
I.   Antenna Pedestal Control Cable 
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Note – If your CIP is configured as a “router” from the factory, the labeling and function 

of the Ethernet connections will be different. See Appendix “B” for more 

information. 

 

5.3 AAQ Remote Application (GUI) Installation 

5.3.1 Remove previous versions 

 

If there are any previous versions of AAQ Remote GUI installed on your PC, remove them before 

continuing. For Windows7 and below navigate;  Start > Control Panel > All Control Panel Items > 

Programs and Features > Uninstall or change a program, will bring you to the screen below. For 

Windows8 and above navigate; Start>settings button>search “Programs and Features” in dialogue 

box. 
 

 
 

Figure 5.3.1 - Uninstall Prior Version 
 

5.4 Install the AAQ Remote  
   

Begin by installing the AAQ Remote on your operating system through the  AAQRemoteSetup_X-X-X-X.msi 
(Windows installation file), provided in your Customer Documentation Flash Drive. 
 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 84 of 200 
 

Note that For Windows 7 and above, the Wizard will install the application to the “C:\Program Files 
x86\AvL\AAQ Remote” folder.  
 

 For Windows Vista and XP, installation is to the “C:\Program Files\AvL\AAQ Remote” folder. Do not 
change location.  
 

Once system cables are connected (photo) and the AAQ Remote software is installed and started, the 

system can be powered on.  

5.5 Power on and Boot 
 

The AAQ controller uses a Linux based operating system.  When the controller is turned on, the system 

begins a boot process that loads the file system and application programs into RAM.  This boot process 

requires 30-60 seconds to complete.  Once the controller is booted, it is in an operational state and 

ready to accept commands.   

 

All external equipment (software) modules are initialized during the boot process.  During this process 

the modules are allowed to initialize specific devices or functions outside the normal AAQ operations.   

In order to ensure complete functionality, check that ancillary equipment is also powered on and 

initialized prior to powering on the controller. 
 

5.6 Initial Login and IP settings 
 

 
 

Figure 5.6a – Remote Settings Window (level 1) 

 

As shown, the controller service IP address is 192.168.129.51. Once the connected PC is set to 

communicate on the same network through TCP-IP Settings, the GUI should show the lower left hand 

corner “coms LED” turn green.  
 

Note - See Chapter 3 for advanced network settings details. 
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Figure 5.6b – Communication LED 

 

 

Login (Top of main GUI) to the controller with your customer Username & Password (Located in your 

customer documentation package or flash drive). The typical integrator access is at a level 4. This level 

determines the commands and configuration items visible and available to be modified. 

 

 
Figure 5.6c – Login Window 

 

Once Login is accepted, you are ready to command the system.  

 

5.7 Command Functions 
 

Commands recognized by the AAQ controller (from the GUI) are shown on the main GUI page command 

pane: 
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Figure 5.7 – Command Pane 
 

 

 Stop:   Stops the current running command.   

 Manual Control: Enables the manual jog commands to be accepted. 

 Home:   Positions the antenna upright and initializes axis based sensors. 

 Stow:   Stows the antenna to the specified angular values. 

 Acquire:  Automatically points the antenna to the specified Target satellite. 

 Move To:  Moves to the requested pedestal coordinates. 

 Peak:   Performs peaking sequence using the current signal source. 

 Repeak:   Performs fine peaking sequence using the current signal source. 

 Track:   Performs the currently selected tracking mode. (option) 

 X Pol:   Moves the polarization 90 degrees from its current position. 

 

 

5.7.1 Command Descriptions 

 

The Manual Control command allows the user to move the antenna freely in any axis desired by way of 

the Manual Control pane which is directly below the Command pane. Note that manual movement via 

“step” requires a “Home” sequence first to initialize axis sensors. 

 

The Home command determines tilt and initializes the motor feedback sensors (i.e. encoders and 

resolvers) needed for precision movements.  The acquire command will initiate a “home” sequence 

before completing the acquisition.  

 

The Stow command moves the antenna to a predetermined position. This is generally based on 
themodel selected so the antenna and pedestal can be packed securely. The stow position is 
adjustable through configuration parameters if needed. The details of these are located in Chapter 
6. 
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The Acquire command starts the antenna towards it’s pointing sequence for the “Target” satellite. 

Acquisition runs in accordance with configuration details for the currently selected “Profile”. 

 

The Move to… command allows the user to move the antenna directly to a desired coordinate location. 

A “Move to” window will be presented for coordinates upon command. Note that manual movement to 

a coordinate location requires a “Home” sequence first to initialize axis sensors. 

 

The Peak command performs a peaking sequence using the current signal source which begins with 

“Coarse” peaking sequence. This may be used to insure that the antenna pointing is optimum should the 

pedestal be bumped or moved slightly. 

 

The Repeak command performs a peaking sequence using the current signal source which begins with 

“Fine” peaking sequence. This may be used to insure that the antenna pointing is optimum should the 

pedestal have moved slightly or if pointed under poor weather conditions. 

 

The Track command performs the currently selected mode for satellite tracking. Tracking is an optional 

feature and the command will only function when the appropriate module is installed. 

 

The X Pol command will move the antenna feed 90 degrees to receive the satellite’s opposite 

polarization. This is typically used to simplify initial antenna cross-pol isolation testing. The direction of 

the feed movement will depend upon the initial feed angle when initiating the command.  

 

Note - See the AAQ Remote GUI Chapters 4 & 7 for additional descriptions & 

information on command functions. 

 

5.8 Profile System 
 

5.8.1 Discussion on Profiles 

 
Profiles are effectively a group of settings which are specific to the target or reference satellite you 

choose to acquire. 

Reference satellite is used to correct any heading error from the compass. 

Target satellite is the user’s assigned satellite. 

For a typical system, the Profile settings (also called Parameters or configuration items) will change 

very little, if at all for the various satellites in your target list.  

One or more factory test Profiles are delivered with each antenna system. These contain all of the 

basic parameters needed for operating the system and are initially “copied forward” when adding a 
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new target profile to the list. Of course, each new target satellite needs a minimum of information 

to be updated for its unique profile: 

 Profile Name 

 Target Satellite & longitude 

 Receive Polarization  

 Reference satellite profile, if used 
 

Information may be needed for the profile in accordance with satellite specifics, for example: 
 

 Satellite inclination (if any) 

 RSL Minimum Lock Threshold (minimum signal level to detect with RSL) 

 Satellite Pol Offset  (if any) 

 Type of polarization (feed dependent) 
 
 
If for instance, your new satellite will be acquired using a different signaling device (ie: modem), this 
information needs to be added to the new Profile. Some examples of parameters to be updated may 
include: 
 
 

 Modem Type.  

 Modem Scan Width 

 Acquisition Sources for scanning and peaking 

 Modem Lock Threshold 
 
 

AvL technical staff works closely with our customers to insure that configuration details for system 
enhancements are captured and kept on file for reference. All equipment additions require AvL 
software “modules” to allow basic communication with devices. 

 
 

5.8.2 Configuration Parameter Types 

 
Parameters are broken up into four categories: 

 

 The “Core” Parameters are based on the equipment “model” and do not 
typically change between profiles. 

 

 The “Target” Parameters are Satellite specific and need to be updated 
unless the new profile will be used for a different carrier on the same 
satellite. 
 

 The “Signal” Parameters will change with carrier type and any external 
signaling equipment specifics. (i.e. – modem, beacon rcvr.) 
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 The “Feed” Parameters will change polarization and frequency band settings 
where applicable. 

 
 
 

Note - A complete alphabetical listing of configuration parameters can be found in 
chapter 6. All parameters available to customers (level 4 and below) are also 
defined in this chapter. 

 
 
 
 
 
 
 
 
 
 
 
 
 

5.9 Profile Examples 
 

The following section provides a number of examples of how to create new profiles.  

5.9.1 Target Satellite selection 

 
In preparation for making a profile, we need to select the satellite which we will be using for our 

Target.  

From the main screen: 

Path 

Main Window → View → Satellite List 

Level 1 
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Figure 5.9.1 – Satellite List 

In this example, the “Factory Test Profile” was created using Satellite AMC-9 @ 83W with Horizontal 

Receive Polarization (selected). For the new profile example, we will use AMC-16 @ 85W using 

Vertical Polarization. Select the “use” checkbox and click on the Pol setting twice to change the 

receive Polarization. Once you press Save, the satellite will be available in the “Target Selection” 

pulldown. 

 

 

 

5.9.2 Simple Profile Example 

 
The “Target” tab of the Configuration window brings us to the Profile “tool” page. 

 

Path 

Main Window → View → Configuration, Target tab 

Level 1 
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Figure 5.9.2 – Configuration, Target tab 
 

Note that the factory test profile is shown in the “Profile Name” box. 

Next, click “Add” next to the Profile name. The name you choose can be anything which has not 

been used before, however certain conventions are recommended: 

 Satellite name 

 Satellite longitude 

 Receive Polarization 

 Signaling device - ie: iDirect, Beacon, RSL 

 Carrier ID (optional) 

 

 

 

 

 

5.9.3  Add Profile 
 

For this example, the following name has been chosen 
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Figure 5.9.3 – Add Profile name 

Once the name is chosen and you click on OK, your new profile is created with all parameters 

“copied forward”. We are ready to update some basic parameters to match your new Target 

choice: 

5.9.4 Select Target 

 
Keeping in mind that the profile added so far is just a name, use dropdown box under the Profile 

name to add the new “target satellite” which was added in 5.9.1: 

 

Figure 5.9.4a – Select Profile Target 
 
 
 
 

Once the Target Satellite has been selected, you can see the changes in Longitude and Polarization 

have been automatically made in the “Target Parameter list”. 
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Figure 5.9.4b – Target Parameter Changes  

In this example, no other changes will be made as we are simply moving to a new Target satellite 

using the same Acquisition Signaling Source (RSL).  Click “Save” at the bottom of the Configuration 

window to save the new profile. Note that most other changes, when creating a profile, are entered 

manually to the listed parameters. 

 

5.9.5 Common Profile Adjustments 

 
When a currently used profile requires a simple configuration change, it is not necessary to create a 
new profile unless the user wishes to keep the original as a reference or alternate. In the latter case, 
add a new profile to the list and adjust the new profile name slightly in order to be able to 
distinguish between different configuration details. 
 
In the following examples, we will not create a completely new profile each time, instead individual 
configuration parameters, which can be then saved as part of the new profile, will be discussed.  
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5.9.6 Adjusting Motion Limits 

 
For this example, we will be installing new equipment on our “vehicle mounted system”. The 

original setting for maximum Elevation position (90 degrees) is now unacceptable to prevent 

mechanical interference. The following parameter will be updated: 

- User El Up Limit (under core parameters, level 4) 
 
 

 
 

Figure 5.9.6 – User El Up Limit Parameter 
 

Remember to click Save after entering the new value to your Profile. 
 
 

~IMPORTANT~ 
 

Since positioner Limits are of a critical nature for the safety of any and all personnel 
that may be near to the antenna system, it is highly recommended that any change to 
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these limits be verified by a second operator who can observe the antenna to ensure 
that the intended changes function correctly. 

 
 

5.9.7 Modem Acquisition, Low Power Carrier 

 
In this example, we have created our new profile as in 5.9.1, however in this case we are using a 
modem signal for our Acquisition Source. In moving from the old satellite to the new one, we find 
that the modem reports back lower power (SNR) from the specified carrier than before. This is 
causing the system to sometimes miss the satellite, resulting in a failed acquisition. The 
recommended solution is to lower the following parameter to compensate. Keep in mind that 
multiple parameters may affect a specific acquisition issue; we might also adjust the modem lock 
threshold to improve the result. 
 

- Scan Az Velocity (under signal parameters, level 4) 
 

 

 
Figure 5.9.7 – Modem Scan Az Velocity 

 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 96 of 200 
 

The Scan Az Velocity controls how quickly the antenna moves in Azimuth while looking for the first 
sign of a signal from the modem. Because of this, we want to reduce this value only to the degree 
required to obtain a consistent result without increasing scan times more than necessary. In this 
case, the best value will be found with some amount of trial and error. 
 
It is recommended that adjustments to parameters similar to the above example are made in small 
steps. It is also advisable that a written log is kept with regards to any changes made for later 
reference. 
 

Note – An alphabetical list of all user level 4 and below parameters can be found at the 
beginning of Chapter 6. For signaling devices and other options, check the appendix 
section of the manual. 

5.9.7.1 Acquisition Redundancy 

 
In order to improve the likelihood of a successful acquisition, a secondary scan & peak sequence (or 

tertiary) can be added in cases where the first attempt was unsuccessful.  

From the Target & Profile tab: 

Path 

Main Window → View → Configuration, Target 

Level 4 
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Figure 5.9.7.1 – Secondary Acquisition Source 
 

Press the green “+” sign to add a secondary (or tertiary) “Acquisition Source”.  

Then, use the dropdown to select the device for scan, coarse & fine peaking. For simple redundancy, 

it is recommended to duplicate the settings from the Primary Source as shown in figure 5.9.7.1. 

Once the Secondary Source is saved to your Profile, it will function during each acquisition if needed. 

To remove a redundant source, select “None” for all three Secondary Sources. Upon saving, the 

sequence will no longer be shown when the window is open. 

 

5.9.8 Adjusting RSL Threshold 
 

We will assume for this example that the Satellite information will be the same as previously discussed 

although we will be using the RSL power detector as our Acquisition Source. This new satellite however, 

has shown itself to be in a position of higher background noise (low elevation angle). This is bringing the 

noise level at the detector too close to its minimum threshold for lock detection. We will therefore 

adjust a parameter based on actual measurement: 

-RSL Minimum Lock Threshold (under Core parameters for level 4, see figure 5.9.8b below) 
 

RSL Minimum lock Threshold is defined as the minimum signal level needed to detect with RSL as 

the signal device.  
 

As the antenna scans for the first indication of satellite signal power, this parameter is used to 

determine that the satellite has been approximately reached and that peaking can begin. If noise levels 

in the vicinity of the target are high, this threshold may be tripped early and cause the antenna to begin 

peaking sequence when off satellite. To get a better understanding of this relationship, bring up the 

“Sensor Output” window. 

Path 

Main Window → View → Sensor Output 

Level 1 
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Figure 5.9.8a – Sensor output, RSL 

 

 

Three monitor points are selected for this example: 

 

 The RSL Min Lock Signal (parameter = RSL Minimum Lock Threshold),  

 RSL Rx Lock &  

 RSL Rx Signal.  

 

Our “on satellite” signal level shows approximately 63.0 rel. which is well above the RSL Min Lock Sig. 

threshold setting of 40.0. However, if the antenna is moved off satellite, our Rx Signal indicates 38.0 

which represents the background noise level in this location. 
 

With the background noise this close to our Minimum Lock Signal threshold, false triggering of the RSL 

lock is likely and our threshold should be increased to insure a complete acquisition. 
 

This setting is best determined empirically by first pointing to the satellite manually, then moving off 

center by a few degrees and noting the RSL “Signal Strength” on the main status pane. The parameter 

should be set a few units above this value. (5 to 10 units recommended depending upon “on satellite” 

aggregate signal strength) 
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Figure 5.9.8b – RSL Min Lock Threshold 

Once the new value is entered to the location shown in the above figure, click “Save” to write the 

changes to your Profile. 

 
 

5.10 Adding a Reference Satellite 

 
Adding a reference satellite (ref sat) to the acquisition process, corrects for any heading errors 
that may exist. The ref sat process performs an acquisition on a known satellite that is low on 
the arc. The compass heading is then corrected and the antenna can move directly to the target 
satellite’s location. 
 
Two reference satellites may be associated with a given target profile.  
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Figure 5.10 – Reference Satellite Profile 

A ref sat must meet the following two requirements or it will not be used. 
 

1) Must be outside the “SatTant Min Long Diff”, which is recommended to be set to 20 
degrees.  The “SatTant Min Long Diff” states that the referenced satellite must be this far 
from the longitude of the current location. 

 
2) Must have a calculated target elevation above 0.0 degrees. 
 

The ref sat selection process will choose the closest ref sat to the target satellite. If the closest 
ref sat does not meet the requirements, the second ref sat will be used.  If the second ref sat 
does not meet the requirements, the SatTant process will be used to correct the heading. 
 
Any profile may be used as a ref sat profile. The ref sat mode may be enabled or disabled.  If 
disabled, the SatTant process will be used. 

5.10.1 Using a DBS signal with the DVB receiver as a reference satellite 

 
If your AAQ antenna system is fitted with the DVB receiver option, an improvement in 
acquisition reliability (over SatTant) can be obtained by using it to initially locate one of a 
number of available satellites. Also see Appendix H for further DVB receiver operation. 
 
One means of using the ref sat process is to use DBS (Direct Broadcast) satellites. They have 
broad, high power carriers in the high band section of their transmitted signal. The spacing of 
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these satellites (in CONUS) makes it very unlikely that an adjacent satellite will be acquired. 
DBS type satellites are often used as their high carrier power simplifies acquisition in poor 
weather conditions as well. 
 
In the following example our Target satellite is AMC-9 @ 83 degrees west and uses RSL for 
acquisition. For our location, this satellite is near the top of the geostationary arc, which is 
prone to greater pointing error. The DBS satellite Echostar-3 is at 61.5 degrees west, which is 
more than 20 degrees further east and considerably lower on the arc which makes it a good 
candidate for our reference. Other CONUS DBS examples are 101W, 110W & 119W. 
 

5.10.1 Create a Reference Profile 

 
When a profile is created for the Reference satellite, it can be then selected as the “reference” 
for our Target satellite. As this Reference satellite uses the DVB receiver, it will need to be 
configured as follows: 
 

 
 

Figure 5.10.1 – Reference Satellite Profile Example 
Notice that the profile name designated this as a Reference satellite profile.  Also notice that 
all acquisition sources are selected for the DVB receiver, except “Fine Source”. For a faster 
(reference sat) acquisition, “Fine Source” may be set to none. Also see Appendix H for 
complete DvB ref sat setup. 
 
Since the generic “high band” frequency of 12235MHz (1485MHz L-band with a 10750MHz 
LNB LO) is selected for level and not DVB coding, the “Enable DvB Mode” function of the 
receiver is turned off as well as the “Signal Optimization” function. In this mode, the receiver 
performs much like a narrow band beacon receiver.  
 

The “Maximum Valid Signal” is set to its maximum value (40) to prevent saturation and the 
“Minimum Valid Signal” is set (25) to avoid false locking of the receiver. The values in the 
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example are those commonly used. We are now ready to configure our Target profile. 
Remember to save all changes. 
 

5.10.2 – Update Target Profile  
 

Our Target as mentioned before is 83W, using RSL. Update the 83W RSL profile as follows: 
 

 
 

Figure 5.10.2 – Reference Satellite Selection 
 

Notice in figure 5.10.2 that we have renamed (or added) the 83W profile with the same target 
and “RSL” acquisition sources. In the Target tab however, we have enabled Reference Satellite 
Mode and selected our DBS reference profile for Reference profiles 1 & 2. Here, the choice to 
use the profile for reference 2 is arbitrary and may serve as redundancy. Should Reference 
profile 1 fail, the system will then go to the second profile. Any profile (reference or 
otherwise) created may be used for either reference 1 or 2. It is recommended to use two 
different profiles created from 61.5W, 101W, 110W or 119W within the CONUS. Remember to 
save any changes. 
 
Once the system is commanded to acquire, the profile name will show the Reference profile 
name from deployment until the Reference has locked and the antenna heading has updated. 
The profile name will then return to the target profile for final acquisition. See Appendix H for 
additional information about the AvL DvB receiver. 

Chapter 6 – AAQ System Configuration Variables (Parameters) 
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6.1 Introduction 
 

 

As mentioned in Chapter 1, the AAQ employs a complete set of configuration parameters that allow a 

single set of software instructions (ROM code) to control a variety of transportable antenna systems.  In 

this chapter, all of the standard configuration parameters that are visible and adjustable by the system 

integrator and other users of the antenna system (Level 0 to 4) are discussed in detail.  The purpose of 

each parameter, or group of related parameters, is described and the effect a change in that parameter 

will have is also discussed. A table is included in each section that provides the following information: 
 

- Long Name – Parameter name as it appears when listed in the AAQ Remote application. 
 

- Level – User log-in privilege level associated with that parameter.  Only users at that level, or higher, 

 will be able to view or modify that parameter’s value. 
 

- Type – The type of value associated with the parameter as listed: 
 

 Choice – Chosen from a drop-down menu listing fixed options. 

 Float – Floating point number with decimal point. 

 Integer – Whole number that is usually positive. 

 String – String of alpha-numeric characters. 

 Unsigned – Status flag, typically having a value of “0” or “1.” 
 

- Value Range – Upper and lower limit on parameter value. 
 

- Documentation – “Tool-Tip” that appears when that parameter is selected in the AAQ Remote GUI.  

      It offers a basic description of the parameter. 
 

The following sections are arranged in a suggested order for review by a system integrator (Level 4 user) 

upon receipt of the AvL antenna system.  The antenna system will arrive with all of these parameters set 

to a nominal value by AvL Engineering, Production and Service groups to facilitate system level testing in 

the factory.  The vast majority of these parameters may not need to be modified.  However, some of them 

do need the system integrator’s attention to insure safe and optimal operation of the fully integrated 

antenna system. 

Please be advised that the configuration parameters addressed in this chapter are not all inclusive and do 

not include those associated with some AAQ ACU features and are subject to change.  Those parameters are 

addressed in appendices to this document and should also be reviewed by the system integrator upon 

receipt of the AvL antenna system for the same reasons cited above. The parameters addressed in this 

chapter are listed below alphabetically and by category: 

 

6.1.1 Core Parameters 
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Core Parameters generally address the relationship between the pedestal mechanism, various 
related sensor devices and the code variables that control them. All parameters are listed here along 
with the section number where their information can be found. 
 

Auto Stow On Movement – 6.2.2 
Auto Stow Speed – 6.2.2 
Auto Stow Speed Time – 6.2.2 
AvL Compass Com Port – 6.3.7 
AvL Compass Com Port Settings – 6.3.7 
Azimuth CCW Limit Switch is Interlock – 6.2.4 
Azimuth CW Limit Switch is interlock – 6.2.4 
Azimuth Motor Abs Enc Offset – 6.3.6 
Azimuth Motor Abs Enc Scale Factor – 6.3.6 
Azimuth Motor Scale Factor – 6.3.6 
Azimuth Pot Offset – 6.3.5 
Azimuth Pot Scale Factor – 6.3.5 
Azimuth Stow Is Interlock – 6.2.4 
Azimuth Stow Position – 6.2.2 
Bootup Logo – 6.3.1 
Circular Polarization Center Position – 6.3.8 
Coarse Peaking Source – 6.3.3 
Compass Heading Offset – 6.3.3 
Compass Scan Width – 6.3.6 
Controller Name – 6.3.8 
Controller Serial Number – 6.3.8 
Cross Polarization Disable – 6.3.6 
Declination Override – 6.7.1 
Digital Input 0 (through 4) Is Interlock – 6.2.4 
Digital Output 2 Digital Output 1 (though 6) – 6.2.4 
Digital Output 3 Digital Output 1 (though 6) – 6.2.4 
Elevation Compass Position – 6.3.3 
Elevation Down Limit Reflector Mounted – 6.2.1 
Elevation Down Limit Switch Is Interlock – 6.2.4 
Elevation Down Limit – 6.2.1 
Elevation Down Stow Limit – 6.2.1 
Elevation Stow Position – 6.2.2 
Elevation Up Limit Switch Is Interlock – 6.2.4 
Elevation Motor Abs Enc Offset – 6.3.6 
Elevation Motor Abs Enc Scale Factor – 6.3.6 
Elevation Motor Scale Factor – 6.3.6 
Elevation Stow Raw Is Interlock – 6.2.4 
Elevation Up Stow Limit – 6.2.1 
Feed Bit Override – 6.3.8 
Feed Bit Override Type – 6.3.8 
GPS Scan Width – 6.3.6 
GPS Source – 6.3.3 
Hand Held Connected – 6.3.1 
Heading Averaged – 6.3.3 
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Heading For Manual Compass – 6.5.1 
Magnetic manual Compass – 6.7.1 
Manual Compass Scan Width – 6.3.6 
Manual Control Allows Modem Tx – 6.3.5 
Manual Control Azimuth Fast Speed – 6.3.5 
Manual Control Azimuth Slow Speed – 6.3.5 
Manual Control Elevation Fast Speed – 6.3.5 
Manual Control Elevation Slow Speed – 6.3.5 
Manual Control Polarization Fast Speed – 6.3.5 
Manual Control Polarization Slow Speed – 6.3.5 
Manual Latitude – 6.7.2 
Manual Longitude – 6.7.2 
Manual Pitch – 6.7.3 
Manual Roll – 6.7.3 
Modem Tx Enable On Rx Lock – 6.3.8 
Modem Tx Restore On Open – 6.3.8 
Nav Operation Mode – 6.3.3 
NMEA Echo Input Com Port – 6.8.1 
NMEA Echo Input Com Port Settings – 6.8.1 
NMEA Server Com Port – 6.8.1 
NMEA Server Enable – 6.8.1 
NMEA Server Interval – 6.8.1 
NMEA Server Message Source – 6.8.1 
NMEA Server Com Port Settings – 6.8.1 
NoCompass Scan Width – 6.3.6 
NTP Server IP Address – 6.3.7 
NTP Server Port – 6.3.7 
Panel Connect Blocks Others – 6.3.8 
Pitch Inc Offset – 6.3.6 
Polarization Flip Amount – 6.3.6 
Polarization Home Position – 6.3.6 
Position Hold Run Acquire on Peak Fail – 6.3.7 
Primary Heading Src. – 6.3.3 
Rack Controller Field 0 (through 9) – 6.3.8 
Rack Controller Label 0 (through 9) – 6.3.8 
Reflector Mount Azimuth Position – 6.2.3 
Reflector Mount Elevation Position – 6.2.3 
Reflector Mount Elevation Switch Position – 6.2.3 
Reflector Mount Polarization Position – 6.2.3 
Reflector Mount Switch Elevation Offset – 6.2.3 
Repeak On Power On When Rx Locked – 6.3.8 
Roll Inc Offset – 6.3.5 
RSL Com Port – 6.3.2 
RSL Com Port Settings – 6.3.2 
RSL Gradient Sample Time – 6.3.2 
RSL Minimum Lock Threshold – 6.3.2 
RSL Noise Sample Time – 6.3.2 
RSL1 Noise Floor – 6.3.2 
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RSL1 Signal Strength Scale Factor – 6.3.2 
Run Position Hold on Startup – 6.3.8 
Safe Turn Maximum Elevation – 6.2.1 
Safe Turn Maximum Elevation Reflector Mounted – 6.2.1 
Satellite Inclination Threshold – 6.3.6 
SatTant Heading Timeout – 6.3.4 
SatTant Type – 6.3.4 
Secondary Heading Source – 6.3.3 
Show Stow Warning – 6.2.2 
Signal Wait Time – 6.3.6 
Slide Motor Acquire Position – 6.8.3 
Slide Motor Abs Enc Offset – 6.8.3 
Slide Motor Abs Enc Scale Factor – 6.8.3 
Slide Motor Enable – 6.8.3 
Slide Motor Scale Factor – 6.8.3 
Slide Motor Stow Position – 6.8.3 
Slide Motor Switch 1 – 3 is Interlock – 6.8.3 
Slide Position (1 – 3) – 6.8.3 
Step Mode Sample Delay – 6.3.8 
Step Mode Wobble Correction – 6.3.8 
Time Service Maximum GPS Drift – 6.3.7 
Time Source – 6.3.7 
Use Fast Home – 6.3.3 
Use Manual GPS on Fail - 6.3.3 
Use Manual Tilt – 6.7.3 
User Azimuth CCW Limit – 6.2.1 
User Azimuth CW Limit – 6.2.1 
User Elevation Down stow Limit – 6.2.1 
User Elevation Up Limit – 6.2. 
 

6.1.2 Target Parameters 

 
Target Parameters relate directly to the scanning & acquisition of the target satellite.  

 
Acquire Modem Scan Width – 6.4.3 
Acquisition Geometry – 6.4.3 
Circular Polarization Left Hand Position – 6.4.4 
Circular Polarization Position – 6.4.4 
Circular Polarization Right Hand Position – 6.4.4 
Coarse Peak Signal Source 1 – 6.4.2 
Coarse Peak Signal Source 2 – 6.4.2 
Coarse Peak Signal Source 3 – 6.4.2 
Current Satellite – 6.4.1 
Disable Scans – 6.4.3 
Fine Peaking Source – 6.4.2 
Fine Peak Signal Source 1 – 6.4.2 
Fine Peak Signal Source 2 – 6.4.2 
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Fine Peak Signal Source 3 – 6.4.2 
Modem Type – 6.4.2 
Position Hold Step 1 (through 4) – 6.4.4 
Reference Profile 1 – 6.4.1 
Reference Profile 2 – 6.4.1 
Reference Satellite Mode – 6.4.1 
RSL 1 Attenuation – 6.4.2 
Run Position Hold After Acquire – 6.4.4 
Run Position Hold After Peak Cmd – 6.4.4 
Satellite Signal Source – 6.4.2 
Satellite Inclination – 6.4.1 
Satellite Orientation – 6.4.1 
Satellite Polarization Offset – 6.4.3 
SatTant Coarse Peaking Source – 6.4.2 
Scan Signal Source 1 – 6.4.2 
Scan Signal Source 2 – 6.4.2 
Scan Signal Source 3 – 6.4.2 
Skip Acquire Sat State -  
SatTant Fine Peaking Source – 6.4.2 
Tx Enable Before Fine Peak – 6.4.4 
Use SECANT Correction – 6.4.3 

 
 

6.1.3 Signal Parameters 

 
Signal Parameters generally correlate to the relationship between RF level and movement of the 
antenna system. 

 
Coarse Peak Signal Dif Pass – 6.5.2 
Coarse Peaking Cycles – 6.5.2 
Coarse Peaking Maximum Cycles – 6.5.2 
Coarse Peaking Mode – 6.5.2 
Cross Pattern Coarse Peaking Height – 6.5.4 
Cross Pattern Coarse Peaking Width – 6.5.4 
Cross Pattern Coarse Signal Tolerance – 6.5.4 
Cross Pattern Coarse Azimuth Velocity – 6.5.4 
Cross Pattern Coarse Elevation Velocity – 6.5.4 
Cross Pattern Fine Peaking Height – 6.5.4 
Cross Pattern Fine Peaking Width – 6.5.4 
Cross Pattern Fine Signal Tolerance – 6.5.4 
Cross Pattern Fine Azimuth Velocity – 6.5.5 
Cross Pattern Fine Elevation Velocity – 6.5.5 
Fine Peak Signal Dif. Pass – 6.5.3 
Fine Peaking Cycles – 6.5.3 
Fine Peaking Maximum Cycles – 6.5.3 
Fine Peaking Mode – 6.5.3 
Line Scan Maximum Elevation Steps – 6.5.11 
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Line Scan Failure Elevation Step Size – 6.5.11 
Modem Based Target Allowed – 6.5.11 
Modem TX Disable Wait – 6.5.11 
Modem Minimum Wait Time – 6.5.11 
Modem Maximum Wait Time – 6.5.11 
Peak Dwell Iterations – 6.5.4 
Peaking Azimuth Travel Limit – 6.5.6 
Peaking Elevation Travel Limit – 6.5.6 
Peaking Ignore Noise Level – 6.5.1 
Peaking Polarization Travel Limit – 6.5.10  
Plateau Peaking Coarse Azimuth Velocity – 6.5.9 
Plateau Peaking Coarse Elevation Velocity – 6.5.9 
Plateau Peaking Fine Azimuth Velocity – 6.5.9 
Plateau Peaking Fine Elevation Velocity – 6.5.9 
Polarization Dwell Iterations – 6.5.10 
Polarization Peak Coarse Azimuth Velocity – 6.5.10 
Polarization Peak Coarse Elevation Velocity – 6.5.10 
Polarization Peak Fine Azimuth Velocity – 6.5.10 
Polarization Peak Fine Elevation Velocity – 6.5.10 
Polarization Peaking Enabled – 6.5.10 
Polarization Peaking Step – 6.5.10 
Scan Azimuth Velocity – 6.5.1 
Scan Elevation Velocity – 6.5.1 
Scan Polarization Velocity – 6.5.10 
Skip Coarse Peak If Tx Enabled – 6.5.11 
Slow Scan Azimuth Velocity – 6.5.1 
Slow Scan Elevation Velocity – 6.5.1 
Slow Scan Polarization Velocity – 6.5.1 
Step Pattern Coarse Peaking Azimuth Step 
Step Pattern Coarse Peaking Elevation Step 
Step Pattern Coarse Azimuth Velocity – 6.5.7 
Step Pattern Coarse Elevation Velocity – 6.5.7 
Step Pattern Fine Azimuth Velocity – 6.5.8 
Step Pattern Fine Elevation Velocity – 6.5.8 
Step Pattern Fine Peaking Azimuth Step – 6.5.7 
Step Pattern Fine Peaking Elevation Step – 6.5.7 

 
 

6.1.4 Feed Parameters 
 

Feed Parameters relate to the movements and limits of the variety of feed based model options. 
 
Elevation Inc Offset – 6.6 
Line Scan Polarization Adjust Flag – 6.6 
Manual Polarization – 6.6 
Polarization Center Switch Is Interlock – 6.2.4 & 6.6 
Polarization Feed Type – 6.6 
Polarization Limit Is Interlock – 6.2.4 
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Polarization Pos Move Maximum PWM – 6.6 
Polarization Pos Move Minimum PWM – 6.6 
Polarization Pos Move PWM Factor – 6.6 
Polarization RF Offset – 6.6 
Polarization Stow Position – 6.6 
Polarization Motor Abs Enc Offset – 6.6 
Polarization Motor Abs Enc Scale Factor – 6.6 
Polarization Motor Scale Factor – 6.6 
Polarization Pot Offset – 6.6 
Polarization Pot Scale Factor – 6.6 
Polarization CW Limit – 6.6 
Polarization CCW Limit – 6.6 
User Polarization CCW Limit – 6.6 
User Polarization CW Limit – 6.6 
 

6.1.5 Optional 

 
A number of system options are available for AvL products. These are listed at the end of the 
chapter and will contain a column for the category of configuration where they can be found. 

 
Feed Slide – 6.8.2 
NMEA Server – 6.8.1  
Vector Compass – 6.8.3 
Wings – 6.8.4 
Wind Compensation – 6.8.5 
 
See Appendices for the following internal options: 

 
Appendix H - DvB Receiver   
Appendix M - Step Track 
Appendix N - Position Hold Lite  
Appendix O – TLE Track 
Appendix P - Step Track Hold   
Appendix S – Predictive Track 
 

6.2 Hardware Safety & Mechanical Limits - Core 
 

Safe operation of the AvL antenna system is essential and it is critical that the AAQ software be configured 

appropriately.  Many limits on motion of the antenna are set by physical switches that are monitored by the 

AAQ ACU.  Others are set by software configuration parameter values that are compared to a particular 

system variable or sensor output.  Most of these are set in the factory, not subject to change and require a 

high privilege level to view and modify.  A small group is subject to change after the antenna leaves the AvL 

factory due to later mounting of CFE hardware on the antenna system and installation of the antenna onto 

the integrator’s vehicle or base support.  It is this small group of parameters that is addressed in this section. 
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6.2.1 Pedestal Limits 

 

Long name Level Type Value Range Documentation 

Elevation Up Stow Limit 4 Float 0.0 to 180.0 (deg) The maximum elevation for the stow switch position. 

Elevation Down Stow Limit 4 Float -90.0 to 90.0 (deg) The minimum elevation at the stow position. 

Elevation Down Limit 4 Float -45 to 45 (deg) 
Down elevation limit (except stow position) when using a 

removable reflector and the reflector is mounted. 

Safe Turn Maximum Elevation 4 Float 0 to 180 (deg) Maximum elevation that is safe to turn in Azimuth 

Safe Turn Maximum Elevation 
Reflector Mounted 

4 Float 0 to 180 (deg) 
Maximum elevation that is safe to turn in Azimuth when 
using a removable reflector & the reflector is mounted. 

User Azimuth CCW Limit 4 Float -220.0 to 0.0 
The maximum counter clockwise pedestal azimuth 

position 

User Azimuth CW Limit 4 Float 0.0 to 220.0 The maximum clockwise pedestal azimuth position 

User Elevation Down Stow 
Limit 

4 Float -90.0 to 90.0 The minimum elevation at the stow position 

User Elevation Up Limit 4 Float 0.0 to 180.0 The maximum elevation of the positioner 

 
 

~IMPORTANT~ 
 

When the antenna is pointing at low look angles, the movable feed boom, along with 

any CFE BUC(s) that may be mounted on it, is located in close proximity to the 

stationary base support.  Safe elevation angles must be determined for normal 

operation of the antenna. This includes movement while the antenna is deployed and 

when it reaches the stow position.  All elevation angles associated with these 

parameters are Ped-EL values, which are referenced to the antenna mechanical 

interface and are not subject to adjustment due to tilt compensation. Special attention 

should be paid to the full range of antenna motion and any objects attached to the deck 

below the antenna that might not be stowed when the antenna in its normal 

operational position. 

 

The Elevation Up Stow Limit is set to a value slightly (typically 0.5 degrees ) above the target El stow 

position (for antenna systems that stow in the up position).  The target Elevation stow position is set 

by either a mechanical switch located on the antenna’s elevation axis or, less frequently, by a sensor 

(usually a Resolver) when “Stow to Position” mode is employed.  This parameter is a safety limit that 

is only tripped if the normal stow process fails to stop antenna elevation motion at the target stow 

position for any reason.  This limit is only active when the antenna is at the Azimuth Stow Position 

angle, otherwise the appropriate Elevation UP Limit is in effect. 

 

The Elevation Down Stow Limit is set to a value slightly (typically 0.5 degrees) below the target 

Elevation stow position.  The target Elevation stow position is set by either a mechanical switch 

located on the antenna’s elevation axis or, less frequently, by a sensor (usually a Resolver) when 
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“Stow to Position” mode is employed.  This parameter is a safety limit that is only tripped if the 

normal stow process fails to stop antenna elevation motion at the target stow position for any 

reason.  This limit is only active when the antenna is at the Azimuth Stow Position angle; otherwise 

the appropriate Elevation Down Limit is in effect. 

 

Elevation Down Limit is also referred to as the “Safe Turn Limit”.  This is the minimum elevation 

angle for deployed antenna motion.  It should be set to insure that the antenna, CFE hardware and 

cables located on the moving platform (above the azimuth bearing ring) do not contact anything on 

the stationary base structure / vehicle.   

 

“User” level limits are specifically designed for the user or integrator so that custom limits can be 

created without disabling safety limits built into the system. 

 

6.2.2 Stow Position 

 

Long name Level Type Value Range Documentation 

Show Stow Warning 4 Choice 
“No”, “Yes” Default: 

Yes 
Flag indicating whether a user is prompted with a 
warning before stow. 

Azimuth Stow Position 
(AzStowPosition) 

4 Float -180 to 180 
The position in degrees for azimuth in the stow 
routine. 

Elevation Stow Position 4 Float -100 to 180 
Elevation stow position in degrees if the stow 
type is 'Stow at Position'. 

Polarization Stow Position 4 Float -180 to 180 
The position in degrees of the pol for the stow 
routine. 

Auto Stow On Movement 4 Choice “No”, “Yes” 
Enables Auto Stow function when set speed is 
reached. 

Auto Stow Speed 4 Integer 0 to 200 Speed from the GPS to trigger an auto stow. 

Auto Stow Speed time 4 Integer 0 to 200 
Time in seconds at the specified speed to trigger 
an auto stow. 

 

 

Proper setting of the Stow Position is essential for all AvL antenna systems, as some models use non-

standard type mounting designs.  The manual provided with every AvL antenna system provides details 

on how the Stow Position should be determined for that antenna.   

Once the antenna has been manually placed in the correct Stow Position, the Azimuth, Elevation and 

Polarization Stow Position parameter values with Type = Float should be set to match the appropriate 

Pedestal angle displayed at that position. 

 

The Azimuth Stow Position parameter with Type = Float, tells the AAQ what position in degrees that the 

Stow Routine will be performed. 
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The Auto Stow On Movement parameter is reserved for vehicular mount antennas. If this is enabled, 

any information from the system GPS indicating vehicle motion above a set speed will activate the 

antenna stow routine. Speed indication units are determined by the GPS settings. 

 
 

6.2.3 Reflector/Feed On/Off 

 

Long name Level Type Value Range Documentation 

Reflector Mount Azimuth Position 4 Float - 180.0 to 180.0 
Pedestal Azimuth position for reflector mount or 

dismount. 

Reflector Mount Elevation Position 4 Float - 180.0 to 180.0 
Pedestal Elevation position for reflector mount or 

dismount. 

Reflector Mount Elevation Switch 
Position 

4 Choice “No”, “Yes” 
Pedestal Elevation switch position for reflector 

mount or dismount. 

Reflector Mount Switch Elevation 
Offset  

4 Choice “No”, “Yes” 
El position in degrees from the selected switch to 

mount the reflector. 

Reflector Mount Polarization 
Position 

4 Float - 180.0 to 180.0 
Pedestal Polarization position for reflector mount or 

 dismount. 

Elevation Down Limit Reflector 
Mounted 

4 Float -45 to 45 
Down elevation limit except at the stow position 

when using a removable reflector and the reflector 
ismounted. 

Safe Turn Maximum Elevation 
Reflector Mounted 

4 Float 0 to 180 
Maximum elevation that is safe to turn in azimuth 
when using a removable reflector and the reflector 

is mounted. 

 

 
Many AvL antenna systems have removable reflectors and feed booms to minimize pack-up size and 
improve transportability of the product.  These systems may have a Stow Position that is necessary 
for pack-up, but leaves no room for an attached reflector or feed boom.  In that case, the AAQ will 
not completely Stow the positioner until the operator confirms that these items have been safely 
removed.  Conversely, the antenna cannot operate as intended without these items installed, so the 
same confirmation process in reverse is required on antenna deployment. 
 
These parameters are typically set by the operator’s response to an appropriately timed prompt, 
offered by the AAQ in the appropriate GUI window. 
 
 
 
 
 
 

6.2.4 Interlocks 

 

Long name Level Type Value Range Documentation 

Azimuth CCW limit switch Is Interlock 4 Choice “No”, “Yes” 
The flag indicating that this digital input is an 
interlock (blocks other operations when set) 
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Azimuth CW Limit Switch Is Interlock 4 Choice “No”, “Yes” 
The flag indicating that this digital input is an 
interlock (blocks other operations when set) 

Azimuth Stow Is Interlock 4 Choice “No”, “Yes” 
The flag indicating that this digital input is an 
interlock (blocks other operations when set) 

Digital Input 0 (through 4) Is Interlock 4 Choice “No”, “Yes” 
The flag indicating that this digital input is an 
interlock (blocks other operations when set) 

Elevation Down Limit Switch Is 
Interlock 

4 Choice “No”, “Yes” 
The flag indicating that this digital input is an 
interlock (blocks other operations when set) 

Elevation Stow Raw Is Interlock 4 Choice “No”, “Yes” 
The flag indicating that this digital input is an 
interlock (blocks other operations when set) 

Elevation Up Limit Switch Is Interlock 4 Choice “No”, “Yes” 
The flag indicating that this digital input is an 
interlock (blocks other operations when set) 

Digital Output 2 (or 3) Digital Out 
1(through 6) 

4 Integer 0 or 1 State of Digital Output. 1= Set output to on. 

Wing Elevation Safety Switch is 
Interlock 

4 Choice  “No”, “Yes” Flag indicating the digital input as an interlock 

Wing Left/Right Deploy Switch is 
Interlock 

4 Choice “No”, “Yes” Flag indicating the digital input as an interlock 

Wing Left/Right Stow Switch is 
Interlock 

4  Choice “No”, “Yes” Flag indicating the digital input as an interlock 

 
 
Interlocks are digital inputs to the AAQ controller. Many of these inputs parallel existing switch and 
or sensor functions when needed. Optional systems often use interlocks for added safety or when 
functional redundancy is called for. Contact AvL customer support for additional information and 
before changing any interlock parameters which are part of your factory system configuration. 

 

6.3 General System Set-Up - Core 
 

The parameters discussed in this section are static and configure the AAQ for operation independent of the 

chosen Target Satellite or Signal Source(s).  They typically affect basic behavior of the system or make a 

choice among multiple hardware sensor or device options that may be available for a particular function. 

 

The General System Set-Up and previously discussed Hardware Safety parameters may be accessed through 

one of the four tabs, “Core”, “Target”, “Signal”, and “Feed”, in the Configuration window in the AAQRemote 

GUI.  An example of that window is provided as Figure 6.3. 

 

 

Path 

Main Window → View → Configuration 

Level 4 
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Figure 6.3 - AAQRemote Configuration Window 

 

6.3.1 RSL Meter 

 

Long name Level Type Value Range Documentation 

RSL1 Noise Floor 4 Float -100000 to 100000 Minimum value that indicates an RSL signal above noise 

RSL Minimum Lock 4 Float -100000.0 to 100000 Minimum value that indicates a lock with RSL 
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Threshold Default value: 50 

RSL Gradient Sample Time 4 Integer 0 to 60 Sample time for detecting the signal gradient 

RSL Noise Sample Time 4 Integer 0 to 60000 Sample time in MS for detecting signal noise 

RSL Com Port 4 String - The computer filename for the communications port used 

RSL Com Port Settings 4 String - 
The communications parameters for the com port, in the 

form of Baud, Data, Stop & Parity Bits (ie: 9600 8 1 0) 
where parity values are 0 for none and 1 for even. 

RSL1 Scale Factor 4 Float 
- 100000.0 to 100000 

Default value: 1 

Value to Divide the rad A/D value to produce a sensor 
value. The formula for producing a final value is: ((raw 

number*10000)/scale factor) 

 

The RSL power meter is used for broadband signal level detection.  Aside from the RSL 1 noise 

floor & lock threshold parameters, it is recommended that this device settings are changed only 

under the guidance of AvL technical staff.  

 

The RSL Minimum Lock Threshold value determines the Minimum signal strength reported for 

detecting a lock signal from a satellite. When this level is reached during a modem scan, the system 

will scan at the slow speed.  

The RSL 1 Noise Floor value determines the Minimum signal strength above which an RSL signal is 

indicated. 

 

6.3.2 Navigation 

 

Long name Level Type Value Range Documentation 

Primary heading Source 4 Choice 
"NoCompass", "GPS", "Compass", 

"Manual", "SatTant", 
"VectorCompass" 

The device to use as the primary source of the 
heading. 

Secondary Heading 
Source 

1 Choice 
"NoCompass", "GPS", "Compass", 

"Manual", "SatTant", 
"VectorCompass" 

The device to use as the heading source if the 
primary source fails. 

Heading Averaged 4 Choice "No", "Yes" 
This flag indicated if the heading will be 

averaged during the dwell time. 

Compass Heading Offset 1 Float -180.0 to 180.0 The offset in degrees of the compass device. 

Elevation Compass 
Position 

1 Float -180.0 to 180.0 
The Elevation position in degrees, to read the 

magnetic compass 

GPS Source 1 Choice 
 "Manual GPS", "Compass GPS", "NAV 

RIOM GPS", "Vector Compass GPS" 
The device to use as the source of the GPS 

location. 

 Coarse Peaking Source 4 Choice 
"RSL Meter 1", "Modem Signal Data", 

"Beacon Rx", "None" 
Signal strength source used for coarse 

peaking on alternate satellite. 

Use Man. GPS on Fail 4 Choice "No", "Yes" 
Flag indicating that the manual GPS entry 

should be used on GPS failure. 

 

 

Nav Operation Mode controls the operating mode of the compass located inside the NAV RIOM.  It 

is typically set to “Normal.”  From time to time, it may be advisable to calibrate the Compass to 

compensate for vehicle mounting conditions or other similar consistent influences on compass 

readings.  When the parameter is set to “Calibration,” the AAQ automatically prompts the operator 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 116 of 200 
 

through the Compass calibration process. Do not calibrate the compass without consulting AvL 

technical support. 

 

Heading Source parameters set the primary and secondary sensors or methods that the AAQ will 

use to determine an initial compass heading for the antenna pedestal.  These parameters can be 

viewed or modified in either the main AAQRemote GUI window or the Controller Config window.  

The standard choices for these parameters are: 

 NoCompass – Instead of poling a sensor device for the Heading value, the AAQ will execute 

a user settable, AZ Line Scan to acquire. 

 GPS – AAQ uses the heading provided by the GPS receiver in the NAV RIOM based on the 

most recent directional motion of the platform. 

 Compass – AAQ uses the heading provided by the Compass in the NAV RIOM. 

 Manual – AAQ uses the current value of the Heading for Manual Compass parameter. 

 SatTant – The AAQ executes a SatTant based on the Compass heading to refine the pedestal 

heading at system initialization. 

 VectorCompass – Optional Vector Compass is used at the Heading Source. (optional) 

 

Heading Averaged – Averaging is performed during the compass read part of acquisition. The 

normal condition for this parameter is “Yes”. 

 

Compass Heading Offset is the nominal difference between the Pedestal Heading and the Compass 

Heading.  This parameter takes into account the difference between the orientation of the Compass 

device inside the NAV RIOM and the Pedestal.  This value is calibrated in the factory, but must be 

made available at lower user login privilege levels to enable potential NAV RIOM replacement in the 

field. Do not change this value without the assistance of AvL technical staff. 

 

Based on the Magnetic Compass parameter, the AAQ can make the necessary correction for 

magnetic declination whenever necessary to convert a Compass reading from Magnetic North to the 

required True North reference frame. 

 

Coarse Peaking Source identifies the default Signal Source that will be used for the Target Satellite 

during the Coarse Peaking process.   
 

Values for the Signal Source 1 / 2 / 3 configuration parameters are selected on the left-hand side of the 

Profile System window (see Figure 6.4).  All valid Signal Sources are available for each step in all three 

Acquisition attempts.  As implied in the figure, up to three successive attempts will be made by the AAQ 

to acquire the Target Satellite based on entries made in the Primary, Secondary and Tertiary sections.   

This flexibility provides the Level 4 operator with the option of attempting the quickest, possibly least 

reliable, method first knowing that the system will automatically progress to more robust acquisition 

schemes.  Parameter choices for the standard systems are: 
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 None – AAQ will skip that step in the Acquisition process. 

 RSL – RSL Meter 1 (default) 

 Modem (if installed) 

 Beacon Receiver (if installed) 

 DvB Receiver (if installed) 
 

6.3.3 SATTANT 

 

Long name Level Type Value Range Documentation 

SatTant Heading Timeout  4 Integer 0 to 60000 Time in seconds to invalidate a SatTant based heading 

 
 

The total validity time for a SatTant based heading is set by the SatTant Heading Timeout 

parameter.  Setting the parameter value to “0” keeps the SatTant based heading valid indefinitely or 

until the next AAQ system reboot.  A non-zero value may be selected to insure that a SatTant is 

repeated each time a new Target Satellite is selected that meets the criteria.  However, care should 

be taken in setting the value such that the SatTant based heading remains valid through completion 

of the Acquisition process. 

 

6.3.4 Manual Moves 
 

Long name Level Type Value Range Documentation 

Manual Control Azimuth Fast 
Speed 

4 Float 0.1 - 100.0 
Speed in degrees per second for manual control of the 

azimuth motor in fast mode. 

Manual Control Azimuth Slow 
Speed 

4 Float 0.1 - 100.0 
Speed in degrees per second for manual control of the 

azimuth motor in slow mode. 

Manual Control Elevation Fast 
Speed 

4 Float 0.1 - 100.0 
Speed in degrees per second for manual control of the 

elevation motor in fast mode. 

Manual Control Elevation Slow 
Speed 

4 Float 0.1 - 100.0 
Speed in degrees per second for manual control of the 

elevation motor in slow mode. 

Manual Control Polarization Fast 
Speed 

4 Float 0.1 - 100.0 
Speed in degrees per second for manual control of the 

pol motor in fast mode. 

Manual Control Polarization Slow 
Speed 

4 Float 0.1 - 100.0 
Speed in degrees per second for manual control of the 

pol motor in slow mode. 

Manual Control Allow Modem Tx. 4 Choice "No", "Yes" When set to “Yes”, does not disable Tx in Manual mode. 

 

The speed at which the antenna moves when manually jogged is set by the Manual _ Speed 

parameters.  Each of the three axes is set independently.  Two speed settings are available; “Fast” 

and “Slow.”   
 

The “Fast” setting is typically set to a value at or above the maximum speed that the antenna axis 

can move.  Setting a value higher than the maximum actual speed has no effect, ill or otherwise. 

Common values are in the area of 1 to 6 degrees per second. 
 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 118 of 200 
 

The “Slow” setting is typically set to a very low value.  This allows very fine adjustments to be made 

such that accurate fine peaking on that axis can be easily verified or emulated. Common values are 

in the area of 0.1 to 2 degrees per second. 

 

Manual Control Allow Modem Tx. makes transmitting from modem possible in manual mode. 

Typically this is not recommended, given the possibility of unintended interference and should be 

used with caution.  

 

 

6.3.5 Acquisition 

 

Long name Level Type Value Range Documentation 

Satellite Inclination Threshold 4 Float 0.0 - 100.0 (deg) 
The inclination threshold of the current satellite. 

Inclination status variable is set when this is exceeded. 

Line Scan Polarization Adjust 
Flag 

4 Choice "No", "Yes" 
Flag indicating that the Pol should be adjusted during a 

line scan. Usually set to Yes. 

Compass Scan Width 1 Float 0.0 to 400.0 (deg) 
Scan width to use during a SatTant or 0.0 to disable 

SatTant. 

GPS Scan Width 1 Float 0.0 - 400.0 (deg) 
Scan width to use during a SatTant or 0.0 to disable 

SatTant. 

Manual Compass Scan Width 1 Float 0.0 to 360.0 
Heading scan width in degrees to scan if override 

compass is selected. 

NoCompass Scan Width 1 Float 0.0 - 400.0 (deg) 
Scan width to use during a SatTant or 0.0 to disable 

SatTant. 

Polarization Flip Amount 4 Float -180 to 180 
This will be added to pol when target is below CCW 

limit & subtracted when above CW limit. 

Polarization Home Position 4 Float -180 to 180 Position in degrees of the pol home switch 

Pitch Inc Offset 4 Float -180 to 180 Offset in degrees to add to the pitch inclinometer 

Roll Inc Offset 4 Float -180 to 180 Offset in degrees to add to the roll inclinometer 

Azimuth Motor Scale Factor 4 Integer -100000 to 100000 
Unit factor to divide by to produce the actual value 

needed by code 

Azimuth Motor Abs Enc Offset 4 Float -600.0 to 600.0 
The offset in degrees to be added to the read position 

of the absolute encoder 

Azimuth Motor Abs Scale 
Factor 

4 Float -10000.0 to 10000.0 
The factor that will be multiplied to the raw absolute 

encoder or resolver value 

Elevation Motor Scale Factor 4 Integer -100000 to 100000 
Unit factor to divide by to produce the actual value 

needed by code 

Elevation Motor Abs Enc Offset 4 Float -600.0 to 600.0 
The offset in degrees to be added to the read position 

of the absolute encoder 

Elevation Motor Abs Enc Scale 
Factor 

4 Float -10000.0 to 10000.0 
The factor that will be multiplied to the raw absolute 

encoder or resolver value 

Azimuth Pot Scale Factor 4 Float -10000 to 10000 
Value to Divide the rad A/D value to produce a sensor 
value. The formula for producing a final value is: ((raw 

number*10000)/scale factor) 

Azimuth Pot Offset 4 Float -360 to 360 The offset added to the converter A/D value. 

Signal Wait Time 4 Integer 0 - 1000 
Number of seconds to wait for valid signal data from a 

signal device. 
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Cross Polarization Disable 4 Choice "No", "Yes" 
Flag indicating that automatic & manual cross pol 

should be disabled. This is usually set to no. 

 

 

The Satellite Inclination Threshold parameter sets the satellite inclination angle value that tells the 

AAQ to switch from standard to Inclined Satellite Acquisition process.  In general, the Inclined 

Satellite Acquisition process takes longer than the standard Acquisition process when the satellite is 

located close to the equatorial plane.  However, if the satellite is significantly inclined, then the 

Inclined Satellite Acquisition process must be used to assure a high probability of success. The 

optimal setting for a particular antenna and frequency band is best arrived at empirically.  

The Inclination of typical commercial satellites is kept within 0.15 degrees. “Inclined“ satellite orbits 

may deviate to as much as 5 degrees or more.  
 

Satellite Inclination should be set to the published value for the Target Satellite.  If the Target Satellite is 

listed as “Geostationary” and no inclination value is provided, then a value of “0.0” is usually a good 

choice.  If a successful acquisition is not consistently occurring on the first Acquisition AZ line scan, then 

this satellite property should be verified by other means. 
 

The Line Scan parameters establish the overall height and number of lines used in the standard 

Acquisition raster scan.  Line Scan Pol Adjust Flag – This indicates that the Pol should be adjusted during 

a line scan. Usually set to Yes. 
 

The Scan Width parameter sets the width of the AZ Line Scan used for SatTant as well as Target Satellite 

Acquisition purposes.  The scan width should be based primarily on the assumed accuracy of the 

Heading Source.  The scan width for each valid Heading source (see Section 6.3.3) can be set 

independently using these parameters.  If SatTant is selected as the Heading source, then the Compass 

Scan Width value will be used for the SatTant scan and the Target Satellite will be acquired directly 

without scanning.  

Pitch Inc Offset & Roll Inc Offset are factory settings where access is reserved for field service 

requirements. Consult AvL technical staff before making changes. 
 

Motor Offset - Because of variations in manufacturing tolerance, it occasionally becomes necessary 

to add a small angular value to correct for mechanical error in the axis. This should not be adjusted 

unless the system has been repaired. (includes Abs Encoder Offset) 

 Motor Scale Factor - Because of variations in manufacturing tolerance, it occasionally becomes 

necessary to change the scale factor to correct for mechanical error in the axis. This should not be 

adjusted unless the system has been repaired. (includes Abs Encoder Scale Factor) 

Signal wait time – If signal device (modem. beacon receiver etc.) has not provided a valid signal and wait 

time has been exceeded, the controller will then proceed to the secondary, then tertiary acquisition 

method. Should these also fail to acquire, the controller will present the user with the message, 

“Acquisition Failed, Waiting for Beacon / Modem Signal”    
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6.3.6 Time 

 

Long name Level Type Value Range Documentation 

NTP Server IP Address 1 String - 
IP Address for the NTP (time) server. Leave blank to 

not use an NTP server. 

NTP Server Port 1 Integer 0 - 65536 
Port number used to communicate with the NTP 

server (123 is the default). 

Time Source 1 Choice 
"None", "NTP", "NAV 

RIOM GPS", "XML" 
Time source used by the controller for time 

synchronization. 

Time Service Maximum GPS 
Drift 

4 Float - Time Service Max GPS Drift 

AvL Compass Com Port 4 String - 
The computer device filename for the 

communications port used for serial and the IP 
address used for Ethernet 

AvL Compass Com Port 
Settings 

4 String - 

The communications parameters for the comm port 
in the form of BaudRate DataBits StopBits Parity for 

serial (ie 9600 8 1 0) where parity values are 0, and IP 
port used for Ethernet. 

 

NTP Server parameters define the IP address and port number for the NTP (Network Time Protocol) 

server the AAQ should use for time synchronization, assuming one is available for that purpose.  If not, 

then the IP Address should be left blank. 
 

The Time Source parameter defines the source used by the AAQ for time synchronization purposes.  A 

description of the available choices follows.  The default value for this parameter is “None.” 

 None – AAQ will use its internal time reference.  Time stamps in AAQ system logs will reflect 

time since system start-up, with time zero equal to 0:00 AM on 1 January 2000. 

 NTP – AAQ will use the NTP server with the IP address and port number specified by the NTP 

Server configuration parameters. 

 NAV RIOM GPS – AAQ will synchronize its time with its own GPS receiver inside the NAV RIOM.  

Prior to receiving a valid GPS message from the receiver, the AAQ will use its own internal time 

reference. 

The Time Service Maximum GPS Drift measures the differential in time between GPS time readings that 
compares to the time increment reported, if exceeded, a GPS time error is indicated. 
 
The AvL Compass settings are needed when the system time source is set to GPS. 
 

6.3.7 Other Core Parameters 

 

 

Long name Level Type Value Range Documentation 

Modem Tx Restore On Open 4 Choice "No", "Yes" 
Restore the modem Tx enable when 
modem is reopened after a failure. 

Modem Tx Enable On Rx Lock 4 Choice "No", "Yes" 
Set modem Tx enabled if Rx Lock is 

received during idle processing. 
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Run Position Hold on Startup 4 Choice "No", "Yes" 
This flag indicates whether position hold 
should be run on startup if an Rx lock is 

detected 

Position Hold Run Acquire on 
Peak Fail 

1 Choice "No", "Yes" 
If set to yes then the acquire command 
will be run if peaking fails to find a lock 

during position hold. 

Controller Name 4 String - Name of the controller 

Controller Serial Number 4 String - Serial number of the controller 

Panel Connect Blocks Others 1 Choice "No", "Yes" 
This flag indicates whether other clients 

are blocked when connected. 

Rack Controller Field 0 - 9 1 String - 
Field Name for a single field to display in 
the rack controller. Blank will skip the 
field 

Rack Controller Label 0 - 9 1 String - 
Label for a single field to display in the 
rack controller. 

Repeak On Power On When 
Rx Locked 

4 Choice "No", "Yes" 
This flag indicates that system should run 
re-peak on power up if the Rx lock is 
active. 

Step Mode Sample Delay 4 Integer 0 to 1000 
Delay in MS between testing and 
retrying the step jog mode move 

Step Mode Wobble 
Correction 

4 Choice "No", "Yes" 
Flag indicating that wobble correction 
should be performed when the Pol is 
changed 

Circular Polarization Center 
Position 

4 Float -90 to 90 
Center position, in degrees, Of the 
motorized circular pol 

Feed Bit Override 4 Choice "No", "Yes" 
Flag indicating whether the feed bits are 
overridden with a manual value 

Feed Bit Override Type 4 Choice 

, "C-LP", "X-LP", "Ku-LP", "Ka-LP", "C-
CP", "X-CP", "Ku-CP", "Ka-CP", "L", "S", 

"Q", "Ka (EXTENDED)", "C-CP 
(MOTORIZED)", "Ka-CP (MOTORIZED)", 

"C-LP-2" 

Value to override the feed bits with 

Manual Control Allows 
Modem Tx 

4 Choice 
“No”, “Yes” 

When set to yes, doesn’t disable the tx 
when manual control is run 

 

 

The Modem configuration parameters are only valid if the AAQ is optionally configured to 

communicate with the terminal’s modem.  If this option has been exercised, then these parameters 

specify the AAQ’s response under the specific conditions as described above in the Documentation 

column. Also see the appendix documentation in accordance with the specific modem used.  

 

The Controller parameters are set in the AvL factory and visible at all privilege levels for service and 

maintenance purposes.   

 
Wobble Correction compensates for any mechanical offset which may occur during the movement 
of the feed assembly and it’s operation depends upon the specific feed type used. 
 
The Feed Bit Override parameter, extends the choices available to the controller outside the 
information provided by the feed bit logic output which comes from the feed itself. This also allows 
proper use of feeds which do not have feed bit control. 
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6.4 Automatic Operation - Target 
 

Configuration of the AAQ’s automated features is made on a Target Satellite or Signal Source specific 

basis using the Profile System.  The steps necessary to create and manage Profiles are described in 

Chapters 4 & 5 of this document.  In this section, the configuration parameters contained in these 

Profiles are detailed. 
 

The Signal Sources and Acquisition Geometry may be defined for each Target Satellite independently by 

setting up a Profile.  In this way, reliable satellite detection and good signal quality for antenna peaking 

purposes can be assured for all satellites of interest.   
 

Without this critical flexibility, antenna performance could be significantly compromised by satellites 

that vary widely in their signal characteristics.  The parameters and sources that may be tailored for a 

specific satellite are accessible through the Profile System window of the AAQRemote GUI.  An example 

is shown in Figure 6.4. 
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Figure 6.4 - AAQ Target and Profile System Window 

 

 

6.4.1  Target Satellite 

 

Long name Level Type Value Range Documentation 

Current Satellite Inclination 1 Float -100 to 100 The inclination of the current satellite. (degrees) 

Current Satellite 1 String - 
The longitude of the satellite to target during acquire 
with the numeric portion in decimal degrees and the 
hemisphere as a single letter (ie 61.5 W). 

Current Satellite Polarization 1 Choice 
"Horizontal", 

"Vertical" 
Feed orientation for the selected satellite 
(Horizontal/Vertical). 

Reference Profile 1 1 Choice All Listed 
First reference profile used to perform a Ref Sat 
Acquisition 

Reference Profile 2 1 Choice All Listed 
Second reference profile used to perform a Ref Sat 
Acquisition 

Reference Satellite Mode 4 Choice "No", "Yes" 
Flag indicating that reference profiles should be used if 
a heading is needed. 
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Note – The three following parameters are entered automatically when a target 

satellite is selected. These may be changed from the Satellite List. 

 

Satellite Inclination should be set to the published value for the Target Satellite.  If the Target 

Satellite is listed as “Geostationary” and no inclination value is provided, then a value of “0.0” is 

usually a good choice.  If a successful acquisition is not consistently occurring on the first Acquisition 

AZ line scan, then this satellite property should be verified by other means. 
 

Current Satellite should be set to the Longitude value of the Target Satellite.  Format is important 

for this parameter.  It must be entered in decimal degrees followed by a space and a single letter 

indicating hemisphere (e.g. 61.5 W or 110.0 E). 
 

Satellite Orientation is critical for linearly polarized satellite signals.  It should be chosen to match 

the linear polarization of the Target Satellite’s downlink (receive) signal.  This value is used by the 

AAQ to correctly position the Polarization Axis of the antenna.  If the Target Satellite is circularly 

polarized, then the value of this parameter is ignored by the AAQ. 
 

Reference Satellite Mode performs two checks to determine if either Reference Profile is valid for 

use in locating the Target Satellite.  The first check looks to see if either Reference Satellite is within 

the SatTant Min Long dif (typically 20 degrees) Core Configuration setting available for reading and 

writing at level 7 and above.  The second check looks to see that the elevation of the Reference 

Satellite is greater than zero degrees.  If both Reference Satellites are valid, then the closest is used 

for reference.   If both Reference Satellites fail, then the AAQ performs a SatTant to locate the 

Target Satellite. 

 
 

6.4.2 Target Sources 

 

Long name Level Type Value Range Documentation 

Modem Type 4 Choice "None", "RSL" Type of modem installed. 

RSL 1 Attenuation 4 Choice 
"0 dB", "1 dB", "2 dB", "4 dB", "8 

dB", "16 dB", "31.5 dB" 
Specifies the attenuation of the built in RSL 

meter. 

Satellite Signal Source 4 Choice "None", "Modem", "Beacon" Signal source of the 'modem' satellite. 

Coarse Peak Signal  
Source 1 - 3 

1 Choice 
"None", "RSL", modem, beacon 

see description below 
Type of modem, beacon if installed. 

Fine Peak Signal Source 1 - 3 1 Choice “ Type of modem installed. 

Scan Signal Source 1 - 3 1 Choice “ Type of modem installed. 
 

The choice made for Modem Type tells the AAQ which device will be providing the Modem Data Signal.  

The drop-down menu will contain all valid choices for the AAQ as configured for that particular system, 

which might include multiple optional Modem makes and models and / or a Beacon Receiver.  With no 

optional device Modules installed, the choices for this parameter are: 
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 None legacy? 

 RSL – RSL Meter 1 
 

The RSL Attenuation parameters set the input attenuator value for the broadband power meter to 

discrete values ranging from 0.0 to 31.5 dB.  By properly adjusting this parameter value for each 

satellite, the RSL meter remains within its linear range at maximum received signal levels and dynamic 

range is also maximized.  Good dynamic range and linear performance insures robust, more reliable 

Acquisition and optimal Fine Peaking on the satellite signal. 
 

Sat Signal Source identifies the default Signal Source that will be used for the Target Satellite during the 

Acquisition (Scan) process.  Choices for this parameter are: 

 None - AAQ will skip that step in the Acquisition process. 

 Modem – The modem signal is used provided the AAQ has been optionally configured to 

interface with the Modem.  Otherwise, the AAQ will use RSL Meter 1. 

 Beacon – The signal level reported by the Beacon Receiver is used provided the AAQ has been 

optionally configured to interface with that device.  Otherwise, the AAQ will use RSL Meter 1. 
 

Values for the Signal Source 1 / 2 / 3 configuration parameters are selected on the left-hand side of the 

Profile System window (see Figure 6.4).  All valid Signal Sources are available for each Acquisition and 

Peaking step in all three Acquisition attempts.  As implied in the figure, up to three successive attempts 

will be made by the AAQ to acquire the Target Satellite based on entries made in the Primary, Secondary 

and Tertiary sections.   

This flexibility provides the Level 4 operator with the option of attempting the quickest, possibly least 

reliable, method first knowing that the system will automatically progress to more robust acquisition 

schemes.  Parameter choices for the standard systems are: 
 

 None – AAQ will skip that step in the Acquisition process. 

 RSL – RSL Meter 1 

 Modem (if installed) 

 Beacon Receiver (if installed) 

 DvB Receiver (if installed) 
 

6.4.3 Target Acquisition 

 

Long name Level Type Value Range Documentation 

Acquisition Geometry 4 Choice *"Direct" 
The acquisition geometry module to use during the 

acquisition process. 

Acquire Modem Scan Width 1 Float 1.0 - 45.0 The width to scan for modem signal in degrees. 

Satellite Polarization Offset 4 Float -180 - 180 (deg) 
The pol correction to be added to the calculated pol 

position during the targeting sequence. 

Use Secant Correction 4 Choice “Yes”, “No” 
Flag indicating whether to use a SECANT correction 

on azimuth scans 

Disable Scans 4 Choice “Yes”, “No” 
Flag indicating that a compass scan over the target 

should not be run (yes = do not run scans) 
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Acquisition Geometry selects the AZ and EL search pattern, or geometry, which will be used during 

the Acquisition process for the Target Satellite.  The standard AvL antenna ships with a single 

Geometry Module that performs a Direct search referred to elsewhere in this document as a raster 

scan.   
 

A single AZ Line Scan is performed centered at the predicted satellite location.  If this initial scan is 

not successful, then the EL angle is changed by a user specified amount and the AZ Line Scan is 

repeated.  *If optional Geometry Modules are included in the AAQ software, then they will also 

appear as choices in the drop-down menu list for this parameter. 

 

Acquire Modem Scan Width defines the AZ and EL scan widths that are used to acquire the Target 

Satellite after the Heading has been refined by either a successful SATTANT satellite acquisition or 

previous acquisition of a Target Satellite.  Under these conditions, the heading is known with higher 

precision and a much smaller scan angle is sufficient to locate the current Target Satellite.  Smaller 

scan angles are particularly advantageous when the Signal Source is the RSL Meter, as this minimizes 

the chance that a stronger neighboring satellite will be detected and peaked upon.  

 

Satellite Polarization Offset is used to include the published linear polarization offset, or skew, for 

the Target Satellite in the POL pointing solution.  For example, Eutelsat’s fleet of satellites employ a 

3.5 degree skew in their linear polarization vector. 

The use of Secant Correction is determined by the design of the antenna system. This parameter is 

generally not changed from the factory test setting. 

 

The Disable Scans Flag indicates that a compass scan over the target will not be run. Choosing “Yes” 

will prevent scans from being run. This allows the controller to use the original heading source 

instead of performing a SatTant or in the case where TLE tracking is used. If signal sources with good 

satellite signal discrimination are going to be used and short acquisition times are essential, then the 

time required to complete a SatTant under normal conditions may always be avoided by choosing 

“Yes” for this parameter.  Note: This will increase the probability of acquiring the wrong satellite if 

the RSL signal source plays any role in the systems Acquisition or Peaking processes defined later in 

this section.  

 

 
 
 

6.4.4 Other Target Based Parameters 

 

Long name Level Type Value Range Documentation 

Tx Enable Before Fine Peak 4 Choice "No", "Yes" 
If enabled then Tx is enabled before fine 

peaking otherwise Tx is enabled after 
acquisition. 
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Circular Polarization Left Hand 
Position 

1 Float -90 to 90 
Left hand position, in degrees, Of the 

motorized circular pol 

Circular Polarization right Hand 
Position 

1 Float -90 to 90 
Right hand position, in degrees, Of the 

motorized circular pol 

Circular Polarization Position 1 Choice 
“Center”, “Left Hand”, 

“Right Hand”, 
Polarization target for motorized circular pols 

Run Position Hold After Acquire 1 Choice "No", "Yes" 
Flag indicating that Position Hold should run 

after a successful acquisition. 

Run Position Hold After Peak Cmd 1 Choice "No", "Yes" 
Flag indicating that Position Hold should run 

after a successful peaking routine. 

Position Hold Step 1 (through 4) 4 Choice "No", "Yes" 
Position Hold / Tracking module to use. Up to 4 

can be called, each with a different 
configuration item 

Skip Acquire Sat State 1 Choice "No", "Yes" 

Flag indicating whether the acquire state 
should be set performed before entering 

track mode. 

 

 

If a Modem Module is present in the AvL antenna system and it supports a TX enable / disable 

command, then the Tx Enable Before Fine Peak parameter may be used to modify when the TX Enable 

command is sent to the Modem by the AAQ.  This flag is typically not set (Value = “No”) by default and 

the TX Enable command is sent after Fine Peaking is completed. 
 

When set (Value = Yes), the Run Position Hold After Acquire (tracking option)instructs the AAQ to start 

the Position Hold process immediately after completion of the Acquisition process.  Examples of the 

Position Hold process are Tracking and Wind Hold, which are optional AAQ features enabled by 

additional Software Modules. 

 

Some optional modes of operation such as TLE and Predictive Track do not require a standard 

acquisition. For these, the Skip Acquire Sat State in enabled to allow these tracking modes to begin 

immediately. 
 

6.5 Signal Source Based Parameters 
 

Properly configuring the parameters in the previous section assures that a good signal will be made 

available to every Signal Source device.  Since each device has its own characteristics, strengths and 

weaknesses, the AAQ software gives the Level 4 operator the opportunity to fine tune the Acquisition 

and Peaking processes for each Signal Source.  Those parameters are available for viewing and 

modification in the AAQRemote’s Profile Signal Source Window.  An example of this window appears in 

Figure 6.5. 
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Figure 6.5 - AAQRemote Profile Signal Source Window 
 

 

 

6.5.1  Acquisition  

 

Long name Level Type Value Range Documentation 

Scan Azimuth Velocity 4 Float 0.01 - 60.0 (deg/sec) 
Azimuth scanning maximum velocity used in scanning 

movements. 

Scan Elevation Velocity 4 Float 0.01 - 60.0 (deg/sec) 
Elevation scanning maximum velocity used in scanning 

movements. 

Scan Polarization Velocity 4 Float 0.01 - 60.0 (deg/sec) 
Polarization scanning maximum velocity used in scanning 

movements. 

Slow Scan Azimuth Velocity 4 Float 0.01 - 60.0 (deg/sec) 
Azimuth slow scanning maximum velocity used in scanning 

movements. 

Slow Scan Elevation 
Velocity 

4 Float 0.01 - 60.0 (deg/sec) 
Elevation slow scanning maximum velocity used in scanning 

movements. 

Slow Scan Polarization 
Velocity 

4 Float 0.01 - 60.0 (deg/sec) 
Polarization slow scanning maximum velocity used in 

scanning movements. 

Peaking Ignore Noise Level 4 Choice "No", "Yes" 
Select “Yes” to ignore calculated noise. Select “No” to only 

peak on signal changes greater than the noise. 
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These Scan Velocity parameters set the maximum speed that each axis is allowed to move when the 

indicated scan speed is used by the AAQ.   

Speeds should be selected with the delay and response time of the device in mind.  For example, if 

the device’s signal output level is slow to respond to actual changes in signal level, then setting a 

relatively slow scan speed is advisable.  If scan speed is set too slow, acquisition time will lengthen 

unnecessarily. 

 

Note - Picking a value above the actual maximum speed of any axis will result in 

motion at the actual maximum speed and will have no detrimental effect to 

the system.   

6.5.2 Coarse Peaking 

 

Long name Level Type Value Range Documentation 

Coarse Peaking Cycles 4 Unsigned 0 to 100 
Number of cycles to complete for coarse peaking. ( 0=1 

Az only, 1 = 1Az and 1 El only ) 

Coarse Peaking 
Maximum Cycles 

4 Unsigned 0 to 100 
Maximum number of cycles to complete before Coarse 

Peaking stops. 

Coarse Peaking Mode 4 Choice 
“None”, “Cross Pattern”, 
“Step Pattern”, Plateau 

Peaking 
The peaking method to use for Coarse Peaking routines 

Coarse Peak Signal 
Difference Threshold 

4 Float 0.1 to 100 
The amount of signal difference between peaking 

iterations that will satisfy the system as the signal is 
peaked. 

 

Coarse peaking cycles sets the minimum number of cycles that will be completed in the Coarse 

Peaking process regardless of any improvement made in antenna pointing (received signal level) at 

the completion of each cycle. 

 

Coarse peaking Maximum Cycles sets the maximum number of Coarse Peaking cycles that may be 

completed before the process is terminated.  This parameter insures that the antenna does not fall 

into an “infinite do loop” attempting to satisfy the Coarse Peak Signal Dif. pass parameter that may 

have been set too low for current conditions. 

 

The Coarse Peak Signal Difference Threshold parameter establishes the success criteria for the 

cyclical Coarse Peaking process.  At the completion of each Coarse Peaking cycle, the final signal 

level value achieved in the previous cycle is subtracted from the final signal value achieved in the 

latest cycle.  If the magnitude of that difference is equal to or less than the value of this parameter, 

then the Coarse Peaking process is deemed to be complete.  Else another Coarse Peaking cycle is 

performed. 
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6.5.3 Fine Peaking 

 

Long name Level Type Value Range Documentation 

Fine Peaking Cycles 4 Unsigned 0 to 100 
Number of cycles to complete for fine peaking. (0 = 

1 az only, 1=1 az and 1 el only 

Fine Peaking Mode 4 Choice 
“None”, “CrossPattern”, 
“StepPattern”, Plateau 

Peaking 

The selection of the peaking method used for fine 
peaking routines. 

Fine Peaking Maximum 
Cycles 

4 Unsigned 1 to 100 
Maximum number of cycles to complete for fine 

peaking stops. 

Fine Peak Signal 
Difference Threshold 

4 Float 0.1 to 100.0 
The amount of signal difference between peaking 

iterations that will satisfy the system as the signal is 
peaked. 

 

 

Fine Peaking Cycles sets the minimum number of cycles that will be completed in the Fine Peaking 

process regardless of any improvement made in antenna pointing (received signal level) at the 

completion of each cycle. 

 

Fine Peaking Maximum Cycles sets the maximum number of Fine Peaking cycles that may be completed 

before the process is terminated.  This parameter insures that the antenna does not fall into an “infinite 

do loop” attempting to satisfy the Fine Peak Signal Dif. pass parameter that may have been set too low 

for current conditions. 

 

The Fine Peak Signal Difference Threshold parameter establishes the success criteria for the cyclical 

Fine Peaking process.  At the completion of each Fine Peaking cycle, the final signal level value achieved 

in the previous cycle is subtracted from the final signal value achieved in the latest cycle.  If the 

magnitude of that difference is equal to or less than the value of this parameter, then the Fine Peaking 

process is deemed to be complete.  Else another Fine Peaking cycle is performed. 

 
 

6.5.4 Cross Pattern - Coarse Peaking 

 

Long name Level Type Value Range Documentation 

Cross Pattern Coarse Peaking Width 4 Float 0.0 to 60.0 
Width in degrees to scan during a coarse cross 

pattern peaking function. 

Cross Pattern Coarse Peaking Height 4 Float 0.0 to 60.0 
Height in degrees to scan during a coarse cross 

pattern peaking function. 

Cross Pattern Coarse Azimuth Velocity 4 Float 0.02 to 30.0 
Azimuth velocity in degrees/sec for coarse 

peaking. 

Cross Pattern Coarse Elevation 
Velocity 

4 Float 0.02 to 30.0 
Elevation velocity in degrees/sec for coarse 

peaking. 

Cross Pattern Coarse Signal Tolerance 1 Float 0.0 to 1000.0 
Signal degradation amount before a scan 

stops. 

Cross Pattern Fine Signal Tolerance 4 Float 0 to 1000 Signal degradation amount before a scan stops 
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Coarse Cross Peaking is the standard method used by the AAQ for Coarse Peaking on the received 

satellite signal.   
 

The Cross Pattern Coarse Peaking parameters set the total AZ width and EL height of the “cross” that 

will be scanned.  These parameters should be set sufficiently large enough to insure that Coarse Peaking 

is not performed in a side lobe of the antenna beam.  However, making them overly large will add time 

to the overall Acquisition process and increase the chance that the signal from a stronger neighboring 

satellite will be used for Coarse Peaking. 
 

The Cross Pattern Coarse Velocity parameters specify the speed that the antenna will move in each 

direction during the signal level measurement scans.  As was true for the Scan Velocity parameters, the 

possibly sluggish response time of the Signal Source and the desire for short Acquisition times must be 

considered. 
 

Cross Pattern Coarse Signal Tolerance sets a tolerance on acceptable signal drop between coarse 

peaking cycles. This is also used to set plateau levels when using Plateau Peaking. 
  

Cross Pattern Fine  Signal Tolerance sets a tolerance on acceptable signal drop between fine peaking 

cycles. This is also used to set plateau levels when using Plateau Peaking. 
 
 

6.5.5 Cross Pattern - Fine Peaking 

 

Long name Level Type Value Range Documentation 

Cross Pattern Fine Azimuth Velocity 4 Float 0.02 - 30.0 Azimuth velocity in degrees/sec for fine peaking. 

Cross Pattern Fine Elevation Velocity 4 Float 0.02 - 30.0 
Elevation velocity in degrees/sec for fine 

peaking. 

Cross Pattern Fine Peaking Width 4 Float 0.0 - 60.0 
Width in degrees to scan during a fine cross 

pattern peaking function. 

Cross Pattern Fine Peaking Height 4 Float 0.0 - 60.0 
Height in degrees to scan during a fine cross 

pattern peaking function. 

Cross Pattern Fine Signal Tolerance 1 Float 0.0 to 1000.0 Signal degradation amount before a scan stops. 

 

“Fine Cross Peaking” is an alternate method used by the AAQ for Fine Peaking on the received 

satellite signal.  As currently designed, this option must be requested by the customer before the 

antenna leaves AvL.  

 

The Cross Pattern Fine Velocity parameters specify the speed that the antenna will move in each 

direction during the signal level measurement scans.  As was true for the Scan Velocity parameters, 

the possibly sluggish response time of the Signal Source and the desire for short Acquisition times 

must be considered. 
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The Cross Pattern Fine Peaking parameters set the total AZ width and EL height of the “cross” that 

will be scanned.  These parameters should be set sufficiently large enough to insure that the peak of 

the antenna’s Main Beam is included in the scan.  However, making them overly large will add time 

to the overall Acquisition process. 
 

Cross Pattern Fine Signal Tolerance sets a tolerance on acceptable signal drop between peaking 

cycles.  If this parameter value is exceeded, then the AAQ assumes that the satellite signal is 

experiencing a Rain Fade and the peaking process is suspended.  

 

6.5.6 Step Pattern Mode 

 

Long name Level Type Value Range Documentation 

Peaking Azimuth Travel 
Limit 

4 Float 0.1 - 100.0 (deg) 
The maximum amount of degrees that the azimuth 

axis can be moved during a single peaking cycle. 

Peak Dwell Iterations 4 Unsigned 1 - 100 
Number of peaking iterations to look for signal 

changes. 

Peaking Elevation Travel 
Limit 

4 Float 0.1 - 100.0 (deg) 
The maximum amount of degrees that the elevation 

axis can be moved during a single peaking cycle. 

 

Peaking Travel Limit parameters set a maximum limit on AZ and EL travel during the Step Peaking 

process.  This way a reasonable search area can be defined that prevents the system from peaking 

on noise for an extended period of time should a weak satellite signal be lost during the Step 

Peaking process.  When one of these limits is exceeded, Step Peaking is terminated and a message is 

displayed in the GUI.  

 

Peak Dwell Iterations defines the number of signal measurements that will be averaged to 

determine the pointing metric for that particular step and hence the dwell time at the end of each 

step.  An individual signal measurement takes 0.012 seconds (where 1 second = 50 samples).  If a 

noisy signal environment is anticipated, then this parameter should be changed. As this parameter  

is Modem Specific, a general value of between 100 to 200 is used for the RSL Signal Source. 

 

6.5.7 Step Pattern - Coarse Peaking 

 

Long name Level Type Value Range Documentation 

Step Pattern Coarse Azimuth Velocity 4 Float 0.02 to 30.0 
Azimuth velocity in degrees/sec for 

coarse peaking. 

Step Pattern Coarse Elevation Velocity 4 Float 0.02 to 30.0 
Elevation velocity in degrees/sec for 

coarse peaking. 

Step Pattern Coarse Peaking Azimuth 
Step 

4 Float 0.0 to 60.0 
Width in degrees to scan during a 

fine step pattern peaking function. 

Step Pattern Coarse Peaking Elevation 
Step 

4 Float 0.0 to 60.0 
Height in degrees to scan during a 
fine step pattern peaking function. 
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The Step Pattern Coarse Velocity parameters specify the speed at which the antenna will move 

during each step.  Higher speeds tend to make the process run quicker, at the expense of position 

accuracy.  Setting the value too high may actually slow the process down as the AAQ is forced to 

correct for frequent over-shoot of the target position. 
 

6.5.8 Step Pattern - Fine Peaking 

 

Long name Level Type Value Range Documentation 

Step Pattern Fine Peaking Azimuth 
Step 

4 Float 0.0 to 60.0 
Width in degrees to scan during a fine step pattern 

peaking function. 

Step Pattern Fine Peaking Elevation 
Step 

4 Float 0.0 to 60.0 
Height in degrees to scan during a fine step 

pattern peaking function. 

Step Pattern Fine Azimuth Velocity 4 Float 0.02 to 30.0 Azimuth velocity in degrees/sec for fine peaking. 

Step Pattern Fine Elevation Velocity 4 Float 0.02 to 30.0 Elevation velocity in degrees/sec for fine peaking. 

 

 

Fine Step Peaking is the standard method used by the AAQ for Fine Peaking on the received 

satellite signal.    
 

Step Pattern Fine Peaking Step parameters dictate the size of the steps made along each axis during 

Fine Step Peaking.  This parameter should be set consistent with the user’s tolerance for beam 

pointing error.  Smaller step sizes generally lead to smaller final pointing errors at the expense of a 

longer overall peaking time.  There is a limit to how small a step size should be used. This is based on 

the position control accuracy of the antenna system and is feed / aperture specific.   
 

The Step Pattern Fine Velocity parameters specify the speed at which the antenna will move during 

each step.  Higher speeds tend to make the process run quicker, at the expense of position accuracy 

which leads to pointing inaccuracies.  Setting the value too high may actually slow the process down 

as the AAQ is forced to correct for frequent over-shoot of the target position.  
 

6.5.9 Plateau Peaking 
 

Long name Level Type Value Range Documentation 

Plateau Peaking Coarse Azimuth 
Velocity 

4 Float 0.02 to 30.0 
Azimuth velocity in degrees/sec for 

coarse peaking. 

Plateau Peaking Coarse Elevation 
Velocity 

4 Float 0.02 to 30.0 
Elevation velocity in degrees/sec for 

coarse peaking. 

Plateau Peaking Fine Azimuth Velocity 4 Float 0.02 to 30.0 
Azimuth velocity in degrees/sec for 

fine peaking. 

Plateau Peaking Fine Elevation 
Velocity 

4 Float 0.02 to 30.0 
Elevation velocity in degrees/sec for 

fine peaking. 
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Plateau Peaking is a function used only with certain types of modem systems, where the signal 
feedback reaches a limit over the course of a scanning sequence. The differential in degrees is 
measured during this limit and a pointing “center” is calculated for the acquisition solution. 
 

6.5.10  Polarization Peaking 

 

Long name Level Type Value Range Documentation 

Peaking Polarization Travel 
Limit 

4 Float 0.1 to 100.0 (deg) 
The maximum amount of travel the pol can be 

moved during a single peaking cycle. 

Polarization Peak Coarse 
Azimuth Velocity 

4 Float 0.02 to 30.0 Azimuth velocity in degrees/sec for coarse peaking. 

Polarization Peak Coarse 
Elevation Velocity 

4 Float 0.02 to 30.0 Elevation velocity in degrees/sec for coarse peaking. 

Polarization Peak Fine 
Azimuth Velocity 

4 Float 0.02 to 30.0 Azimuth velocity in degrees/sec for fine peaking. 

Polarization Peak Fine 
Elevation Velocity 

4 Float 0.02 to 30.0 Elevation velocity in degrees/sec for fine peaking. 

Polarization Dwell Iterations 4 Unsigned 1 to 100 
Number of peaking iterations to pause for look for 

signal changes. 

Polarization Peaking Step 4 Float 0.0 to 60.0 
Width in degrees to scan during a pol peaking 

function. 

Scan Polarization Velocity 4 Float 0.01 to 60.0 (deg/sec) 
Pol scanning maximum velocity used in scanning 

movements. 

Polarization Peaking Enabled 4 Choice "No", "Yes" 
If set to “Yes”, then the pol will be peaked after fine 

peaking 

 

 

Polarization Peaking is an automated process that may be employed only on specially equipped 

and supported linearly polarized AvL antenna systems.  This new AAQ feature is currently 

implemented only on satellite systems that utilize a feedback signal metric generated by the NOC 

and provided to the AAQ via the forward satellite link and the terminal’s Modem (Hughes HX). 

 
 
 

6.5.11  Other Signal Based Parameters 

 

Long name Level Type Value Range Documentation 

Modem Based Target Allowed 4 Choice "No", "Yes" 
Allows a modem device to set the azimuth and 
elevation targets if supported by the modem. 

Skip Coarse Peak If Tx Enabled 4 Choice "No", "Yes" 
If set to yes then coarse peaking will be skipped if the 

modem transmitter is enabled. 

Modem Minimum Wait Time 4 Integer 0 - 1000 
Minimum seconds to wait for a modem signal during 

acquire. 

Modem Maximum Wait Time 4 Integer 0 - 1000 
Maximum seconds to wait for a modem signal during 

acquire. 

Line Scan Maximum Elevation 
Steps 

4 Integer 1 - 100 
Initial scan plus the number of el steps to make when 

an az scan fails. 
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Line Scan Failure Elevation Step 
Size 

4 Float 0.0 - 45.0 (deg) 
The amount of each el step to make when an az scan 

fails. 

 

 

These “Modem specific parameters” are considered common to several types of Modems and are 

included in the standard set of parameters to avoid issue with duplication in multiple Software 

Modules.  If no Modem module is present, then these parameter values have no influence on the 

behavior of the AAQ and the AvL antenna system. 

 

Modem Minimum Wait Time – During acquisition, the controller will wait this amount of seconds 

before attempting to read the modem signal level. 
 

Modem Maximum Wait Time – If the AAQ controller has acquired but modem has not acquired and 

wait time has been exceeded, the controller will then proceed to the secondary, then tertiary 

acquisition method. Should these also fail to acquire, the controller will present the user with the 

message, “Acquisition Failed, all signal sources tried”.   
 

The Line Scan parameters establish the overall height and number of lines used in the standard 

Acquisition raster scan.  Elevation Step Size should be set as large as possible, while at the same time 

insuring that a satellite located midway in between the lines is easily detected.  The number of Max 

Elevation Steps should be selected to set a reasonable overall height for the raster scan. Typical number 

of 3 is used for default. 
 

 

 

6.6 Feed Based Parameters 

 

Long name Level Type Value Range Documentation 

Polarization Feed Type 4 Choice "XPOL", "COPOL" Specifies the type of feed the pol used (XPOL/COPOL). 

Manual Polarization 1 Choice "No", "Yes" 
Flag indicating whether the pol should be set manually 

during the acquire sequence. 

Polarization RF Offset 4 Float -10 to 10 
Offset in degrees, added to Pol angular value to correct for 

mechanical error 

Elevation Inc Offset 4 Float -180 to 180 Offset in degrees to add to the elevation inclinometer. 

Polarization Pot Offset 4 Float -360.0 to 360.0 The offset added to the converted A/D value 

Polarization Pot Scale 
Factor 

4 Float 
- 100000.0 to 

100000.0 

Value to divide the raw A/D value by to produce a sensor 
value. The formula for producing a final value is ((raw 

number*10000)/ scale factor) 

Line Scan Polarization 
Adjust Flag 

4 Choice "No", "Yes" 
This flag indicates that the Pol should be adjusted during a 

line scan. Usually set to Yes. 

Polarization Motor Abs Enc 
Offset 

4 Float -600 to 600 
The offset in degrees to be added to the read position of 

the absolute encoder 

Polarization Motor Abs 
Scale Factor 

4 Float -10000 to 10000 
The scale factor that will be multiplied to the raw encoder 

or resolver value 

Polarization Motor Scale 
Factor 

4 Integer -10000 to 10000 Scale factor to divide by to produce the actual value 
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Polarization Stow Position 4 Float -180 to 180 The position in degrees of the pol for the stow routine 

Polarization Position Move 
Max PWM 

4 Integer 0 to 1000 
Maximum PWM power used in a position move for pol 

when no encoders are present 

Polarization Position Move 
Min PWM 

4 Integer 0 to 1000 
Minimum PWM power used in a position move for pol 

when no encoders are present 

Polarization Pos Move 
PWM Factor 

4 Integer 1 to 1000 
Pol proportional multiplier to produce a PWM value when 

no encoders are present. 

User Polarization CCW Limit 4 Float -180.0 to 0.0 The maximum pol position for counter clockwise travel 

User Polarization CW Limit 4 Float 0.0 to 180.0 The maximum pol position for clockwise travel 

Polarization Center Switch 
Is Interlock 

4 Choice “No”, “Yes” 
Flag indicating the digital input as an interlock (blocks other 

operations when set) 

Polarization Motor Abs Enc 
Scale Factor 

4 Float -999999 to 999999 
The scale factor that will be multiplied to the raw absolute 

encoder or resolver value 

Polarization RF Offset 4 Float -10 to 10 
The pol correction can be added to the calculated pol 

position during the targeting sequence 

 

Many AvL antennas are multiple frequency band capable and employ an interchangeable feed 

design.  This allows the antenna to be easily reconfigured in the field from one polarization and 

frequency band to another.  These two parameters allow the AAQ to operate correctly given these 

multiple feed configurations. 
 

When expressing the polarization of the antenna, AvL employs a received satellite signal convention.  

When the polarization of a standard cross-polarized linear Ku-band antenna is designated 

“Horizontal”, this means the Receive signal polarization vector is Horizontal and the Transmit signal 

polarization vector is Vertical.  On those rare occasions when the antenna’s linearly polarized feed is 

co-polarized (Transmit and Receive signals share the same linear polarization), there is the potential 

for polarization mislabeling by the AAQ GUI.  A proper setting of Pol Feed Type prevents that from 

happening. 
 

 Most of AvL’s linearly polarized feeds include an automatic polarization adjustment feature, but not 

all.  All of AvL’s circularly polarized feeds employ a quick and easy Manual Pol change feature.  When 

this flag is set and the AAQ detects that it is being configured for a change in the polarization value, 

the operator of the antenna will be prompted to perform a manual change of polarization by the 

GUI.  The AAQ will not proceed past this step until the operator acknowledges that the change has 

been completed. 
 

Polarization RF Offset - Because of variations in manufacturing tolerance, it occasionally becomes 

necessary to add a small angular value to correct for mechanical error in Polarization. This should 

not be adjusted unless the feed has been replaced or repaired. (includes Abs Encoder Offset) 

Polarization Motor Scale Factor - Because of variations in manufacturing tolerance, it occasionally 

becomes necessary to change the scale factor to correct for mechanical error in Polarization. This 

should not be adjusted unless the feed has been replaced or repaired. (includes Abs Encoder Scale 

Factor) 
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Polarization Pos Move Min PWM and Pol Pos Move PWM Factor are factory settings where access 

is reserved for field service requirements. Consult AvL technical staff before making changes. 

“User” level limits are specifically designed for the user or integrator so that custom limits can be 

created without disabling safety limits built into the system. 

 
 

6.7 Sensor Override 
 

In the unlikely event that the on-board navigation or tilt sensors in the AvL antenna system become 

unreliable, the operator may override them with values manually entered into the control system 

through the AAQRemote GUI.  The configuration parameters that hold the manually entered values and 

the flags that trigger their use are detailed in the following sections. 

 

6.7.1 Compass 

 

Long name Level Type Value Range Documentation 

Magnetic Manual Compass 1 Choice "No", "Yes" 
Flag indicating that the manually entered compass 

heading is magnetic rather than a true heading. 

Heading for Manual Compass 1 Float 0.0 - 360.0 
Heading in degrees to use as the frame heading if 

override compass is selected. 

Declination Override 4 Choice "No", "Yes" 
Flag indicating that the compass declination should 

be ignored. 

 

 

6.7.2 GPS 

 

Long name Level Type Value Range Documentation 

Manual Latitude 1 String - 
The latitude of the antenna to use if manual override for the 

GPS is selected in decimal degrees and direction (ie: 109.2 N). 

Manual Longitude 1 String - 
The longitude of the antennae to use if manual override for 

the GPS is selected in decimal degrees and hemisphere 
 (ie: 99.2 E). 

 

 

6.7.3 Tilt 

 

Long name Level Type Value Range Documentation 

Manual Pitch 4 Float -180 - 180 
Manually entered pitch angle in degrees used in tilt 

override. 
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Manual Roll 4 Float -180 - 180 
Manually entered roll angle in degrees used in tilt 

override. 

Use Manual Tilt 4 Choice "No", "Yes" Flag indicating whether manual tilt values are used. 

 

 

 

6.8 System Options 
 

The following section addresses specific equipment and optionally installed AvL modules. Any changes to 

parameters on systems where options are not installed will have no effect on operation. 
 

6.8.1 NMEA Server 

 

Long name Level Type Category Value Range Documentation 

NMEA Server Enable  4 Choice Core "No", "Yes" Enables or disables the NMEA Server on the controller. 

NMEA Echo Input Com Port 4 String Core - 
The computer device filename for the communications port 

used. 

NMEA Server Com Port 4 String Core - 
Com port name (blank for IP address) to use for NMEA 

server on the controller. 

NMEA Server Enable 4 Choice Core "No", "Yes" Enables or disables the NMEA server on the controller 

NMEA Server Interval 1 Integer Core 0 to 65536 NMEA server broadcast interval in seconds 

NMEA Server Message Source 4 Choice Core 
“Controller”, 

“Echoed” 

The source of the NMEA messages sent to the configured 
port. “Echoed” indicates a message echoed from a GPS 

device 

NMEA Server Com Port 
Settings 

4 String Core - 
Com port setting or TCP-IP port number to use for NMEA 

server on the controller 

 

6.8.2 Slide Motor Feed System 

Note – Many of these options are found under the “Core” tab. 

 

Long name Level Type Category Value Range Documentation 

SlideMotor Abs Enc Offset 
4 Float Sensor 

-600.0 to 
600.0 

The offset in degrees to be added to the read position of 
the absolute encoder. 

SlideMotor Abs Enc Scale 
Factor 

4 Float Sensor 
-10000.0 to 
10000.0 

The scale factor that will be multiplied to the raw absolute 
encoder or resolver value. 

Slide Motor Enable 
4 Choice 

Feed 
“No”, “Yes” Slide Position Enable (No = slide is disabled) 

Slide Motor Stow Position 
4 Choice Positioner 

“None”, “1”, 
“2”, “3” 

Slide position to move to before a stow completes 

SlideMotor Scale Factor 
4 Float Sensor 

-10000.0 to 
10000.0 

The scale factor to divide by to produce the actual value. 

SlideMotor Switch 1 (through 
3) is Interlock 

4 Choice 
Sensor 

“No”, “Yes” 
Flag indicating the digital input as an interlock (blocks other 

operations when set 
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Slide Position 1 
4 Float 

Modules -100.0 to 
100.0 

Numeric slide position representing the left slide position 

Slide Position 2 
4 Float 

Modules -100.0 to 
100.0 

Numeric slide position representing the center slide 
position 

Slide Position 3 
4 Float 

Modules -100.0 to 
100.0 

Numeric slide position representing the right slide position 

6.8.3 Vector Compass 

 

Long name Level Type Category Value Range Documentation 

Vector Compass Enable 1 Integer 
Core, 

Sensor 
0 or 1 

Flag indicating that the compass should be used and 
powered (1 = powered) 

Vector Compass Heading 
Offset 

4 Float System 
-180.0 to 

180.0 
The offset in degrees of the device 

Vector Compass Com Port 4 String System - The filename for the com port used 

Vector Compass Com Port 
Settings 

4 Choice System “No”, “Yes” 
The computer settings for the com port, in the form of Baud, 
Data, Stop & Parity Bits (ie: 9600 8 1 0) where parity values 

are 0 for none and 1 for even. 

Vector Compass Reset 1 Integer 
Sensors 

0 or 1 
Flag indicating that the compass should be reset. ( 1 = reset 

now) 

Vector Compass Scan Width 1 Float Modules 0.0 to 400.0 Scan width used during a SatTant or 0.0 to disable SatTant 

Vector Compass Separation 4 Float Modules 
0.0001 to 

10.0 
Separation parameter used to initialize the vector compass 

 
Vector Compass parameters are included to configure and manage the optional high-precision 

Vector Compass offered on some AvL antenna systems.  The Enable parameter is persistent and 

when set insures that the Vector Compass is always powered on and available to the system.  When 

set and Saved, the Reset parameter causes the Vector Compass to be re-initialized.  The parameter 

clears automatically (to value = 0) after a successful reset. 

 

6.8.4 Wing System 

 

Long name Level Type Category Value Range Documentation 

Wing Elevation Safety Switch is 
interlock 

4 Choice Sensor “No”, “Yes” 
Flag indicating the digital input as an interlock (blocks other 

operations when set 

Wing Left Stow Switch is 
Interlock 

4 Choice 
Sensor 

“No”, “Yes” 
Flag indicating the digital input as an interlock (blocks other 

operations when set 

Wing Motor Abs Enc Offset 
4 Float Sensor 

-600.0 to 
600.0 

The offset in degrees to be added to the absolute encoder 

Wing Motor Abs Enc Scale 
Factor 

4 Float Sensor 
-10000.0 to 

10000.0 
The scale factor that will be multiplied to the raw absolute 

encoder or resolver value 

Wing Motor Scale Factor 
4 Integer 

Sensor -10000.0 to 
10000.0 

The scale factor to divide by to produce the actual value 

Wing Right Deploy Switch is 
Interlock 

4 Choice 
Sensor 

“No”, “Yes” 
Flag indicating the digital input as an interlock (blocks other 

operations when set 

Wing Right Stow Switch is 
Interlock 

4 Choice 
Sensor 

“No”, “Yes” 
Flag indicating the digital input as an interlock (blocks other 

operations when set 
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Chapter 7 - Theory of Operation 

7.1  Introduction 
 

AvL antenna systems combine the AvL Cable Drive positioning system with a completely automatic 

satellite acquisition Antenna Control Unit (ACU) to provide ease of operation without needing a satellite 

technician and the ultimate in reliability under even the most demanding environmental conditions.  

 

Our latest line of antenna systems features our AAQ ACU.  The AAQ ACU is a robust system offering a 

variety of software control functions, high speed sensors, and High-Level integration between hardware 

and software. This new system is designed for complete integration into new or existing AvL antenna 

systems. 

 

Key Features of the AvL Cable Drive system: 

 

 Utilizes highly reliable aircraft control cables in a redundant configuration to achieve zero 

backlash 

 Light-weight, very stiff drive system, suitable for high stability requirements such as Ka Band 

 Method used to wrap the capstan results in a minimum free length of cable 

 The load in the cable on the main drum is exponentially reduced as it is wrapped around the 

drum, minimizing elongation of the cable under load  

 The AvL cable drive system results in stiffness of up to 10 times that of comparable gear or 

harmonic drive systems.  

 The cables are pre-tensioned and spring loaded at the main drum attachment point which 

eliminates backlash at installation and backlash from any cable stretch in the future 

 

Key features of the AAQ ACU: 

 

 Supports multiple users with unique passwords and levels of access  

 Provides an extensive set of configuration items  

 All internal measurement and status variables are accessible 

 Capability to remotely log any system variables 

 Has the ability to run multiple levels of calibration  

 Allows remote  software upgrading and system diagnostics  

 Allows remote and local setting of basic runtime acquisition parameters  

 Allows remote and local execution of various position commands  

 Provides the ability to monitor system logs and status in real time  

 Supports SNMP communication protocol  
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The ACU is designed to handle all of the antenna operations in a standalone fashion – no external M&C 

connection is required.  It also permits all configuring, operating and monitoring functions remotely 

through various methods to externally connected computers and other devices.  While the system is 

designed to operate in a standalone fashion, all of the operational aspects can also be performed 

remotely by a connected device or computer. 
 

7.1.1  Auto-Point Antenna Basics 
 

All AvL transportable satellite antennas employ a parabolic main reflector with a single feed 

providing optimal RF illumination.  The vast majority of our designs are front-fed full offset parabolic 

reflector antennas that provide exceptional antenna gain efficiency and very low side-lobe radiation 

characteristics.  These antennas produce a very narrow “pencil shaped” beam that must be 

accurately pointed at a geostationary communications satellite located at a great distance (over 

22,000 miles away).  Antenna pointing is achieved by an elevation-over-azimuth positioner, or 

pedestal, that employs high-stiffness, low-backlash cable drive technology.  For operation with 

linearly polarized satellite communication signals, an additional polarization positioner is included 

that typically rotates only the feed assembly. 
 

All three of the axes are motorized and equipped with position feedback sensors that quantify 

positioner / antenna pointing in the pedestal coordinate system.  Additional sensors on the antenna 

system such as GPS, magnetic compass and tilt sensors provide critical information that determines 

the antenna pedestal’s location and orientation relative to the Earth and its geosynchronous 

communication satellites.  This motorized system and all of its sensors are managed by an ACU 

function that is completely hosted on the antenna system. 
 

When properly equipped, deployed and operated, the antenna system is capable of automatically 

locating and acquiring the downlink signal of any visible geosynchronous communications satellite 

within its range of motion based solely on the satellite’s longitude. 
 

7.2 Antenna Drive System 
 

The Drive systems for Azimuth, Elevation and Polarization along with their respective sensor 

components are described below. 

7.2.1 Azimuth Cable Drive 
 

The AvL cable drive system produces a drive system with zero backlash, high stiffness, no wear, no 

lubrication, and maximum reliability. The system consists of stainless steel aircraft control cables 

reverse wrapped twice around the grooved capstan, and once around the drum, with solid 

connections on one end and high force Belleville springs on the other end. The additional cables are 
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used to provide increased stiffness and drive redundancy. The Azimuth drive components are 

described in this section. 

 

Figure 7.2.1a - Azimuth Capstan 
 

If a cable becomes damaged during usage, remove the cable and continue to use the positioner. The 

positioner is designed to operate using a single cable if necessary. When time permits the damaged 

cable should be repaired by an authorized service facility. 

The cables are sized to last the life of the positioner. No replacement from wear is expected. The 

spring packages at one end will automatically compensate for any elongation of the cables. Cable 

position and stiffness should be checked as per a periodic maintenance schedule.  

 

 

 

 

 

 

              

Azimuth Capstan 

Azimuth Cable Anchors 
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                                              Figure 7.2.1b - Az Cable Drive Assy. 

 

7.2.1.1  Azimuth Gear Box 

 

The azimuth gearbox is a low backlash worm gear type. The worm gear drive isolates any backlash in the 

motor drive from the system. In addition, the gear box eliminates back-drive, eliminating any need for a 

brake on the drive train. 

 

The motor drives the input worm via a quill/female hole and square key. The worm shaft is extended 

with a hex shape installed for the hand crank. The hand crank is utilized to manually manipulate the 

positioner in the event the controller fails. The azimuth capstan is secured to the output shaft to 

eliminate any backlash between the capstan and gearbox.  

 

The low backlash is achieved by the selective fit of the worm and worm gear. The gearbox contains 

synthetic grease to help prevent wear in the gears. Because of the design capacity of the gearbox and 

low rpm, no maintenance is required. 

 

 

7.2.1.2  Azimuth Position Feedback 

 

The directional sense of azimuth movement is defined as clockwise (CW) or counter-clockwise 

(CCW), as viewed by an observer located above the antenna (aerial view or “bird’s eye”).  

 
 

7.2.1.3  Azimuth Potentiometer (POT) 

 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 144 of 200 
 

The azimuth position feedback is produced in part, by a potentiometer. The pot acts as an adjustable 

voltage divider using a three-terminal resistor with a sliding contact. The pot is driven by the output 

shaft of the worm gear box. Since the AvL cable drive has no backlash, the position feedback is as 

accurate as the resolution and accuracy of the potentiometer along with its gear drive interface. The 

potentiometer is mechanically centered at the travel position when the Az platform is in the Az stow 

position or its physical center position. Limits are controlled by using inputs from the potentiometer and 

optical encoder together and are set in, and controlled by, the AAQ controller. 

 

  

Figure 7.2.1.3 – Az. Potentiometer Examples 

 

7.2.1.4  Motor Shaft Encoders 

 

The shaft encoder mounts to the output shaft of the motor, providing a more precise feedback on 

Azimuth position. The controller uses the output of the azimuth encoder to determine the range of 

motion from axis point A to point B.  The information is then processed by the AAQ and displayed as 

distance and angular position. 

Without gear drive 

With gear drive 

http://en.wikipedia.org/wiki/Voltage_divider
http://en.wikipedia.org/wiki/Terminal_%28electronics%29
http://en.wikipedia.org/wiki/Resistor
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Figure 7.2.1.4 – Motor Encoder 

7.2.1.5  Azimuth Resolver (optional) 

 
The on axis resolver may be used for more precise motion control. Resolvers are generally used for the 

elevation and azimuth axis. The resolver is an on-axis sensor and is generally located on the pivot points 

of the unit to provide highly accurate angular data. This sensor is primarily used in precision movements 

such as peaking.  

 
 

Figure 7.2.1.5 – Azimuth Resolver 

7.2.1.6  Azimuth Stow switch 
 

The controller uses the Az. potentiometer voltage to determine limits. Therefore, the AvL positioner is 
equipped with only an azimuth stow position switch to determine the stow position. The azimuth stow 
switch should trigger magnetically at the azimuth physical zero position.  
 

The azimuth stow switch is mounted on the azimuth platform and is accessible under the Az/El cover. 
The switch is fixed relative to the mounting surface and is actuated by a permanent magnet located on 
the azimuth bearing drum. 
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The logic of “Stowing” and “Acquire” requires that all axes be centered to physical zero for the antenna 
to complete its cycles. 
 

 
 

Figure 7.2.1.6 – Azimuth Stow Switch 
 
 

7.2.1.7  Notes on Azimuth Settings 

 

- The limits should be set after the potentiometer has been centered. Anytime the potentiometer 
is moved or repositioned, the limits should be reset. 

 

- The Az angle displayed by the ACU is affected by several parameters in the ACU. (These include 
Az Scale Factor, Az Reference Position, etc.). 

 

- While setting the limits, watch the Az capstan to make sure it does not run to the physical end of 
the cables. This could result in one or more of the cables breaking.  

 

- After integration (external equipment, location, etc.), limits should be checked and set for safe 
travel.   

 

7.2.2 Elevation Positioning 

 
The elevation cable drive produces a drive system with zero backlash, high stiffness, no wear, no 

lubrication, and maximum reliability. The system consists of stainless steel aircraft control cables 

reverse wrapped twice around the grooved capstan, and once around the drum, with solid 

connections on one end and high force Belleville springs on the other end. The additional cables are 

used to provide increased stiffness and drive redundancy.  

 

Magnet on Az base plate 

moves across sensor end Typical as installed 
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If a cable becomes damaged during usage, remove the cable and continue to use the positioner. The 

positioner is design to operate using a single cable if necessary. When time permits the damaged 

cable should be repaired by an authorized service facility. 

 

The cables are sized to last the life of the positioner. No replacement from wear is expected. The 

spring packages at one end will automatically compensate for any elongation of the cables. Cable 

position and stiffness should be checked as per a periodic maintenance schedule. The Elevation 

drive components are described in this section. 

 

7.2.2.1  Elevation Pivot Assembly 

 

The elevation pivot assembly consists of two elevation drum assemblies pivoting between two clevis 

blade assemblies. The drum shafts pivot in hi-tech plastic (Delrin) bushings.  

 

 

7.2.2.2  Elevation Gear Box 

 
The elevation gearbox is a low backlash worm gear box. The worm gear drive isolates any backlash 

in the motor drive from the system. In addition, the gear box eliminates back-drive, eliminating any 

need for a brake on the drive train. 

 

The motor drives the input worm via a quill/female hole and square key. The worm shaft is 

extended with a hex shape installed for the hand crank. The hand crank is utilized to manually 

manipulate the positioner in the event the controller fails. The elevation capstan is secured to the 

output shaft with a clam shell coupling to eliminate any backlash between the capstan and gearbox.  

 

The low backlash is achieved by the selective fit of the worm and worm gear. The gearbox contains 

synthetic grease to help prevent wear in the gears. Because of the design capacity of the gearbox 

and low rpm, no maintenance is required. 

 

7.2.2.4  Elevation Motor 

 

The elevation drive motor is typically a DC motor with an optical encoder mounted to the motor 

output shaft, to provide real time positional information to ACU.  
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Figure 7.2.2.4 - Elevation Gear Box and Motor 
 

 

 

Since the low backlash worm gear drive isolates the backlash from the motor, any backlash between 

the shaft adapter, coupler, or motor gear train will not be seen by the reflector bore sight. The 

motor is mounted to an adapter plate that is bolted to gearbox. No maintenance of the elevation 

motor is required. 

 
 

7.2.2.5  Elevation Cable Drive 

 

The elevation cable drive system provides zero backlash, high stiffness, no wear, no lubrication, and 

maximum reliability. The system consists of stainless steel aircraft control cables reverse wrapped 

twice around the grooved capstan, and once around the drum, with solid connections on one end 

and high force Belleville springs on the other end. The additional cables are used to provide 

increased stiffness and drive redundancy.  

 

If a cable becomes damaged during usage, remove the cable and continue to use the positioner. The 

positioner is designed to operate using a single cable if necessary. When time permits the damaged 

cable should be repaired by an authorized service facility. 

 

Elevation Gear Box 

Elevation Motor 

Elevation Clam Shell 
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The cables are sized to last the life of the positioner. No replacement from wear is expected. The 

spring packages at one end will automatically compensate for any elongation of the cables. Cable 

position and stiffness should be checked as per a periodic maintenance schedule.  

 
 

7.2.2.6  Elevation Position Feedback (inclinometer) 

 

The elevation position feedback is typically produced by an electronic inclinometer within the AvL 

NAV RIOM (see 7.4.1.1). The NAV RIOM will most likely be located at the top of the reflector while 

the optional EL RIOM will generally be located in either elevation arm.   

 

7.2.2.7  Motor Shaft Encoders  

 

The shaft encoder mounts to the output shaft of the motor, providing a more precise feedback on 

Elevation position. The controller uses the output of the elevation encoder to determine the range 

of motion from axis point A to point B.  The information is then processed by the AAQ and displayed 

as distance and angular position. 

 
Figure 7.2.2.7 – Shaft Encoder Examples 

 

7.2.2.8  Elevation Resolver (optional) 

 
The on axis resolver may be used for more precise motion control. Resolvers are generally used for 

the elevation and azimuth axis. The resolver is an on-axis sensor and is generally located on the 

pivot points of the unit to provide highly accurate angular data. This sensor is primarily used in 

precision movements such as peaking.  

Typical as installed 
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Figure 7.2.2.8 – Elevation Resolver 
 

7.2.2.9  Elevation Limit Switches 

 

The elevation limit or stow switch is actuated by a cam on the “elevation capstan” or the on “axis 

pivot drum”.  The location of the switch(s) will vary depending on model. 

 

The elevation Up and Down switches can also be actuated by a cam on the elevation capstan or the 

on axis pivot drum.  The location of the switches will vary depending on model. 

 

Elevation physical switches are generally used in conjunction with the soft (software created) 

switches. These are predetermined by the controller and may not always be present depending on 

model. 

 

 
 

Figure 7.2.2.9a – Elevation Limit (or Stow) Switch 
 

 

Typical as installed 
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Figure 7.2.2.9b - Elevation Stow Switch 

 
 

 

7.2.3 Feed and Polarization Positioning 

 

Polarization movement is defined, in the directional sense as CW or CCW, as seen by an observer 

standing behind the reflector looking at the satellite.  

 

Feed assemblies consist of a feed boom, a feed, RF components, feed sensing bits (optional) and a 

polarization drive assembly. Some models have a pivot connection at the end of the feed and use 

Delrin bushings and shoulder bolts as pivot fasteners. Position feedback is generated with similar 

sensors as used on the Az and El axis. 

 

7.2.3.1  Polarization Drive 

 

The feed/polarization drive can found underneath the pol mounting plate. The actual arrangement 

is model dependent.  The worm gear on the feed horn extends through a slot and mates with the 

drive worm gear.  The polarization drive gear is adjusted to allow minimal backlash to the worm gear 

mounted on the feed horn.  The polarization drive motor is a DC type with shaft encoder.  A hex 

adaptor on the worm shaft provides manual polarization of the feed assembly using the hand crank 

in the case of a drive failure. 

 

Elevation Stow Switch 

Elevation Capstan 

Elevation Cam 

Typical as installed 
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Figure 7.2.3.1 - Feed and Polarization Drive 
 

Since the low backlash worm gear drive isolates the feed from the motor, no brake is required. No 

maintenance of the polarization motor/assembly is required.  

7.2.3.2  Potentiometer (POT) 
 

The polarization position feedback is typically produced by a potentiometer. The pot is an adjustable 

voltage divider using a three-terminal resistor with a sliding contact. The pot is driven by the output 

shaft of the worm gear drive. The potentiometer is sealed and rated for IP 65 environment - wind, 

rain, dust, etc. The potentiometer is mechanically centered at the travel position when the Pol 

platform is in the physical center position. Limits are controlled by using inputs from the 

potentiometer and / or encoder together and are set in, and controlled by, the AAQ controller. 
  

 
 

Figure 7.2.3.2 – Pol Potentiometer 
 

BUC 

Hex Adaptor 

Pol Drive 

LNB 

Ortho Mode 

Transducer 

Feed Horn 

Typical as installed 

http://en.wikipedia.org/wiki/Voltage_divider
http://en.wikipedia.org/wiki/Terminal_%28electronics%29
http://en.wikipedia.org/wiki/Resistor
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7.2.3.3  Polarization Encoder 
 

The Polarization encoder, when installed, is mounted to the output shaft of the motor providing a 

more precise feedback on Pol position. The controller uses the output of the encoder to determine 

the range of motion from axis point A to point B.  The information is then processed by the AAQ and 

displayed as angular position. 

 
 

Figure 7.2.3.3 – Pol Motor Encoder 

7.2.3.4  Polarization Limits 
 

The controller uses the polarization potentiometer voltage and motor encoders to determine limits. 

Most units have the mechanical capability of +/- 95 degrees.  
 

7.2.3.5  Feed Assembly 
 

The feed assembly consists of the feed, the polarization drive and position sensors. The feed is 

mechanically accurate to within 1/8” of the theoretical focal point of the reflector. This assures the 

RF System functions In Accordance With FCC compliance as stated in the specifications.  
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Figure 7.2.3.5 – Antenna Test Receive Pattern Example 
 

7.2.3.6  Feed Bits (Band Sensing) 

 
The AAQ is capable of multiband operation. When using a multi-feed system, the feed bits are 

utilized in recognizing the feed selected. Generally the feed connection is located on the 

interchangeable feed platform.  

 

 

7.3 AAQ Controller System Detailed Description 
 

AvL produces a wide variety of transportable antenna products with a vast array of capabilities tailored 

for different customers and market segments.  Aperture sizes range from a fraction of a meter up to 

many meters.  Operating frequencies range from L-band (1.5 GHz) up to Ka-band (30 GHz).  The AAQ 

antenna controller must be able to interface with a wide variety of equipment for position sensing and 

signal monitoring purposes.  It must also be able to perform a large number of specialized functions in 

addition to performing the standard Acquire and Stow commands.  Historically, the ACU in our antennas 

required many different current versions of antenna control software running on a single hardware 

platform with all the work being done by a single processor.  As a result, the flexibility and scalability of 

the critical ACU function in our antennas was limited.   

Null 

Main 

Beam  

Side Lobe 
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The AAQ ACU employs a superior approach.  Unlike our legacy systems, the AAQ software is not 

monolithic, instead is modular and parametric by design.  

 

7.3.1 Modular / Parametric Software 

 

 AAQ software is segregated into a single ROM (Read Only Memory) code, several PIC 

(Programmable Integrated Circuit) codes and many device modules.  The ROM code is common to 

every antenna system and is responsible for the basic control and communication functions 

necessary for any of our auto-point antenna systems.  It runs on a state-of-the-art ARM ( Advanced 

RISC Machine )processor where RISC stands for (Reduced Instruction Set Computer), with ample 

memory available for program execution and storage.  The PIC code runs on distributed processors 

that are tasked with critical, lower-level processes such as positioner axis motion control and sensor 

suite control & digital Input /Output.  Many of the software modules add enhanced capabilities to 

the AAQ ACU such as Step Track and Inclined Orbit Satellite Acquisition.  Other modules act as 

software “drivers” that open interfaces to AvL optional and customer provided equipment such as 

modems, beacon receivers, and spectrum analyzers.  This modular software architecture provides 

the ultimate in flexibility and responsiveness while minimizing the risk associated with the inevitable 

software changes typical of a continuously evolving / improving product by isolating new software 

and code changes at the module level.   

 

An extensive set of user defined configuration parameters are used to enable one version of AAQ 

software to function as expected across a wide range of antenna hardware platforms.  Through 

these parameter settings, the controller is made aware of the sensors that are present on a system 

and the role that each of them plays in providing critical information and feedback to the antenna 

control process.  Control loops are properly managed and the appropriate software module 

connections made.   

 

 

These configuration parameters also play a critical role, determining precisely how higher level 

functions like acquisition and tracking behave and how they may be optimized for a particular 

satellite and frequency band.  The parametric aspect of our AAQ software design provides the 

flexibility necessary to optimally control any AvL antenna model and tailor its behavior to best meet 

the needs of a particular application or even an individual satellite. 

 

7.3.2 Operator Access Levels 

 

The operator of an AvL antenna system equipped with the AAQ ACU will interface with the 

controller through a Graphical User Interface (GUI) or the Red & Green (stow & deploy) buttons 

located on the antenna positioner cover.  There are several GUI options that the operator might use, 
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including the PC-based AAQRemote .Net application, AAQ Webserver (see Appendix A), AAQ 

Controller Interface Panel (CIP) on the 1RU power supply (see Appendix B), AAQ Hand-Held 

Controller, and customer furnished custom GUIs.  All AvL GUIs offer the operator an opportunity to 

log-in with a username and password that is associated with an access level. 

 

The AAQ employs four (4) access levels based on a user’s log-in credentials.  The operator’s access 

to all AAQ functions and configuration parameters is dictated by the level associated with their log 

in username and password.  Those privilege levels are: 

 Level 9 – AvL Engineering 

 Level 7 – AvL Production and Service 

 Level 4 – AvL Customer (System Integrator) 

 Level 1 – End-User of the Antenna System 

 

Every system leaves the AvL factory configured with default user log-in credentials for AvL internal 

and customer use.  AvL’s immediate customer is provided with a single Level 4 (Integrator) user 

account.  With this account, our customer can create any number of Level 4 and Level 1 user 

accounts for their engineering, production, and service personnel; as well as the end-user of the 

satellite antenna system / terminal. 

 

The AvL antenna system may be operated without logging in through any GUI.  Under these 

circumstances, the operator is afforded access to only the basic commands and a pre-defined list of 

target satellites.  He is able to view status variables and parameters, but unable to modify any 

configuration parameters. 

 

The lowest privilege level (Level 1) is typically assigned to a knowledgeable terminal operator or 

end-user.  At this level, the operator is allowed access to a limited set of functions that allow him to 

select from or modify a pre-defined list of satellites, execute all available commands, view antenna 

system status variables, and modify a small set of AAQ configuration parameters. 

 

At Level 4, the satellite terminal integrator has access to all of the features and functions necessary 

to configure service and maintain the AvL AAQ antenna system.  

 

 

Note - Privilege Levels 7 and 9 are reserved for AvL Service, Production and 

Engineering purposes, only.  AAQ functions and configuration parameters 

restricted to these levels are only needed when the system is being assembled 

and or serviced in the factory or serviced by AvL personnel in the field. 
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7.3.3  AAQ Configuration Items 

 

As mentioned previously, the AAQ ACU makes extensive use of user settable configuration 

parameters.  These many parameters are segregated into three categories; hardware, calibration, 

and operation.  Hardware configuration parameters are determined by the design of the antenna  

system and are common to all antennas with the same AvL master part number.  Calibration 

parameters are unique to each antenna and are used to compensate for small variations seen from 

part to part and the inevitable assembly tolerances present in any complex antenna assembly.  

Those configuration parameters that do not fall into the previous two categories are generally useful 

in fine tuning the electromechanical operation and behavior of the antenna system. 

 

7.3.3.1   Hardware Parameters 

 

Hardware parameters specify the types of motors, gear ratios, and sensors present on the antenna 

system.  There is one motor per positioner axis, usually three in all.  There are a large number of 

sensors on each system that include those used to determine antenna geographic location and base 

heading, axis position feedback and satellite signal level received.  These parameters also provide 

critical details about how the controller establishes communication with each of these devices (IP 

addresses, serial interface parameters, etc.).  In summary, these parameters define the control 

system for the AAQ ACU and they are set at the factory via a Master Configuration File that is 

specific to the antenna’s Master Part Number.  These parameters can only be accessed at the 

highest privilege level and are not subject to change after the antenna system leaves AvL. 

 
 

7.3.3.2   Calibration Parameters 

 

Calibration parameters apply primarily to the sensors present on the antenna system.  They typically 

take the form of scale factors and offsets that translate sensor readings into values that the AAQ 

ROM code can use.  For example, a potentiometer voltage level reading is translated into an 

accurate estimate of Pedestal Azimuth angle by these parameters.  All of these parameters are 

determined during the manufacture of the antenna system and verified during final system test.   

 

 

Many of the sensors in the antenna system are either a Line Replaceable Unit (LRU) or part of one.  

By definition, an LRU is a customer serviceable item.  For that reason, most of these parameters are 

changeable at the AvL customer’s Level 4 privilege level. 
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7.3.3.3   Operation Parameters 

 

Critical aspects of the antenna’s operation are controlled by an extensive set of user settable 

parameters.  These parameters set things like antenna azimuth axis scan speed, the satellite signal 

level sensor/device used for acquisition purposes, and the fine peaking method.  AvL sets all of these 

parameters to default values in the factory based on information and Customer Furnished 

Equipment provided by our system integrator customer.  Acceptable performance of every antenna 

system is verified to the extent possible before that system leaves our factory.   

 

Most of these parameters are accessible at lower log-in privilege levels to provide the system 

integrator and the knowledgeable end user the ability to fine-tune the performance of the AvL 

antenna system for their specific application, satellite, frequency band, and even terminal location.  

This is a very powerful feature of the AvL AAQ design and should be exercised with some care and 

due diligence.  Advice on how to set these parameters and their effect on antenna performance is 

included in Chapters 5 & 6 of this manual. 

 

7.3.4  Antenna System Calibration 

 

Every antenna must be accurately calibrated to insure safe, reliable acquisition, and tracking of the 

desired communications satellite.  Almost every sensor has critical characteristics that will vary unit 

to unit.  The orientation and placement of these sensors will vary within a range of tolerances 

allowed by their design and our assembly processes.  The calibration process we have developed at 

AvL virtually eliminates these inconsistencies and allows us to provide a cost-effective auto-

acquisition antenna system solution.  

 

7.3.5  Factory Test 

 

All model based calibration parameters are set in the AvL factory Engineering test lab.  All customer 

based parameters are set before final test by the AvL Service group.  The Service group test procedure 

includes steps that verify that every calibration parameter is set correctly.  Upon successful completion 

of testing at AvL, all of the configuration parameters and files for every antenna system are recorded 

and stored by the Service group for future reference. 

 

7.3.6  Power-On Calibration 

 

Calibration is not a process that occurs only once during the factory assembly and test of AvL 

antenna systems.  It is an important automatic step that is performed every time the antenna is 

powered on for normal operation.  This calibration step is referred to as the “Home” process.  It is 

also a system command that figures prominently on all of the AAQ GUIs.  The main purpose of the 

Home process is to calibrate the primary position feedback devices used on most of AvL’s antenna 
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systems.  The optical encoders mounted on the AZ and EL motors and the potentiometer mounted 

on the POL motor would be an example of this.   

 
These devices are high resolution and very precise, but they provide only relative angular position 

measurements with no reliable absolute reference point.  For this reason, when the antenna system 

powers on it does not know with certainty where the antenna is pointing or where the positioner’s 

axes are relative to hardware safety limits.  Executing the Home command/process moves the 

antenna to known reference points using inclinometer and potentiometer feedback and a magnetic 

reed switch that together allow the AAQ to assign a reliable absolute position value to the readings 

provided by the encoders. 

 

7.3.7  Product Lifetime 

 
AvL designs antennas for a long service lifetime with minimal maintenance required.  However, it 

may become necessary at some point to re-calibrate the antenna system due to replacement of a 

sensor or some other critical component of the antenna system. AAQ software includes several 

automated calibration (Auto-Cal) routines to assist the user in many of these situations.  When 

necessary, step-by-step instructions may be provided to address special cases.  A properly trained 

System Integrator technician or end-user, with sufficient log-in privileges, is able to safely and 

accurately execute all the calibration steps necessary to maintain the antenna system in good 

working order. 
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7.4 AAQ Controller Functional Description 
 

7.4.1  Pedestal Base Heading 

 
Every AvL antenna system ships with an Electronic Compass that is used to determine an initial 

heading for the antenna system’s base platform.  This information, along with the antenna’s 

geographic location (latitude and longitude), is essential to determine a pointing solution (antenna 

pedestal azimuth, elevation, and polarization angles) for the target satellite.   
 

This estimate of the antenna’s heading value is approximate and subject to significant variation due 

to the possible presence of ferrous material, such as a metal framed building or vehicle, in the 

vicinity of the antenna system.  For this reason, the default value for the azimuth line scan angle 

employed during acquisition is set to a value of +/- 20 degrees.  In AvL’s extensive experience 

supporting users of our transportable antenna systems, this value has proven to be very reliable in 

the vast majority of applications. 
 

Both the Electronic Compass and GPS are built into the AAQ’s NAV RIOM. 

 

7.4.1.1  Navigation Remote Input Output Module (RIOM)  

 
The NAV RIOM contains a GPS receiver and a 3 axis Electronic Compass and is the primary positional 

sensor of the AAQ Controller. A 2-axis inclinometer also resides within the NAV RIOM.  The NAV 

RIOM is plugged into the AAQ’s J2 harness and it is typically mounted on the back of the reflector at 

the topmost point when deployed.  At this location, the GPS antenna is afforded a good view of the 

sky.   

 

 
 

Figure 7.4.1.1 - NAV RIOM on Reflector 
 

 

NAV RIOM 
Antenna 

Reflector 
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7.4.2  SATTANT 

 

SATTANT is the name AvL has assigned to a novel approach developed to refine the antenna base 

heading provided by the electronic compass using satellite received signal power, only.  Unlike 

methods employed by other antenna controllers to refine the compass heading, SATTANT does not 

require a DVB receiver or an extensive, up-to-date satellite location database.  A simple and 

inexpensive broadband power detector (RSL) is all that is required.  This method provides an 

accurate estimate of antenna heading immediately out-of-the-box anywhere the antenna system is 

deployed. 

 

This approach depends only on accurate knowledge of the antenna’s location and the elevation 

angle of the antenna’s bore-sight.  The GPS antenna and receiver included in every AvL antenna 

system provides location information to accuracy much higher than the SATTANT process needs.  A 

carefully calibrated elevation inclinometer provides an accurate estimate of the antenna’s elevation 

angle relative to the local gravity vector. 

 

Based on the antenna’s location and heading, the imaginary line in the sky traced by the 

geostationary satellite arc can be calculated.  The two points at which a line of constant elevation 

angle intersects that geostationary satellite arc can also be calculated with precision and expressed 

in terms of elevation angle and azimuth angle relative to true North.  These intersecting lines are 

illustrated in Figure 7.4.2.  Successfully acquiring and peaking on any geostationary satellite provides 

the information (pedestal elevation and azimuth angles) necessary to substantially improve the 

antenna heading estimate and allow the antenna to zero in on the target satellite’s location. 
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Figure 7.4.2 – SATTANT Process 

 

AvL’s SATTANT algorithm takes several factors into consideration when it selects the elevation angle for 

its satellite acquisition scan and the east / west intercept point.  Every effort is made to insure that a 

reliable heading update is made at the end of this process. 

 

It should be emphasized here that the SATTANT process used to improve your heading accuracy is a 

mathematical process as opposed to the Reference satellite method which takes advantage of 

knowledge of location and or carrier information to provide more reliable data for acquisition.  

 

7.4.3 Reference satellite function 

 

Reference satellites are generally of two types. Those of the first “Direct Broadcast” type have 

broad, high power carriers in the high band section of their transmitted signal. Once found, these 

carriers can be used to fine tune the heading of the antenna to a considerable degree, while 

reducing any error in the Target acquisition process. The spacing of these satellites (in CONUS) 

makes it very unlikely that an adjacent satellite will be acquired. DBS type satellites are often used 

as their high carrier power simplifies acquisition in poor weather conditions as well. 
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The second type of reference satellite uses a “DvB” carrier on a known satellite location and of a 

known frequency, bandwidth etc. While this offers a generally lower power carrier than the DBS 

type, the specifics of the carrier make it very unlikely that an adjacent satellite will be acquired. 

 

Use of a Reference Satellite requires the creation of a separate profile for each Reference chosen. 

The Reference is then set to use the signaling device and carrier information available. An example 

of a reference profile created to use the AvL DvB receiver can be found in section 5.9.9 of this 

manual as well as section 9.6 of the DvB receiver appendix. 

 

7.4.4  Pedestal Tilt Compensation  

 

In order to calculate an accurate satellite pointing solution, the tilt (pitch and roll) of the antenna 

platform must be known to a relatively high degree of accuracy.  This information also plays an 

important part in aligning the antenna’s linear polarization vector with that of the target satellite to 

insure optimal co-polarized signal transmission / reception and to minimize cross-polarized 

interference on the forward and return links.   

 

Tilt of the antenna platform is measured by precision inclinometers that are usually located inside 

the AAQ ACU main module.  The ACU module is typically mounted directly on the Azimuth 

positioner base plate above the Azimuth Bearing Assembly.  Mounted in this location, the sensors 

are always on a surface that is nominally level during antenna operation, which insures the actual tilt 

of the system will be well within the accurate / linear range of these devices. 

 

 

During normal operation, pitch and roll sensor values are recorded during the Home process (for 

calculation of the pointing solution) and immediately after peaking is completed on the target 

satellite (for polarization optimization).   

 

7.4.5  Satellite Pointing Solution 

 

The AAQ calculates the current pointing vector of the reflector boresight in Pedestal Coordinates 

and World (Local Tangent Plane) Coordinates.  These are displayed on the AAQRemote GUI main 

window and output as Sensor Outputs if desired. 

 

World Coordinates - These are the AZ/EL spherical coordinates in the Local Tangent Plane 

reference system.  AZ is measured clockwise (when looking down on the antenna) from true 

north.  EL is measured up from the local tangent plane (horizon).  These are the coordinates 

most common in the satellite industry. 
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Pedestal Coordinates - These are the AZ/EL spherical coordinates of the pointing vector, in 

the pedestal reference system.  AZ is measured clockwise (when looking down on the 

antenna) from the AZ Home Position.  The antenna boresight will be parallel to the frame of 

the antenna at the Home Position.  EL is measured up from a boresight of 0 degrees. 

 

The AAQ calculates the pointing solutions in Pedestal Coordinates.  These are the Pedestal 

Coordinates that will point the antenna boresight at the Target Satellite if the Pitch and Roll are 0.0 

and the Heading is exactly equal to the current heading.  These are displayed in the “Target 

Selection” section of the AAQRemote GUI main window as “Actual” values and are output as Sensor 

Outputs. 

 

The AAQ calculates Tilt Corrections that must be made to the pointing solution.  These tilt 

corrections are calculated by a “3 rotation tilt transform” using Yaw (Heading) followed by Pitch and 

then Roll.  The Yaw, Pitch, and Roll values used in this transform are measured during a Home 

routine at power up.  When these corrections are added to the “Actual” values, they become the 

Pedestal Coordinates that will point the antenna boresight at the Target Satellite assuming the Pitch, 

Roll, and Heading values last reported by those sensors.  

 

This process is performed whenever the AvL antenna system is powered up or a new target 

satellite/profile is selected in any AAQ GUI (AAQRemote .Net, Web Server, CIP or Handheld). 

 

7.4.6  Acquiring the Satellite Signal 

 

The AAQ usually acquires the Target Satellite by executing a single Azimuth (AZ) Line Scan (Azimuth 

angle varied while the Elevation angle is held constant) centered on the best current Ped-AZ / Ped-

EL pointing solution.  If this initial AZ Line Scan is not successful, then a raster scan is performed 

automatically. This raster consists of several back-and-forth Azimuth line scans at different Elevation 

angles.  The AZ width, EL height, and EL step size of this scan volume are all based on user settable 

configuration parameters.  The AAQ acquisition scan is illustrated in Figure 7.4.5. 
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Figure 7.4.6 - AAQ Acquisition Scan 

 

The required AZ width parameter is substantially influenced by the accuracy of the pedestal heading 

source used for acquisition purposes.  The standard magnetic compass included with all AvL antenna 

systems is a moderately accurate device.  However, like any magnetic compass, its reading is subject 

to significant errors when the antenna system is located close to large ferrous objects like metal 

framed buildings and large commercial vehicles or the electromagnetic fields generated by 

underground utility cables.  For this reason, the AAQ’s raster scan is typically rectangular in shape, 

with an AZ width that is many times larger than the EL height. 

 

As mentioned previously, the AAQ typically acquires the target satellite on the first AZ scan.  This 

high success rate is due in large part to a feature called continuous tilt compensation.  This standard 

AAQ feature enables the antenna system to perform acquisition AZ scans at a constant World-EL 

value instead of a constant Ped-EL value.  In this way, potentially significant World-EL angle errors 

due to pedestal tilt are eliminated near the beginning and end of the AZ scan.  With this feature in 

place, multiple AZ scans (additional acquisition time) and increased probability of acquiring the 

wrong satellite is avoided. 

The steps employed by the AAQ during satellite acquisition vary depending on the type of 

acquisition signal source being used and the satellite’s position relative to the terminal’s location.  

These dependencies are described in the following sections. 
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7.4.7  Signal Source = RSL 

 

A Received Signal Level (RSL) broadband power detector comes standard on all AAQ equipped AvL 

antennas.  It is designed to detect power in the standard L-band used by most satellite terminals, 

specifically 950 – 2150 MHz.  AvL antennas are typically wired to provide the RSL with a sample of 

the satellite signal available on the cable running from the customer provided LNB to the modem via 

an AvL provided in-line signal splitter or coupling device.  Based on the nature of its design, the RSL 

is a great detector of satellite signals, but it cannot reliably confirm that the detected signal is 

originating from the target satellite.  For this reason, extra steps are sometimes required to increase 

the probability that the antenna acquires and peaks on the correct satellite.   

 

 

As mentioned previously in this chapter, prior to acquisition of a satellite the AAQ is typically 

operating with a very good knowledge of the EL angle and a relatively poor estimate of the AZ angle 

for the antenna beam.  Consequently, the AAQ searches for the target satellite using relatively wide 

AZ line scans as illustrated in Figure 7.4.6a.  While performing an AZ line scan, the AAQ records RSL 

output.  Upon completion of each scan, the AAQ reviews data taken on that pass and compares it 

against a user defined threshold value.  If the threshold value is met or exceeded, then the AAQ will 

return the antenna to the location corresponding to the highest level detected and begin peaking on 

the signal.  Otherwise, the AAQ will continue with its raster scan routine.  A successful acquisition of 

Satellite A after a single AZ line scan is illustrated in Figure 7.4.6b. 
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Figure 7.4.7a – Wide Az. Line Scan Example 

 

 

When the difference between the longitude of the target satellite and the terminal is small, the 

target satellite will appear near the top of the geosynchronous satellite arc when viewed from the 

terminal’s location (Satellite B in Figure 7.4.7a).  As shown in the figure, the AZ line scan for Satellite 

B passes very close to several other GSO satellites.  If the EL angle is off by even a small amount 

and/or any of those other satellites is transmitting higher broadband power than the target satellite, 

then the AAQ could easily select and peak on the wrong satellite’s signal.  In order to minimize the 

probability of making the wrong choice under these circumstances, a SATTANT is automatically 

performed by the AAQ before target satellite acquisition (peaking only) is attempted.  This process is 

illustrated in Figure 7.4.7b.  The longitude difference between satellite and terminal that triggers the 

automatic SATTANT is user configurable and typically set to a value of 20 degrees. 

 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 168 of 200 
 

 
 

Figure 7.4.7b – Narrow Az. Line Scan Example 

 

 

Even with these extra precautions, it is difficult to successfully acquire a target satellite with a relatively 

weak broadband signal when it is located next to a newer, higher power satellite.  In this case, it is 

desirable to use a more selective satellite signal source such as a modem, DvB or beacon receiver. 

 

7.4.8  Signal Source, Modem or Beacon Receiver 

 

AvL offers an optional Satellite Beacon Receiver with almost every antenna system, but Satellite 

Modems are typically supplied by our system integrator customers.  The AAQ is compatible with a 

large number of Satellite Modems and Beacon Receivers and they are the Signal Source of choice for 

robust and reliable satellite acquisition.  Their preference is based primarily on their ability to 

confirm that the signal detected is originating from the target satellite and not one of its neighbors.  

Modems usually lock exclusively on only the carrier associated with their particular network.  

Narrowband satellite beacon signal frequencies, while not completely unique to each satellite, are 

usually assigned in a way that helps differentiate close neighbors so when the receiver locks, the 

antenna is pointing at the correct satellite.  Modems that are designed to work with the AAQ 

controller have an associated Appendix to be used with this manual. 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 169 of 200 
 

 

 

When one of these signal sources is selected for acquisition, the AAQ will move directly to the “AZ 

Line Scan” starting point based on the pointing solution for the target satellite and initiate a raster 

scan.  The AZ line scan is stopped immediately upon target satellite signal detection 

(modem/receiver lock indication) and the AAQ shifts directly into peaking mode.  The AAQ does not 

normally execute a SATTANT when the Signal Source is Modem or Beacon Receiver since 

neighboring satellites that lie on or close to the AZ line scan will be ignored by these signal sources. 

 

7.4.9  Peaking on the Signal 

 

After acquisition is complete, the AAQ peaks on the satellite signal in two stages; referred to as 

Coarse Peaking and Fine Peaking.  The objectives for Coarse Peaking are to (1) insure that the 

system is peaking on the main beam of the antenna’s pattern and not a “side lobe” and (2) position 

the antenna such that the peak of the main beam is closely aligned with the satellite.  The objective 

for Fine Peaking is to precisely align the antenna with the target satellite. 

 

The following Sections, describe the default (recommended) mode for Coarse and Fine Peaking on 

the Target Satellite signal.  In reality, either of the modes described here (Cross Peaking and Step 

Peaking) may be used.  Additionally, Coarse and/or Fine Peaking may be skipped entirely if that is 

the Integrator’s choice.  All of these options are configurable via the AAQ Profile System parameter 

settings described in Chapters 4 & 5. 

 

7.4.10  Coarse Peaking 

 

At the completion of the acquisition process, the antenna is aligned close enough to the satellite’s 

location to receive a signal that meets or exceeds the user settable minimum detection threshold.  

The next step involves reliably moving the center of the antenna’s main beam (boresight) to an 

angle that aligns closely with the target satellite.  This is usually accomplished by executing cross 

scans as illustrated in Figure 7.4.9.   
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Figure 7.4.10 – Cross Scan Example 

 

 

As noted in the figure, the axes of the cross scan (two orthogonal line scans) align with the antenna’s 

Ped-AZ and Ped-EL axes.  After the first line scan is completed, the AAQ commands the antenna to the 

scan angle corresponding to maximum received signal level.  The next line scan is made in the 

orthogonal direction and passes through the previous scan’s maximum signal point.  Again, the AAQ 

commands the antenna to the scan angle corresponding to maximum received signal level seen during 

the second scan.  This process is repeated until Coarse Peaking success criteria are met.  Those criteria 

may be a predetermined number of cycles or some minimum peak signal difference between cycles. 

 

The length of the cross scans in AZ and EL are selected to insure that the peak of the main beam will be 

scanned even if the target satellite is initially acquired in a “side lobe” of the antenna.  This assures that 

the Fine Peaking process will be initiated when the target satellite is well within the main lobe of the 

antenna’s beam. 
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7.4.11  Fine Peaking 

 

Optimal pointing of the antenna at the target satellite is usually achieved by a Ped-AZ and Ped-EL 

step scan technique.  A series of small, equal changes in antenna pointing are made in one direction 

(Ped-AZ).  After each small step, the received satellite signal is measured and compared to the level 

recorded at the end of the previous step.  If the new signal reading is higher than the previous 

reading, then an additional small step is made in the same direction and the signal is measured at 

the new position.  Else, the AAQ commands a backwards step and begins a step scan in the 

orthogonal direction (Ped-EL).  This step scan process is illustrated in Figure 7.8.2. 

 

 

 
 

Figure 7.4.11 – Fine Peaking Example 

 

At the end of each Ped-AZ / Ped-EL step scan cycle, the signal level achieved at the end of the 

current cycle is compared to the signal level recorded at the end of the previous cycle.  If the 

difference is positive and exceeds a user defined limit, then the Fine Peaking process continues and 

another step scan cycle is performed.  Fine Peaking is considered complete when no further 

meaningful improvement in received satellite signal level can be made. 
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7.4.12  Linear Polarization Optimization 

 

It is critical that the linearly polarized satellite ground antenna align its polarization vector closely 

with that of the satellite.  Any mismatch between satellite and terminal antennas will reduce signal 

power on the forward and return links.  Even a small misalignment of the polarization vector will 

significantly increase cross-polarized interference and further degrade the communications link 

between satellite and terminal.  Both of these potential performance shortfalls are addressed and 

minimized by the AAQ. 
 

The satellite pointing solution implemented by the AAQ and described earlier, address the angle of 

the satellite’s linear polarization vector in addition to Azimuth and Elevation pointing angles.  All 

three of these angles depend on the same factors, including the pitch and roll of the antenna’s 

pedestal.  Prior to acquisition of the satellite, all of the satellite pointing and polarization angles are 

calculated based on the initial, relatively inaccurate estimate of pedestal heading.  The antenna’s 

linear polarization is configured based on this initial value, which is more than adequate for 

acquisition and peaking purposes.   
 

Once the AAQ has successfully acquired and peaked on the target satellite (or the SATTANT 

satellite), the pedestal heading is updated with an extremely accurate value.  Without this final 

adjustment, the satellite terminal’s performance would be degraded and the resulting cross-

polarized interference on the return link could be a significant issue for the satellite operator and 

other users of the system. 

 

7.4.13  Tracking on the Signal (Optional) 

 

The vast majority of communications satellites in geosynchronous orbit are essentially stationary 

relative to any point on the Earth’s surface.  Occasional station keeping maneuvers keep these 

satellites within a very small “box” centered on their assigned orbital location.  In most applications, 

there is no reason for the AvL antenna system to move (change antenna pointing) once the satellite 

has been acquired and the peaking process is complete.   
 

There are exceptions to this general rule and the AAQ is equipped to deal effectively with them.  

One exception involves large aperture antennas (> 2.4 meters) operating at Ka-band.  Antennas of 

this size have very narrow “beam widths” at 30 GHz and they suffer a measurable loss in antenna 

gain due to pointing error as the geostationary satellite drifts around in its small box.  Since these 

antennas are typically used in small gateways for many remote terminals, the entire network suffers 

when the gateway antenna is not performing optimally.  In this case, the gateway antenna is usually 

required to track the small motion of the satellite and maintain the antenna gain very close to peak 

level. 
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The popularity of satellite services using inclined geosynchronous satellites is growing and becoming 

a more frequent exception to the stationary rule.  These satellites typically start their service lives in 

stationary orbits.  As their station keeping fuel supply dwindles, the satellite operator decides to 

extend the life of the satellite by moving the satellite into an inclined orbit that requires much less 

fuel to maintain.  
 

The new orbit is still geosynchronous (orbit period = 1 day), but the satellite no longer appears 

stationary when viewed from the Earth’s surface.  Instead, it moves in a predictable, narrow “figure 

8” path that aligns North to South.  The price charged for bandwidth on these inclined / drifting 

satellites is much lower than that charged for stationary satellites, hence their growing popularity. 
 

The AAQ may be optionally configured with satellite tracking capabilities through the addition of 

software modules.  Two tracking modes are currently available, with more to follow.  They are Step 

Track and TLE Track. 

 

7.4.14  Step Track 

 

Step Track mode is designed to address the first exception to the stationary satellite rule described 

above.  It is also very useful when an AvL transportable antenna might be inadvertently deployed on 

an unstable surface, such as sand or loose soil.  Any gradual, permanent changes in antenna pointing 

due to the frequent vibration of passing vehicles or induced by gusty winds on the antenna’s 

reflector are automatically corrected. 

 

Step Track is best described as periodic Fine Peaking of the antenna system.  The periodic peaking 

process is the same as described in Section 7.4.10.  Small step scans are performed in Ped-AZ and 

Ped-EL until the Fine Peaking criteria is met.  The AAQ then waits a specified time period (Level 4 

user settable) and repeats the process.  This method insures that the antenna beam remains peaked 

on the target satellite and temporary antenna gain loss due to “step off” is minimized by choosing 

an appropriately small angular step size, which is also Level 4 user settable. See appendix M for the 

Step Track option. 

 

7.4.15  Two-Line Element (TLE) Track 

 

TLE Track mode is the preferred approach for tracking inclined geosynchronous satellites.  As 

mentioned above, the track that these satellites make in the sky is predictable and a standard 

method for efficiently and accurately calculating the time varying antenna pointing solution has 

been developed.  This standard method uses a set of orbital elements in a standard format called 

Two-Line Elements (TLE) that describe the orbit of Earth-orbiting satellites.  These TLE sets are 

widely distributed on the Internet.  A computer program called a model or propagator uses the TLE 

set to calculate the pointing solution for the target satellite at a particular time.  
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The AAQ’s TLE Track software module includes a TLE propagator program that takes a user provided 

TLE set and calculates the antenna Ped-AZ and Ped-EL angles versus time necessary to reliably 

acquire and accurately track the target satellite.  The TLE set for a particular satellite will be updated 

from time to time based on NORAD tracking data and infrequent maneuvers performed by the 

satellite operator to maintain the satellite’s inclined orbit.  The operator of the terminal is 

responsible for keeping the TLE set current. See appendix O for the TLE Tracking option. 

 

 

 

7.4.16  Position Hold 

 

The AAQ has a Position Hold mode that makes it tolerant of power outages.  While in this mode, if 

the power should fail and return without any detectable movement of the antenna system, then the 

AAQ will continue to hold its position provided that the Modem reports a lock on the Target 

Satellite’s signal. 

 

7.4.17  Satellite Signal Properties 

 

The AAQ requires a metric that it can use to discern a successful satellite acquisition and optimize 

for antenna peaking purposes.  That metric is some representation of the signal received by the 

antenna from the target satellite.  The signal itself is subject to significant perturbation by the 

atmosphere through which the electromagnetic waves travel.  For the AAQ, the satellite signal is 

represented by the output of a device called a “Signal Source”.  The AAQ is designed to work with 

several types of signal sources, each with its own advantages and disadvantages that must be 

accommodated by AAQ software.  

 

7.4.18  Scintillation Effect 

 

Scintillation is a term for rapid variation in apparent brightness or position of a distant object when 

viewed through a medium such as the Earth’s atmosphere.  Scintillation’s effect on a satellite signal 

causes rapid changes in received signal level that can reach several decibels (dB) in magnitude.  The 

effect is caused by anomalous refraction of the satellite’s RF signal due to small fluctuations in air 

density.  The effect varies significantly in intensity with time as atmospheric conditions are 

constantly changing. 

 

In order to optimally peak the antenna system on the target satellite, the AAQ must be able to make 

Fine Peaking decisions based on changes of only a fraction of a dB in received satellite signal level 

from one step to the next.  This becomes problematic when scintillation effects reach several dB.  

Under nominal conditions, when the received satellite signal is reasonably stable, the AAQ will 
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command the antenna to dwell for some time at the end of each step and average several short 

duration measurements to filter out the always present scintillation “noise.”   

 

      7.4.19 Rain Fade 

 

Rain Fade refers to the absorption of an RF signal by atmospheric rain, snow, or ice.  It is most prevalent 

at frequencies above 11 GHz.  A heavy rain storm can reduce the satellite signal level received by a Ku-

band or Ka-band antenna system to essentially zero in a matter of seconds.  Lesser storms, which are 

much more common, can still have significant effects long before they arrive at the antenna’s location, 

especially when the antenna is operating at low look (elevation) angles.  Any significant signal changes 

not related to the pointing of the antenna system can have a detrimental effect on the performance of 

an auto-pointing antenna system. 

 

Rain fades are usually short duration events, so the antenna typically returns to normal operation very 

quickly. 

 

7.4.20  Signal Sources 

 

The AAQ is designed to interface with four different types of signal sources; RSL (broadband power 

meter), Beacon Receiver, the AvL DvB receiver and a variety of Modems.  Each of these devices falls 

short of being the ideal signal measurement device for an auto-point antenna system.  That ideal 

device would have the following key characteristics: 

 

1. Reliable confirmation that the signal originates from the target satellite 

2. High sensitivity and dynamic range 

3. Near instantaneous response time 

4. Frequent (>~10 Hz) and accurate signal level estimates 

5. Affordable incremental system price 

 

A device that excels in all of these areas would assure very fast and reliable satellite acquisition and 

peaking while minimizing complexity in the AAQ software.  Modems tend to do very well on 

characteristics (1) and (5), but fall short on the others.  The RSL scores well on items (3) – (5).  The 

best Beacon Receivers meets most of the above criteria, but they struggle with the important 

characteristic (5). See appendix listing for Beacon receivers and other signal source options. 
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With no clear winner, the AAQ is designed to work with all three.  Special provisions are made in the 

design of the AAQ software and available configuration parameter settings to compensate for their 

short-comings.  Scan speeds can be varied to account for variation in response time and the rate at 

which new measurements are provided.  Averaging times can be modified to deal with different 

sensitivity levels.  The SATTANT process reduces the necessity for satellite signal identification at the 

expense of additional acquisition time.  Finally, if more than one type of signal source is present in 

the system, then the AAQ allows each source to be assigned the task that they are best suited to 

perform. 

 

The AAQ ACU is compatible with a long list of popular Modem types.  Four of these Modem Types 

are addressed in detail in Appendices D, E, F and G of this document. 

 

7.4.21  Profile System 

 

The AAQ Profile System is a powerful tool that is available in the AAQRemote .Net GUI.  It is 

described in detail in Chapters 4 & 5 as well as in the DvB receiver appendix H.  For the average 

operator, it provides the means to create a selectable target without having to adjust simple 

parameters for longitude, polarization or signaling devices each time.  For the knowledgeable 

operator or integrator, it provides the ability to optimize the AAQ’s acquisition and peaking 

processes for each satellite placed on the Target Satellite list. Additionally, profiles can be created 

where different carriers on the same satellite have individual requirements.  It also allows the 

operator to optimize the appropriate AAQ configuration parameters, such as scan speeds, dwell 

times and carrier thresholds for each of the signal sources present in that particular antenna system. 

 

When the profile is complete, it becomes a selection in the Target Profile drop-down menu on the 

main screen of all AAQ GUIs.  The operator of the antenna in the field can select that profile and 

immediately benefit from all of the careful system optimization work done by others without ever 

logging in to the AAQ system and changing a single parameter.  Through Profiles, the end-user 

experience is simultaneously simplified and optimized. 
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7.5  The Acquisition process 
 
This section describes the normal operations of the AAQ controller from power on to acquisition of the 

target.  For each step, the “command response” indicated on the GUI will also be included. 

 

7.5.1 Power on and Boot 

 

The AAQ controller is a Linux based operating system.  When power is applied to the controller, the 

system begins a boot process that loads the file system and application programs into RAM.  This boot 

process requires 30-60 seconds to complete.  Once the controller is booted, it is in an operational state 

and ready to accept commands.  For this example we will use a system equipped with a modem for our 

signal source. 

 

All external equipment modules are initialized during the boot process.  During this process the modules 

are allowed to initialize specific devices or functions outside the normal AAQ operations.   

 

When booted the controller awaits a command request.  Commands recognized by the AAQ controller 

are: 

 

 Stop:  Stops the current running command.   

 Manual Control: Enables the manual jog commands to be accepted. 

 Home:  Positions the antenna upright and initializes axis based sensors. 

 Stow:  Stows the antenna to the specified values based on the configuration. 

 X Pol:  Moves the polarization 90 degrees from its current position. 

 Acquire:  Automatically points the antenna to the specified satellite. 

 Move To:  Moves to the requested pedestal coordinates. 

 Peak:  Performs peaking using the current signal source. 

 Track:  Performs the current tracking sequence. 

 Repeak:  Performs fine peaking sequence if signal is above a set threshold. 

 SatTant:  Automatically points the antenna to the specified Target satellite utilizing a  

   SatTant based pointing solution. 

 

7.5.2 Home Sequence 

 
The “Home” command determines tilt and initializes the motor feedback sensors (i.e. encoders and 

resolvers) needed for precision movements.  The acquire command will initiate a “home” sequence 

before completing the sequence.  
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7.5.2.1  Setting the Azimuth Axis  

 

Once the elevation axis has reached its home position, the azimuth axis will begin searching for the 

magnetic reed switch located in the center of the azimuth axis on the baseplate.  The azimuth will 

begin moving to the defined value based on the azimuth potentiometer position sensor.  Once 

detected, the azimuth will follow the logic below to derive the center of the azimuth magnetic 

switch. After the position sensors (i.e. Magnetic reed switch and/or potentiometer) have found the 

physical center, the precision feedback sensors are initialized (i.e. encodes).   

 

- Move to the Counter-Clockwise side of the magnetic switch. 

- Move through the magnetic switch to the Clockwise side.  Record the values of the 

transitions on and off the switch. 

- Move through the magnetic switch to the Counter-Clockwise side.  Record the values of 

the transitions on and off the switch. 

- Calculate the center of the switch, removing hysteresis effect.  Move to the calculated 

center of the switch. 

 

                 Command Response:  Initializing Azimuth Encoder 

 

 
 

Figure 7.5.2.1 – Setting Azimuth Axis 

Move to Counter-Clockwise 

side of the switch 

Move to Clockwise side of 

the switch 

Move to Center of the switch 
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7.5.2.2  Setting the Elevation Axis 

  
When performing the “Home” command for the first time, the system will first move to a defined 

position using the elevation position sensors (i.e. switches and/or inclinometers).  This action moves 

the antenna from the stowed position to a point where azimuth movements are allowed. Once in 

the home position the elevation precision feedback sensors can be initialized (i.e. encoders). After 

setting the Az. Encoders, the antenna moves elevation to within a valid range (core config) to then 

set El encoders 

Command Response:  initializing elevation encoder 
 

7.5.2.3  Elevation down Limit 

 
Only elevation axis movements are permitted below the Down Limit with the azimuth centered, this 

is to avoid collateral damage that could result from moving the azimuth or polarization axis 

prematurely.  The following warning will show on the GUI main window: 

 

    Elevation is Below the Down Limit 
           

 

 

 
Figure 7.5.2.3 – Elevation Down Limit Example 

 

 

Down Limit:  Azimuth & Pol 

Movements Prohibited Below 

this Point. 

 

Elevation Inclinometer 

(AAQ1500 NAV RIOM) 
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7.5.2.4  Initializing Sensors 

 

Now that the azimuth and elevation are in the proper homed position, the precision feedback 

encoders are initialized based on the analog sensor position. From this point forward, axis 

movements are based on the motor encoders and analog inputs are used to signal an alarm in the 

event a sensor fails or the readout is incorrect.  

 

 

7.5.3 Acquisition Sequence 

 
Any Acquisition command will use parameters selected in the active profile for the current target.  

The following steps are common for all types of Acquisition.  

 

7.5.3.1  Compass Read  

 

If a home has not been performed prior to the compass routine, the unit will automatically home 

first before taking a compass reading. The system will then move to the predefined 

azimuth/elevation compass read positions. Typically this is where the Electronic compass is level. 

This reading is a coarse heading the system will use to reduce time searching for the target satellite.  

Once the system is in the correct orientation for data collection from the compass, the system reads 

the value from the compass and generates a heading based on the reading.  Once the heading is 

generated, the system creates a series of azimuth and elevation points that are tilt compensated 

according to the pitch and roll values taken during the ‘Home’ command.  The points are based on a 

compass scan width where the width is set to compensate for any compass error.  

 

Command Response Message:  Read Compass  

 

 

7.5.3.2  Move to Initial Scan Point  

 

The positioner now moves to the initial scan point (first point of the tilt compensated azimuth and 

elevation values).  The polarization is moved to a calculated value based on the electronic compass 

heading. 
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Figure 7.5.3.2 - Satellite Arc 
 

Command Response Message:  Moving to begin scanning in Az for Target Sat Signal 
 

7.5.3.2  Move to Second Scan Point  

 

The positioner now moves through the scan width searching for data satellite. Once the system or 

external signaling device (i.e. modems, beacon receiver, etc.) declares a lock. The system will 

discontinue the scan and move into the peaking sequence. This may vary with signaling device used. 

 

Command Response Message: Scanning Az. For Target Sat Signal, Pass 1 
 

7.5.4 Peaking Sequence 

 

In general, the acquisition process attempts to locate and lock onto the strongest signal detected 

from the desired satellite using the signal levels and reported by the Modem, beacon receiver, RSL 

etc. This operation consists of the following steps: 
 

Note - Setting values referred to below are part of the parameter settings for a   

particular profile. See chapters 4 & 5 for more information on the Profile 

system. 
 

7.5.4.1  Coarse peaking   

 

Coarse Peaking is the typical method used to automatically coarse peak on a satellite.  This method 

sweeps in Azimuth based on the “Coarse Peaking Width” setting.  Upon completion of the sweep, it 

will return to the highest signal level position where it then will move elevation based on the 

“Peaking Height” setting.  Upon completion of the elevation movement, it will once again return to 

the highest signal level position.   

 

 

 

Initial Scan Point 

Compass Scan Width  

Target Satellite   
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At this point, it will compare the current signal level to the previous signal level. If the signal level 

difference is greater than the “Coarse Peak Signal Dif. Pass” setting value and meets the minimum 

number of peaking cycles specified by the “Coarse peaking cycles” setting, then “Cross Pattern, 

Coarse Peaking” has completed.  If the value is not greater, it will continue Cross Pattern Coarse 

Peaking for a maximum number of tries based on the “Coarse Peaking Max Cycles” setting.  

 

Command Response Message: Coarse Peaking 

 

7.5.4.2  Fine peaking  

 

This is the typical method used to automatically fine peak on a satellite.  This method steps in 

Azimuth based on the “Fine Peaking Az Step” setting.  Upon completion of each step, it compares 

the current signal level to the previous signal level.  The “Peak Dwell Iterations” is set accordingly to 

allow for the signal level to stabilize before the comparison between steps is calculated.  If the 

current signal level is greater than the previous signal level, it will step again.  This process will 

continue until the previous signal level is greater than the current signal level.  At this point, it will 

return to the previous signal level’s position.  It will then step in Elevation based on the “Step 

Pattern Fine Peaking El Step” setting.   

 

This process will once again continue until the previous signal level is greater than the current signal 

level.  At this point, it will once again return to the previous signal level’s position.  If the signal level 

difference is greater than the “Fine Peak Signal Dif. Pass” value and meets the minimum number of 

peaking cycles specified by the “Fine peaking cycles” setting, then Step Pattern Fine Peaking has 

completed.  If the value is not greater, then it will continue Step Pattern Fine Peaking for a 

maximum number of tries based on the “Fine peaking max cycles” value. At this point, the antenna 

acquisition is considered to be complete. 

 

Command Response Message: Fine Peaking 
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Chapter 8 - Troubleshooting  

 

There are many interfaces between the AAQ and positioner including sensors, limit switches, the mechanical 
components of the antenna and ancillary satellite equipment, etc.  Some issues are due to interactions that 
are not always readily apparent. A review of symptoms and faults will be given in this section.  
 

8.1 Alarms & Messages 
 

Numerous alarms, cautions, prompts and running messages are presented by the AAQ GUI depending upon 
situation as well as the equipment supplied with each type of system. This section will list and describe those 
found within the current revision. 
 

8.1.1 Alarms 
 

 The following table lists alarm messages and their descriptions as shown on the AAQ GUI: 
 

Alarm Name             Description 

AzPot The azimuth potentiometer cannot be read.  The azimuth RIOM reports 
this error.  This does not indicate an azimuth potentiometer is broken, it 
indicates the A/D interface cannot be read by the RIOM. 

ElPot The elevation potentiometer cannot be read.  The elevation RIOM reports 
this error.  This does not indicate an elevation potentiometer is broken, it 
indicates the A/D interface cannot be read by the RIOM. 

PolPot The polarization potentiometer cannot be read.  The polarization RIOM 
reports this error.  This does not indicate a polarization potentiometer is 
broken, it indicates the A/D interface cannot be read by the RIOM. 

RSL1 Indicates an RSL read issue 

AzStow The azimuth stow magnetic switch cannot be read.  The azimuth RIOM 
reports this error.  This does not indicate the magnetic switch is broken, it 
indicates the digital input cannot be read by the RIOM. 

PolLimit The polarization limit switch cannot be read.  The polarization RIOM 
reports this error.  This does not indicate the limit switch is broken, it 
indicates the digital input cannot be read by the RIOM. 

PolCenterSwitch The polarization center switch cannot be read.  The polarization RIOM 
reports this error.  This does not indicate the center switch is broken, it 
indicates the digital input cannot be read by the RIOM. 

ElUpLimitSwitch The elevation up limit switch cannot be read.  The elevation RIOM reports 
this error.  This does not indicate the up limit switch is broken, it indicates 
the digital input cannot be read by the RIOM. 

ElDownLimitSwitch The elevation down limit switch cannot be read.  The elevation RIOM 
reports this error.  This does not indicate the down limit switch is broken, it 
indicates the digital input cannot be read by the RIOM. 

AzCWLimitSwitch The azimuth clockwise limit switch cannot be read.  The azimuth RIOM 
reports this error.  This does not indicate the clockwise limit switch is 
broken, it indicates the digital input cannot be read by the RIOM. 

6.4.1 
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AzCCWLimitSwitch The azimuth counter-clockwise limit switch cannot be read.  The azimuth 
RIOM reports this error.  This does not indicate the counter-clockwise limit 
switch is broken, it indicates the digital input cannot be read by the RIOM. 

AzMotor The azimuth motor had entered an error state. The azimuth RIOM reports 
this error. This indicates the azimuth motor can no longer move due to a 
physical problem.     

ElMotor The elevation motor had entered an error state The elevation RIOM reports 
this error. This indicates the elevation motor can no longer move due to a 
physical problem.   

PolMotor The polarization motor had entered an error state The Polarization RIOM 
reports this error.  This indicates the polarization motor can no longer 
move due to a physical problem.   

navDevice The navigation RIOM cannot be communicated with. 

WingMotor The wing motor had entered an error state. The wing RIOM reports this 
error. This indicates the wing motor can no longer move due to a physical 
problem.   

WingLeftDeploySwitch The wing left deploy switch cannot be read.  The wing RIOM reports this 
error.  This does not indicate the left deploy switch is broken; it indicates 
the digital input cannot be read by the RIOM. 

WingRightDeploySwitch The wing right deploy switch cannot be read.  The wing RIOM reports this 
error.  This does not indicate the right deploy switch is broken; it indicates 
the digital input cannot be read by the RIOM. 

WingLeftStowSwitch The wing left stow switch cannot be read.  The wing RIOM reports this 
error.  This does not indicate the left stow switch is broken; it indicates the 
digital input cannot be read by the RIOM. 

WingRightStowSwitch The wing right stow switch cannot be read.  The wing RIOM reports this 
error.  This does not indicate the right stow switch is broken; it indicates 
the digital input cannot be read by the RIOM. 

WingElSafetySwitch The wing elevation safety switch cannot be read.  The wing RIOM reports 
this error.  This does not indicate the elevation safety switch is broken, it 
indicates the digital input cannot be read by the RIOM. 

DigIn0 through 4 The RIOM configured as the Digital Input 0 through 4 register cannot be 
communicated with. 

ElevationInc The elevation inclinometer cannot be read or the inclinometer device is not 
functioning. 

PitchRollInc The pitch and roll (tilt) inclinometer cannot be read or the inclinometer 
device is not functioning. 

FeedType The feed bit digital inputs cannot be read.   

GreenRed The Green and Red digital inputs cannot be read. 

RackController The Legacy 1RU Rack Controller cannot be communicated to.   

DigitalOut The RIOM configured as the Digital Output 0 register cannot be 
communicated with.  AAQ 1500 hardware is configured to use Digital 
Output 0 as the LNB control. 

DigitalOut1 through 3 The RIOM configured as the Digital Output 1 through 3 register cannot be 
communicated with. 

LocationService The controller has not received a valid GPS location. 
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GPS The GPS device on the NAV RIOM cannot be read or the GPS device is not 
functioning. 

Compass The compass device on the NAV RIOM cannot be read or the compass 
device is not functioning. 

VectorCompass The vector compass device cannot be communicated to. 

AvLCompass The heading device configured as the AvL Compass cannot be 
communicated with. 

Az Limit The azimuth axis is in a limit condition. 

El Limit The elevation axis is in a limit condition. 

Pol Limit The polarization axis is in a limit condition. 

User Manager The internal user manager has encountered an issue.  

 

 

8.1.2 Error Messages 

 
The following table lists error messages and comments as shown on the AAQ GUI: 
 

Message   Comment 

Cannot execute command while alarm is 
active. 

Clear alarm and retry 

GPS Coordinates are not valid. Check GPS or manually entered coordinates 

GPS or compass is in Alarm state. Clear alarm and retry 

Modem has not sent a target. Check device and retry 

All signal sources tried with no valid signal 
detected. 

Possible RF or signal threshold issue 

Scanning will exceed Az Limits - Rotate Base 
and try again 

Rotate Base and try again 

Heading calibration failed. No signal found 
during arc scan. 

Check heading source and retry 

Command failed. Home must be run first. Home command needed to initialize resolvers 

Elevation inclinometer failure. Check inclinometer or El RIOM may be incorrect 

Azimuth must be on stow switch  

Invalid target for this location. Target may not be visible from present location 

Invalid signal for peaking. Possible signal threshold issue or peaking on incorrect 
satellite 

Heading Cal Failed Unable to Calculate Heading 

Invalid target for this location. Target may not be visible from present location 

Could not transform world coordinates.  

Acquire failed waiting for modem/beacon 
signal. 

Possible signal threshold issue or peaking on incorrect 
satellite 

Elevation deploy failed. Check cabling or interference 

Elevation stow failed. Check cabling or interference 

Heading calibration Failed. No signal found 
during scan for a reference satellite. 

Possible compass calibration needed 
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The crosspol command cannot be performed 
with this feed. 

Check hardware or “feedbit” read issue. 

Invalid operation Invalid operation for the current hardware 

 

8.1.3 Prompts  

The following table lists user prompts and their descriptions as shown on the AAQ GUI: 

Message   Comment 

Mount reflector and select OK to continue For use on systems with removable antennas only. At 
this point in the deploy process, the antenna should be 
mounted. 

Unmount reflector and select OK to continue For use on systems with removable antennas only. At 
this point in the stow process, the antenna should be 
unmounted. 

Warning stow may cause elevation to move 
to the deploy range. Press OK to continue. 

The stow process may require that the antenna 
elevation is moved past the elevation limit. Caution is 
advised to avoid potential damage. 

Connect all RIOMs and select OK to continue A RIOM may have been unintentionally disconnected 
or may need to be connected during deployment.  

Disconnect all removable RIOMs and select 
OK to continue 

This message is typically used during the stow process 
for the antenna. 

 

8.1.4 Running Messages with Associated Hex Code 

The following table lists running messages and their descriptions as shown on the AAQ GUI. Depending on the 
message location, either the short or long message will be displayed: 

Function Code 
(Hex) 

Short Message   Long message 

0x0001   "Scanning in Az 1"   "Scanning in Az for Target Sat Signal, Pass 1" 

0x0002   "Moving back to Peak "   "Moving back to Peak signal" 

0x0003   "No Signal-Rescanning"   "No Signal found on first pass" 

0x0004   "Scanning in Az 2"   "Scanning for Target Signal, Pass 2" 

0x0005   "No Sig Return Home"   "No Signal found returning to Home Position" 

0x0006  "Adjusting Pol"   "Adjusting Pol during Az Scan" 

0x0007   "Acquiring"   "Acquiring" 

0x0008   "Moving to Home"   "Moving to Home Position" 

0x0009   "Read GPS"   "Read GPS" 

0x000A   "Read Compass"   "Read Compass" 

0x000B   "Acquiring"    "Waiting for target from modem." 
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0x000C   "Waiting"    "Waiting on modem to allow move." 

0x000D   "Performing Move To"   "Moving to commanded position" 

0x000E   "Moving to Home"   "Moving to Home Position" 

0x000F   "Stowing"   "Stowing" 

0x0010   "Compass Cal"    "Performing compass calibration." 

0x0011   "X-Pol (H/V) moving"   "Cross Pol (H/V) moving Pol" 

0x0012   "Initializing Sensors"   "Initializing El Encoder" 

0x0013   "In Manual Control"   "In Manual Control and Jog mode" 

0x0014   "Moving"   "Moving" 

0x0015   "Coarse Peaking"   "Coarse Peaking" 

0x0016   "Coarse Peaking done"   "Coarse Peaking Complete" 

0x0017   "Fine Peaking"   "Fine Peaking" 

0x0018   "Fine Peaking Done"   "Fine Peaking Complete" 

0x0019   "Fine Peaking Pol"   "Fine Peaking POL" 

0x001A   "Peaking"   "Peaking" 

0x001B   "Idle"   "Idle" 

0x001C   "Tracking for signal"   "Moving to maintain signal" 

0x001D   "Position Hold Active"   "Moving to maintain signal" 

0x001E   "Opening wings"    "Opening wings." 

0x001F   "Closing wings"    "Closing wings." 

0x0100   "Mount Reflector"   "Moving to reflector mount position" 

0x0101   "Dismount reflector"   "Moving to reflector dismount position" 

0x0102   "Acquire Complete"   "Locked and Acquired continuing pos/wind hold 
and track ops" 

0x0103   "Tilt Compensating"   "Calculating Tilt compensation" 

0x0104   "Moving to Target"   "Moving to begin Scanning in Az for Target Sat 
Signal" 

0x0105   "Moving back to Peak "   "Moving back to Peak signal" 

0x0106   "Calibration"    "Performing Calibration" 

0x0107   "Initializing Sensors"   "Initializing Az Encoder" 

0x0108   "Initializing Sensors"   "Initializing POL Encoder" 

0x0109   "Intializing sensors"   "Intializing sensors" 

0x0110   "Acquiring"   "Paused" 

0x010A   "Waiting for signal"   "Acquiring, waiting for modem/beacon signal." 

0x010B   "Wait. Cal Heading"   "Please wait. Calibrating heading." 

0x010C   "Elevation Deploy"   "Moving in elevation to deploy range" 

0x010D   "Elevation Stow"   "Moving in elevation to the stow position" 

0x010E   "Wait. Cal Heading"   "Please wait. Calibrating heading." 

0x010F   "Mod Cmd Running"   "Please wait. Module command running." 

0x0111   "No Ref., Calibrating "    "Invalid Ref. Satellites, Calibrating Heading " 

0x0112   "Adj. using Ref #1 "    "Adjusting Heading using Reference Sat. #1" 

0x0113   "Adj. using Ref #2 "    "Adjusting Heading using Reference Sat. #2" 

0x0114   "Ref 1 Fail use Ref 2 "    "Ref. Satellite #1 Failed, using Ref. Satellite #2" 

0x0115   "Ref 2 Fail use Ref 1"    "Ref. Satellite #2 Failed, using Ref. Satellite #1" 
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0x0116   "Ref Fail Calibrating"    "Ref. Satellites Failed, Calibrating Heading" 

0x0117   "Moving to target"    "Moving to target satellite" 

0x1001   "Has Alarm"    "Cannot execute command while alarm is active." 

0x1002   "Invalid GPS"    "GPS Coordinates are not valid." 

0x1003   "Location Alarm"    "GPS or compass is in Alarm state." 

0x1004   "No modem target"    "Modem has not sent a target." 

0x1005   "Acquire Failed"    "All signal sources tried with no valid signal 
detected." 

0x1006   "Acquire Failed"    "Scanning will exceed Az Limits - Rotate Base and 
try again" 

0x1007   "Heading Cal Failed"    "Heading calibration failed. No signal found during 
arc scan." 

0x1008   "Needs Home"    "Command failed. Home must be run first." 

0x1009   "Sensor failure"    "Elevation inclinometer failure." 

0x100A   "Operation failure"    "Azimuth must be on stow switch" 

0x100B   "Invalid operation"    "Invalid operation for the current hardware." 

0x100C   "Invalid signal"    "Invalid signal for peaking." 

0x100E   "Move failed"    "Geometry move failed." 

0x100F   "Invalid Target"    "Invalid target for this location." 

0x1010   "World calc failed"    "Could not transform world coordinates." 

0x1012   "Signal wait failed"   "Acquire failed waiting for modem/beacon signal." 

0x1013   "El Deploy failed"   "Elevation deploy failed." 

0x1014   "El Stow failed"   "Elevation stow failed." 

0x1015   "Heading Cal Failed"    "Heading calibration Failed. No signal found during 
scan for a reference satellite." 

0x1016   "XPol not valid"   "The crosspol command cannot be performed with 
this feed." 

0x1017   "Heading Cal Failed"    "Unable to Calculate Heading 

0x2000   "Aborted"    "Command aborted" 

0x2001   "Acquire Complete"   "Locked and Acquired" 

0x2002   "Heading Cal. Comp."    "Heading calibration completed" 

0x2003   "X-Pol (H/V) complete"   "Cross Pol (H/V) POL move complete" 

0x2004   "Home Completed"    "Home Completed" 

0x2005   "Command completed"    "Command completed." 

0x2006   "Command completed"    "Position hold completed." 

0x2007   "Command skipped"    "Command skipped due to hardware 
configuration." 

0x2008   "Stowed"   "Stowed" 

0x2009   "Idle"   "Idle waiting for next command" 

0x200A   "El deploy completed"    "Elevation deploy completed" 

0x200B   "El stow completed"    "Elevation stow completed" 

0x200C   "Ref Sat Completed"    "Scan for reference satellite completed" 

0x200D   "Mod Cmd Completed"    "Module command completed" 

0x3000   "Mount Reflector"    "Mount reflector and select OK to continue" 

0x3001   "Unmount Reflector"    "Unmount reflector and select OK to continue" 
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0x3002   "Stow Confirm"    "Warning stow may cause elevation to move to the 
deploy range. Press OK to continue." 

0x3003   "Connect RIOMs"    "Connect all RIOMs and select OK to continue" 

0x3004   "Remove RIOMs"    "Disconnect all removable RIOMs and select OK to 
continue" 

 
 

8.2 Communicating with the GUI 
 

Should the AAQ Graphical User Interface (GUI) application not show a connection to the Antenna Control Unit 
(ACU), follow the steps below.  
 

8.2.1 Comms. LED Indicator 

 

Communication between the GUI and ACU is indicated by an LED located in the bottom left corner of 

the GUI. Green indicates communication is present, while gray indicates no communications are 

present.  

 

 
Figure 8.2.1 – GUI Communication Indicator 

 

 

8.2.2 Remote IP Address 

 

View the Remote IP address in the AAQRemote Settings window located in FILE>SETTINGS tab. Verify 
that the IP address on the Client Computer is correct.  

 
 

 
 

Figure 8.2.2 – Remote Settings Address 
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8.2.3 Verifying Connections 

 

If the Addressing appears to be correct, continue with the following steps: 

 

1. Verify the Ethernet cable from the pedestal to the PC is present. 
 

2. Open the client computers command prompt (cmd).  
 

3. Ping the ACU, i.e. (ping 192.168.129.51. , Service IP) 
 

4. If ping responds with replies. Contact AvL to ensure the correct GUI is installed in the AAQ Version 
Info found in HELP>VERSION tab. 

 
5. Contact AvL support to assist in reinstalling ROM software if necessary. 

 
6. If ping does not respond, ensure power is present by checking power supply and re-checking control 

cable connections. 
 
 

 
 

Figure 8.2.3 – Version Info Example 

 

8.2.4 ACU communication to RIOMs 

 

Communication between the GUI and RIOM’s are indicated by a series of LED’s located in the bottom of 

the GUI. Green indicates communication is present, while gray indicates no communications are 

present.  
 

 
 

Figure 8.2.4 – RIOM Comms. LEDs 
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If system has external RIOM modules, Verify connections from ACU to external RIOM (i.e. Tyco 
connections) are secure. If all connections appear to be correct, contact AvL Customer Support to 
verify correct RIOM software is installed.  

 

8.3 Modem Signal Source not found on scan 
 

When during the initial acquisition scan, a signal was not detected by the ACU’s external device (i.e. 
modem, beacon receiver, etc.), follow steps below 

 

8.3.1 Verify Communication 

 

Verify communication between the ACU and modem are present by viewing the “Current Device 
Stats” window found in the VIEW>DEVICE WINDOW tab.  
 
If communications is present the window will populate with the device’s information, if 
communications is not present the window will be blank for the device in use. The unit will fail to 
acquire if communication is not present between the ACU and the external device.  
 

 
 

Figure 8.3.1 – Current Device Stats Example 

8.3.2 IP Addressing 
 

Verify the Configuration port and IP addresses are set to the match the external device settings. (i.e.  
192.168.100.1, port settings: 80 for Viasat modem).  
 
Verify that Ethernet and/or serial connection is present between the ACU and external device.  
If the “Device in use” box shown in figure 8.2.1, shows blank, then the external device is still not 
recognized by the ACU. 
 
Contact AvL Customer Support to verify the correct module is installed in the AAQ Version Info 
found in Help > Version tab. 
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Figure 8.3.2 – Version Info 

 

If the external device is recognized in the Device Window, manually point the antenna to verify the 
external device can recognize the intended signal. Should the signal then be recognized, verify the 
Azimuth and Elevation alignment are correct for the intended Target Satellite.  

 

 

8.4 Elevation and Azimuth alignment 
 
Incorrect offsets in both azimuth and elevation are the most common inaccuracies when acquiring a 
satellite. Offsets may be introduced due to mechanical tolerances, slight inaccuracies in installation, etc. 

 

  8.4.1 Elevation Offset 

 
Once a known satellite is identified, the elevation can be verified. If the actual and the predicted are 
noticeably different, an elevation offset may need to be applied in the system calibration window. The 
“Elinc Offset” configuration item is located the “System Configuration” window located in the 
VIEW>CONTROLLER CONFIGURATION tab. 
 

 

Note - The pedestal must be level before the elevation can be set. It is also necessary that the 
“roll” reading be as close to zero as practical before entering a new Elevation offset. 
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Predicted Target 

 
Actual Target 

 

 
 
 
 
 

Figure 8.4 - Errors in the Elevation Calibration (El Offset) 
 

 

 

WARNING - Anytime the “elevation offset” value is changed, the elevation limit switches 

(UP, DN, and STOW) should be checked.  

 

 

  8.4.2 Azimuth Offset  

 
If a consistent error in actual vs. predicted azimuth is observed, an offset in the compass may need to be 
applied. The “Compass Heading” configuration item is located the “System Configuration” window located in 
the View>Controller Configuration tab. Compass test and calibration tools are located in File > Calibration.  
 
 
 
 

 
Predicted Target 

 
Actual Target 

 
  

Figure 8.4.2 - Errors in Azimuth (Compass) Calibration  
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8.4.3 Recognizing a Failed Compass 

 

Manual Compass is required when the compass module fails and the readout does not change from 

default (zero), regardless of the true heading. The compass readout will remain zero during the 

compass routine and continue the acquiring process. The ACU assumes the compass heading of zero 

is correct and continues the acquiring process. See Figure 8.3.3. 

 

 

 

 

 
 

Figure 8.4.3 - Main GUI, Heading Indicates Zero 
 

Note - A compass fault will not be indicated in the event the compass fails to produce a 

heading.  
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8.4.4 Changing the Compass Heading Sources 

 

The “Heading Source” configuration item is located in the “Configuration” window 

VIEW>CONFIGURATION, Core tab. Keyword search was used to find heading related items. 

 

 
 

Figure 8.4.4 – Heading Sources to Manual 
 

Selecting “Manual” from the pull downs for both primary and secondary heading sources, will 

direct the AAQ controller to use the value listed under “Heading for Manual Compass” for the 

heading source. This parameter is listed under the “Configuration” window 

VIEW>CONFIGURATION, Core tab as shown in Figure 8.3.4b.   

 

Note - Searching for the “Keyword(s)” simplifies the process as indicated.  

 

The ACU is now set to recognize this value as the position of the Antenna frame when 

beginning the acquisition process. Typically, the pedestal is pointed due south (north when 

operating below the equator) and the Manual heading is set to 180.00. 

 

In the case of a vehicular mount, the operator will make a best estimate of the antenna’s pointing 

direction while stowed, with a hand compass. This value then becomes the “Manual Heading”. 

 

Remember to save the changes when finished. 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 196 of 200 
 

 

 

8.5 Recognizing a Failed GPS 
 

A “GPS Coordinates are not valid” error will occur when “zero” values are displayed in the “Lat” and 

“Long” readout positions. 

 

 
 

Figure 8.5 - Main GUI, GPS Coordinates 
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8.5.1 Changing to Manual GPS  

 

The “GPS Source” configuration item is located in the “Configuration” window under, VIEW> 

CONFIGURATION>Core Tab. 

  

 

 
 

Figure 8.5.1 – GPS Source to Manual 
  

 

 

 

Selecting “Manual” from the “GPS Source” pull down menu will direct the AAQ controller to use the 

values listed under “Manual Latitude” and “Manual Longitude” for the GPS source. These values are 

also listed under the “Configuration” window, VIEW>CONTROLLER CONFIGURATION> Core tab. 
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Figure 8.5.1b - Manual Lat and Long entry 
 

8.6 Maintenance  
 

AvL Antenna systems are designed such that any wear should never degrade performance below 

specifications and essentially no maintenance should ever be required. However, since it is impossible to 

ascertain or test for all possible environments, the following checkup is recommended each year. If any 

problems are observed, refer to section 8.6 in order to contact Customer Service. 

 

8.6.1 Annual Inspection 

 

Azimuth 

 

 Check for unusual noise in the azimuth bearing, the azimuth gearbox and the azimuth 
motor. 

 Run in azimuth and check for unusual noise in the azimuth motor. 

 Check the position of the azimuth drive cables on capstan at 0° Azimuth. 

 Check the drive cables for damage. 

 Run both Az. limits and observe cable tracking. 

 Check for excessive backlash in the gearbox. 

 Inspect cable connections and tensions. 

 Inspect the Azimuth potentiometer for looseness, damage or dirt. 
 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 199 of 200 
 

 

Elevation 

 

 Hand crank in elevation - the unit should hand crank easily. 

 Unit should hand crank with approximately 50-75 in-lbs. torque depending on model. 

 Check for unusual noise in the elevation pivot bearings and the elevation gearbox. 

 Run in elevation and check for unusual noise in the elevation motor. (Run to limits) 

 Check the position and tracking of the elevation drive cables. 

 Check the drive cables for damage. 

 Check the oil level in the gearbox, where accessible. 

 Inspect the elevation limit switches. 
 

Polarization 

 

 Run in polarization and check for unusual noise in the polarization gearing or motor. 

 Inspect the polarization potentiometer. 

 Inspect the wave-guide for any damage, dents, or cracks. 
 

8.7 Contacting Customer Service  
 

AvL Customer service is available 24 hours a day, seven days a week for your inquiries. We strive to 

assist our customers in any way they need, providing as much information, training, and assistance as is 

necessary. AvL customer support is committed to solving our customer problems. We are a team of 

dedicated professionals working to continually improve all aspects of our products and the service we 

provide. We want to take the time to understand your technical and operational requirements. 

 

When contacting customer support please ensure the following information is available, this information 
can be found on the AvL serial tag located between the elevation arms or on the azimuth base plate. 

 

 AvL antenna type 

 serial number 

 Manufacturing Date  

 Customer the unit was originally purchased from (optional). 
 

8.7.1 Email Support 

 

General email support is available to all AvL customers at support@avltech.com. 
 

We encourage making primary contact for routine requests through email in order for our technical staff 

to organize and evaluate needs in a timely manner. 

 
 



AvL Proprietary and Confidential  
Content is Subject to Change without Notice    Page 200 of 200 
 

 
 
 

8.7.2 Priority Telephone & Fax Support 

 

In case of an emergency or relating to matters of a more pressing nature, telephone and fax 
support is available per incident to AvL customers throughout the world. 
 

 

General telephone support - (Monday - Friday 8am - 5pm EST): 

1-828-250-9950 

 

 

After hours/emergency customer service (Weekends and Holidays): 

1-828-250-9140, then follow prompts to page Custom 

 

 

 


